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the screen may be hazardous if your attention has been diverted 
away from your driving task at a critical time.
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volume at a level where you can still hear outside traffic and 
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Palm Take Back and Recycling Program
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environment, we strive to use environmentally friendly materials, 
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recycling. Our recycling program keeps Palm handheld devices, Treo 
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Palm customers may participate in the recycling program free of 
charge. Visit palm.com/recycle for additional details and information 
about how you can help reduce electronic waste.
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Congratulations on the purchase 
of your Palm® Treo™ 800W 
smartphone. In one compact and 
indispensable device, you now 
have all of the following:

• An advanced wireless smartphone

• A Windows Mobile® organizer with 
portable expansion capability (miniSD)

• High-speed data with GPRS/EDGE and 
CDMA2000 (3G and HSDPA) support

• A 1.3-megapixel digital camera

• Support for numerous mobile email 
solutions

• Text and multimedia messaging

• Windows Media® Player Mobile

• Microsoft® Office Mobile suite

This guide will help you set up your 
smartphone and quickly learn to use it. 

NOTE If you want to use your phone and 
send and receive text messages, you need 
a service contract with your wireless 
service provider. If you also want to 
browse the web and send and receive 
email, you need not only a service contract 
but also a data service plan from your 

wireless service provider. You may also 
need a specific data service plan to send 
and receive multimedia messages. Data 
speeds vary based on network availability 
and capacity.

What’s in the box?

All of the following items should be in the 
smartphone box:

Hardware

• Treo 800W smartphone

• Rechargeable battery (1200 mAh)

• AC charger (with international adapters 
in some smartphone packages)

• USB sync cable

• Stereo headset

• Palm Vehicle Power Charger

• Screen protector

TIP LOOK HERE: Don’t miss the helpful tips 
and cross-references given in these boxes.
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Documentation and software

• Read This First setup poster

• Treo 800W Smartphone Quick Reference 

• Windows Mobile Getting Started CD, 
which includes the following:

• Link to Microsoft Office Outlook® 
software download

• Desktop synchronization software 
(ActiveSync® desktop software for 
Windows XP, Windows Mobile Device 
Center for Windows Vista)

• Windows Media® Player 10

• Additional software for your 
smartphone

• User Guide (this guide) 

• Palm warranty

• End User License Agreement

What do I need to 
get started?

As you work through the instructions in this 
guide, you need all the items that came in 
the smartphone box (see What’s in the 
box?), as well as the following:

• You must have an activated wireless 
account (using a SIM card from your 
wireless service provider) with data 
services.

• If you plan to synchronize personal 
information between your smartphone 
and a computer, you need access to 
that computer during setup.

• You must also have your smartphone 
within range of your wireless service 
provider’s cellular coverage.

TIP Visit www.palm.com to purchase a 
replacement screen protector if the original 
one becomes scratched or worn.
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Setting up
Congratulations on the purchase of your new Palm® Treo™ 800W 
smartphone. You’re about to discover the many things about 
your smartphone that will help you better manage your life and 
have fun, too.

As you become more familiar with your smartphone, you’ll 
want to personalize the settings and add applications to make it 
uniquely yours. But first, follow these few easy steps to set up 
your smartphone and get it running.

Benefits

• Know where your smartphone 
controls are located

• Start using your smartphone right 
away

Benefits

• Know where your smartphone 
controls are located

• Start using your smartphone right 
away
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Palm Treo 800W smartphone overview

Front view

Charge indicator light 
(visible only when 
smartphone is 
connected to AC 
charger)

Multi-connector

5-way navigator 
with Center button

Earpiece

Power/End 

Microphone

Headset jack

Start 

Phone/Send 

Side button

OK 

Volume 

Left action 
key

Right action key
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IMPORTANT The smartphone speaker 
includes a large magnet, so be sure not to 
store your smartphone near credit cards or 
other items that could be demagnetized.

Back view

TIP Be careful not to scratch or crush your 
smartphone screen. Do not store it in a place 
where other items might damage it.

DID YOU KNOW? By default, pressing and holding 
the Side button opens the Windows Media® 
Player Mobile application (see Windows 
Media Player Mobile). You can change the 
function of the Side button (see Reassigning 
buttons).

Camera lens

Battery door 
release

SpeakerSelf-portrait mirror

Infrared (IR) 
port

Expansion card 
(miniSD) slot

Reset button 
(located inside 
expansion card 
slot door)
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Top view

Inserting the SIM 
card and battery

Your SIM card contains account 
information such as your phone number 
and voicemail access number. To use your 
smartphone’s phone, email, or web 

features, you need to insert a SIM card. If a 
SIM card is not included in your 
smartphone box, your wireless service 
provider will provide you with one.

To take advantage of the high-speed data 
connection available on your smartphone, 
you need to have a 3G SIM card. A 3G SIM 
card has “3G” on it.

Ringer switch

Stylus

Car kit jack

DID YOU KNOW? The Ringer switch silences all 
sounds, including music, at once; you don’t 
need to hunt for “off” or “mute” settings in 
individual applications.

TIP If you don’t have a SIM card, contact your 
wireless service provider.
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1 Use one hand to press the Battery 

door release, and use your other hand 
to slide the battery door downward to 
remove it from your smartphone.

2 If the battery is installed, remove it. 
Slide your finger under the left side of 
the battery (nearest the stylus) and lift 
up to remove it.

3 With the metal contacts facing the 
battery compartment, slide the SIM 
card into the cutout in the lower-right 
corner of the compartment until you 
feel it snap into place. Align the notches 
to make sure you have the card oriented 
correctly.

4 Align the metal contacts on the battery 
with the contacts inside the battery 
compartment, insert the battery into the 
compartment at a 45-degree angle, and 
then press it into place. 

5 Slide the battery door back into place. 

Your smartphone screen turns on. 
Wait for the progress bar to fill and the 
Windows Mobile® screen to appear.

TIP It is easier to remove the battery if you first 
remove the stylus from your smartphone.

Battery door 
release

Notch

Battery 
contacts
Phone 
contacts
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6 Follow the onscreen instructions to 
finish the installation.

7 If your SIM card is not already activated, 
follow the activation steps provided by 
your wireless service provider, or 
contact your wireless service provider 
directly for assistance. If you plan to use 
email and web browsing, you need a 
data service plan from your wireless 
service provider in addition to your 
service contract. You may also need a 
data service plan to send and receive 
multimedia messages.

Charging the battery

Although the battery may come with a 
sufficient charge to complete the setup 
process, we recommend that after setup 
you charge your smartphone for three 
hours (or until the indicator light is solid 
green) to give it a full charge. See 
Maximizing battery life for tips on making 
your battery’s power last longer.

BEFORE YOU BEGIN Make sure the 
battery is inserted in your smartphone 
before you charge. If you connect your 
smartphone to a power source without the 
battery inserted, nothing happens.

1 If you have international adapters in your 
smartphone package, prepare the AC 
charger by inserting the adapter that fits 
the wall outlet you’re going to use.

2 Plug the AC charger into a wall outlet.

3 With the arrow on the connector facing 
up (toward your smartphone screen), 
connect the charger cable to the bottom 
of your smartphone. 

TIP If your smartphone does not turn on after 
you insert the battery, you need to connect it 
to the AC charger to charge it (see Charging 
the battery). If it still doesn’t start, perform a 
soft reset (see Performing a soft reset).

TIP You can buy an extra battery as a spare for 
long airplane trips or periods of heavy data 
use. To ensure proper functioning and avoid 
voiding the warranty, be sure to use batteries 
from Palm only. Visit www.palm.com.
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4 Check the indicator light to confirm that 
your smartphone is charging. 

• Solid red indicates that your 
smartphone is charging.

• Solid green indicates that your 
smartphone is fully charged. 

When your smartphone is on (see Turning 
your Palm® Treo™ 800W smartphone on/off), 

the onscreen battery icon displays the 
charging status:

DID YOU KNOW? If the battery is low, the indicator 
light flashes red.

Indicator light

A solid lightning bolt indicates that 
the battery is connected to a wall 
outlet and is charging.

A shaded lightning bolt indicates 
that the battery is connected to a 
wall outlet and is fully charged.

A partial battery without a lightning 
bolt indicates that the battery is not 
connected to a wall outlet and that 
it has some power.

An exclamation point (!) indicates 
that the battery needs to be 
charged immediately.

Battery 
icon
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Maximizing battery life

Battery life depends on how you use your 
smartphone. You can maximize the life of 
your battery by following a few easy 
guidelines:

• Charge your smartphone whenever 
you’re at your desk, or charge 
it overnight each day. The battery in your 
smartphone has a much longer useful 
life if you charge it frequently instead of 
waiting until it’s fully drained.

• If you spend a lot of time using the 
camera, games, media players 
(including listening to music with 
wireless headphones using the built-in 
Bluetooth® wireless technology), or 
other applications, keep an eye on the 
battery icon and charge when 
necessary.

• The wireless features (phone, email, 
messaging, and web) on your 
smartphone generally consume more 
power than the organizer features. 
If you don’t plan to use the wireless 
features on your smartphone for a 
while, turn off your wireless services 
(see Turning wireless services on/off). 
You can forward calls to a different 
number or let all calls be picked up by 
voicemail (see Forwarding calls). To see 
if your wireless services are on, tap the 
phone-off  icon and select Wireless 

Manager.

• If you are synchronizing email and other 
information directly with your corporate 
Exchange server using Microsoft 
Exchange ActiveSync®, set the 
synchronization interval to a maximum 
of every 15 minutes during peak times 
and every hour (or turned off 
completely) during non-peak times (see 
Setting the synchronization schedule).

DID YOU KNOW? If your battery ever becomes fully 
drained, your info remains safely stored on 
your smartphone. Recharge the battery to 
access your info.

TIP You can also charge your smartphone from 
your computer by connecting them with the 
sync cable.

DID YOU KNOW? You can also see if your wireless 
services are on by pressing Menu (right action 
key) and selecting Wireless Manager.
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• Turn off the Bluetooth feature when you 
do not need to make a Bluetooth 
connection (see Entering basic 
Bluetooth settings).

• Turn the voice command feature off 
(see Setting up voice commands).

• As with any mobile phone, if you are in 
an area with no wireless coverage, your 
smartphone searches for a signal, which 
consumes power. If you cannot move to 
an area of better coverage, temporarily 
turn off your phone (see Turning your 
phone off). 

• Turn down the screen brightness (see 
Adjusting the brightness).

• Set your screen to turn off automatically 
after a shorter period of inactivity (see 
Optimizing power settings). 

• Turn off the option to receive beamed 
information (see Beaming an entry or 
file).

• Keep your battery away from direct 
sunlight and other sources of heat. 
Temperatures over 50 degrees Celsius 
(120 degrees Fahrenheit) can 
permanently reduce the capacity and 
life span of any lithium-ion battery.

Making your first call

1 Press Phone/Send  to display your 
Today screen.

2 If prompted, press Center  to turn 
off Keyguard (see Locking your 
keyboard (Keyguard) for more info).

3 Use the number pad on the keyboard to 
enter the number you want to call.

TIP You can also press Power/End to display 
your Today screen, unless you are on a call. If 
you’re on a call, pressing Power/End hangs up 
the call.
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4 Press Phone/Send  to dial.

5 When your call is complete, press 
Power/End  to end the call.

Adjusting call volume

While a call is in progress, press the 
Volume button on the side of your 
smartphone to adjust the call volume.

What’s my number?

1 Make sure your phone is on (see 
Turning your phone on).

2 If you do not see your Today screen, 
press Phone/Send .

3 Press Menu  (right action key).

4 Select Preferences > Phone Settings.

5 On the Phone tab, look for your phone 
number below the title bar.

TIP The Dial Lookup list might appear while you 
are dialing a number. Continue entering 
numbers to place the call. For more info on 
the Dial Lookup list, see Dialing by contact 
name. 

Volume 
button
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6 Press OK .

Setting up 
synchronization

After you’ve finished setting up your 
smartphone, we recommend that you set 
up a synchronization method to get the 
most out of your smartphone. 
Synchronizing means that information that 
has been entered or updated in one 
place—your smartphone, your computer, 
or your corporate server—is automatically 
updated in the other (see Synchronizing 
information).

TIP If your phone number doesn’t appear on 
the Phone Settings screen, your network has 
not yet sent the number to the SIM card (this 
does not affect SIM card functionality). Turn 
your phone off, wait a few hours, and then 
turn on your phone and repeat these steps. If 
your phone number still does not appear, 
please contact your wireless service provider 
for assistance.

Look here for your 
phone number
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Moving around on your 
Palm® Treo™ 800W smartphone
Have you ever been to a new city and felt a bit lost until you 
figured out the streets? Learning to move around on your 
Palm® Treo™ 800W smartphone is similar. Most applications that 
work on your smartphone use the same set of controls. So 
once you learn how to use these controls, you’ll be driving all 
over town and you won’t even need a map.

Benefits

• Quickly move around and 
complete tasks in applications 
using one thumb on the 5-way 
navigator

• Access extra features with menus

• Find and open applications quickly
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Navigating around 
the screen

To navigate around the smartphone screen, 
you can use the 5-way navigator or you can 
tap items on the screen with the stylus. As 
you become familiar with your 
smartphone, you’ll find your own favorite 
way to scroll, highlight, and select items.

Using the 5-way, press Right , Left , 
Up , or Down  to move around the 

screen. Press Center  to highlight and 
select items.

TIP Some third-party applications may not work 
with the 5-way navigator, and you must use 
the stylus instead.

DID YOU KNOW? Custom navigation features are 
available when you browse the web using 
Internet Explorer (see Viewing a web page).

TIP The arrow icons that indicate directions on 
the 5-way are different from the onscreen 
scroll arrows and the arrows that indicate that 
a list is available (see Selecting options in a 
list). 

Up 

Down 

Left Right 

Center 
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Scrolling through screens

As on a computer, on your smartphone you 
scroll to move from field to field or page to 
page, or in some cases to highlight an item 
or option in a list. There are several 
methods of scrolling:

• Press the 5-way on the front of your 
smartphone. Press Right , Left , Up 

, or Down  to move to the next 
field, button, or action in that direction.

• Press and hold Option  while 
pressing Up  or Down  to scroll 
one screen at a time. These keys work 
just like the Page Up and Page Down 
keys on your computer keyboard.

• Press and hold Option  while 
pressing Left  or Right  to jump to 
the top or bottom of the current 
document or entry.

• When viewing a screen with tabs, such 
as when adding a contact, press 
Down  to scroll to the tabs, and then 
press Left  or Right  to move 
between tabs.

• When inside a text field, press Right  
or Left  to move to the next character, 
and press Up  or Down  to move 
between lines. 

• When inside a list, press and hold 
Up  or Down  to rapidly scroll 
through the list.

TIP Can’t find the Option key? See Using the 
keyboard.

TIP When you are using applications such as 
Inbox, Internet Explorer Mobile, and Word 
Mobile, press and hold Option while pressing 
Left or Right on the 5-way to automatically go 
to the top and bottom of a screen.
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• Tap an onscreen scroll arrow.

• Tap and drag the slider of an onscreen 
scroll bar.

Closing screens

To accept the information you entered on a 
screen and to return to the previous 
screen—or to return to the previous screen 
without making any changes—do one of 
the following:

• Press OK .

• Use the stylus to tap  or  in the 
upper-right corner of the screen. These 

buttons are not accessible using the 
5-way.

Highlighting and selecting items

On most screens, one item—a button, a 
list entry, or a check box—is highlighted by 
default. The highlight identifies which item 
is affected by your next action. Use the 
5-way to move the highlight from one item 
to another before opening or selecting it. 

The highlight can take one of two forms, 
depending on what is highlighted:

• Border: This rectangular border 
highlights items such as an onscreen 
button (such as OK, Dismiss, or Hide), a 
check box, an option, or a web link. 

Scroll arrows

Scroll arrows

Scroll bar 
with slider

TIP The best way to learn to use the 5-way is to 
experiment. Press the 5-way buttons, and as 
you do, follow the movement of the border 
around the screen. The behavior of the 5-way 
varies slightly in each application.
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• Light text on a dark background: This 
highlights items such as a phone 
number, an email address, text, or an 
item in a list.

After highlighting an item with the 5-way, 
you can select or activate it by pressing 
Center  or by tapping the item with the 
stylus. 

Highlighting text

You can use the stylus to highlight text on 
the screen. Tap and drag the stylus across 
the text you want to highlight. To highlight 
a word, double-tap it. To highlight a 
paragraph, triple-tap it.

Using the action keys

The left and right action keys give you quick 
access to tasks that you can do on the 
current screen, so the action key items 
vary from application to application and 
from screen to screen. Look on the screen 
directly above the action key to see the 
action that it takes in the current context. 
In some contexts, these keys may do 
nothing at all. In most cases the right 
action key  opens the menu, and the 
left action key  activates a specific 
command, such as New or Edit. 
Remember that action key functions vary 
from screen to screen, so be sure to check 
the onscreen label before pressing the 
action keys. 

TIP When text is highlighted, you can press 
Backspace to delete the highlighted text.
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Selecting menu items

In many applications, a menu provides 
access to additional features. The menu is 
hidden until you press Menu  (right 
action key). To get the most out of your 
smartphone, it’s a good idea to familiarize 
yourself with the additional features 
available through the menu in various 
applications.

1 Press Menu  (right action key) to 
display an application’s menu. 2 Press Up  or Down  to highlight a 

menu item.

Left action key Right action key

Left action key 
activates this 
command

Right action key 
activates this 
command
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3 If an arrow appears next to a menu 
item, press Center  or Right  to 
display additional options for that item, 
and then press Up  or Down  to 
highlight a menu item. To return to the 
main menu without making a selection, 
press Left .

4 Press Center  to select the menu 
item, or press Left  or Menu  
(right action key) to close the menu and 
cancel your selection.

Selecting options in a shortcut menu

Most applications also provide access to 
context-sensitive shortcut menus—similar 
to the right-click menus on a computer. The 
shortcut menu options vary based on the 
highlighted selection.

1 Highlight the item whose shortcut 
menu you want to see.

2 Press and hold Center  to open the 
shortcut menu.

3 Press Up  or Down  to highlight a 
menu item.

4 Press Center  to select the menu 
item, or press Left  to cancel your 
selection.

Selecting options in a list

Lists enable you to select from a range of 
options. You can identify whether a list is 
available when you select the field. If a 
rectangle appears around the field along 
with a downward-pointing arrow, a list is 

DID YOU KNOW? You can select most menu items 
by pressing a key on the keyboard. To quickly 
access a menu item, press Menu (right action 
key) followed by the underlined letter in the 
menu item’s name. 

TIP You can also tap and hold the stylus on an 
item to open the shortcut menu.
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available. Lists are different from the 
menus described earlier in this section.
 

To select from a list, do any of the 
following:

• Use the 5-way to highlight the field, and 
then press Center  to display the 
items in the list. Press Up  or 
Down  to highlight the item you want, 
and then press Center  to make 
your selection.

• Use your stylus to tap the arrow, and 
then tap the item in the list.

• Press Left  to exit the list and cancel 
your selection.

TIP When selecting fields you might not see 
the downward-pointing arrow until you press 
Center on the 5-way. 

DID YOU KNOW? In fields where you see a 
downward-pointing arrow but no rectangle, 
you must tap the arrow with the stylus to 
display the list. 
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Using the keyboard

Understanding the keyboard backlight

Your smartphone includes a keyboard 
backlight for low light conditions. The 
keyboard backlight activates automatically 
when the screen turns on. The backlight 
turns off automatically when the screen 
turns off or when you are on a call or 
playing music in the background for longer 
than the time specified in Backlight 
Settings. You can set different time 
intervals depending on whether the 
smartphone is operating on battery power 

Left
action key

Right
action key

Phone/Send
Start

Power/End
OK

Backspace

Option

Shift/Search

Space

Return

Shift

Alt

DID YOU KNOW? You can also use the onscreen 
keyboard to enter letters, numbers, and other 
characters in applications that support this 
feature. Tap the keyboard icon in the center at 
the bottom of any screen where it appears. 
After opening the keyboard, you can set 
various input options by tapping the arrow to 
the right of the keyboard icon.
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or is connected to an external power 
source. The backlight also turns off when 
an application’s power-saving features turn 
it off.

Entering lowercase and uppercase letters

By default, the first letter of each sentence 
or field is capitalized and the remaining text 
you enter is lowercase. To enter other 
uppercase letters, do one of the following: 

• Press Shift (  or ), and then enter 
a letter. You don’t need to press and 
hold Shift while entering a letter.

• Press Shift (  or ) twice to turn on 
Caps Lock, and then enter a series of 
letters. When Caps Lock is on, this 
symbol appears at the bottom of the 
screen: . To turn off Caps Lock, press 
Shift (  or ) again. 

Entering numbers, punctuation, and 

symbols 

Numbers, punctuation, and symbols 
appear above the letters on the keys. To 
enter these characters, do one of the 
following: 

• Press Option , and then press the 
key of the desired character. You don’t 
need to hold Option while pressing the 
key.

• Press Option  twice to turn on 
Option Lock, and then press the desired 
keys to enter a series of characters. 
When Option Lock is on, this symbol 
appears at the bottom of the screen: . 
To turn off Option Lock, press Option 

 again. 

TIP You can change the backlight shut-off 
interval. Press Start and select Settings. 
Select the System tab, and then select 
Backlight. Set the time interval on the Battery 
Power tab and on the External Power tab.

TIP You can turn off the first-letter capitalization 
setting (see Setting input options).
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Entering other symbols and accented 

characters

You can enter symbols and accented 
characters that don't appear on the keys by 
using the alternate characters list.

1 Press Alt  to display the alternate 
character list.

2 Narrow the list by pressing the key that 
corresponds to the character you want. 
For example, to enter an é, press e. See 
the table below for a list of 
corresponding characters.

3 Press Up  or Down  to highlight the 
desired character.

4 Press Center  to insert the 
character.

TIP The alternate characters are grouped 
according to their similarity to the 
corresponding key. For example, the alternate 
character available for the R key is ®, and for 
the T key is ™. If you press the wrong key, 
press Backspace to return to the full list of 
alternate characters. You can then press 
another key.
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0

Symbols and accented characters 

Press Alt 
 and 

press… 

to select… Press Alt 
 and 

press… 

to select… Press Alt 
 and 

press… 

to select…

a á à ä â ã å æ n ñ x or X x ¤

A Á À Ä Â Ã Å Æ N Ñ y  ý ÿ 

b or B ß o ó ò ö ô œ õ Y  Ý Ÿ

c ç ¢ © O Ó Ò Ö Ô Œ Õ 0 °

C Ç ¢ © p or P ¶ 1 1 ¼ ½

e é è ë ê r or R ® 2 2

E É È Ë Ê s ß š 3 3 ¾

f or F ƒ S ß Š ! ¡

i í ì ï î t or T ™ $   £ ¥ ¢

I Í Ì Ï Î u ú ù ü û Option + 
K (;)

: :-) :-( ;-)

l or L £ U Ú Ù Ü Û Option + 
N (?)

¿

Press Alt  by itself to select these characters:

: _ • % = ÷ ^  £ ¥ ¢ $ [ ] { } < > « » © ® ° ~ \ Ø μ |
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Opening and closing 
applications

Opening applications

You can access all the applications on your 
smartphone through the Start menu.

1 Press Start  to open the Start menu.

2 Use the 5-way navigator to highlight the 
application you want to use. To view 
additional applications, select 
Programs.

3 Press Center  to open the 
highlighted application.

4 (Optional) Press OK  to return to 
Programs and open another application. 
The current application continues to run 
in the background.

Closing applications

You can have several applications open at 
once, so you don’t need to exit an 
application to open another one. In most 
cases, applications close automatically 

TIP With the Start menu open, press the letter 
underlined in the application’s name to open 
the app. For example, press H to open Help. 
Or, select the shortcut icons at the top of the 
Start menu to open recently used 
applications.

In Programs, press a letter to jump to the first 
app that begins with that letter. For example, 
press C to jump to Calculator. Press C again to 
jump to Camera, and so on.

DID YOU KNOW? You can open apps by pressing 
and holding Option and then pressing Phone/

Send, Start, or OK. You can change which 
app a button combination opens (see 
Reassigning buttons).
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when available memory is low, but you can 
also close applications manually.

NOTE If you press OK  to leave an 
application, the current application 
continues to run in the background. 
Manually closing applications helps 
conserve battery power and frees up 
memory.

1 Press and hold OK  to open Memory 
Settings. 

2 On the Running Programs tab, do one 
of the following:

• Select the application you want to 
close, and then select Stop to close 
it. 

• Select Stop All to close all your open 
applications.

Using your Today 
screen

From your Today screen you can quickly 
look up a contact, make a call, see your 
latest calendar appointments, see the 
number of unread email messages, and 
even perform a web search.

To access your Today screen, press 
Phone/Send . 

TIP If you press Phone/Send while a number 
is highlighted, your smartphone dials the 
number. If a number is highlighted, deselect 
the number, or use the Start menu to access 
the Today screen.

TIP You can also open the Today screen by 
pressing Power/End, unless you are on a call. 
If you’re on a call, pressing Power/End hangs 
up the call. If the Today screen is already 
displayed and you’re not on a call, pressing 
Power/End turns off the screen display.
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• Title bar and status info: See What are 
all those icons? to learn about the icons 
that appear in this area.

• Dial Lookup field: Type the number 
you want to call and press Center  
to dial, or begin typing a name to look 
up the associated number in Contacts. 
See Dialing by contact name for more 
info. 

• Web search field: Enter a web address 
or a keyword, and press Center  or 
Return  to view a list of search 
results based on the address or word 
(data services connection required).

• Speed-dial entries: Select a speed-dial 
button—either a picture or text—to call 
the number assigned to it. See Defining 
speed-dial buttons to create your own.

Title bar and
status info

Dial Lookup field

Speed-dial
entries

Scroll down to view 
Web search field

TIP You can select a picture for your Today 
screen background and select which items 
appear in the Today screen. See Today screen 
settings for details.
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Your phone
The phone, along with the Today screen, is your home base for 
making and receiving calls.

You can creatively manage multiple calls; for example, you can 
swap between calls, send text messages to ignored calls, and 
create conference calls. 

And you can do more than manage your phone calls. You can 
send text messages, open applications, go to your favorite web 
pages, see your upcoming appointments, and even find out 
how many unread email messages you have.

Benefits

• Stay in touch—you choose how

• Work in other applications when 
on an active call.

• Create speed-dial buttons with 
pictures of your friends
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Turning your Palm® 
Treo™ 800W 
smartphone on/off

The term smartphone refers to the device 
and its physical aspects. The term phone 
refers to the wireless feature of your Palm® 
Treo™ 800W smartphone that enables you 
to connect to your wireless service 
provider’s network so that you can make 
and receive calls and send and receive 
data.

The phone and the screen of your 
smartphone can be turned off and on 
separately. This means you can wake up 
the screen to use just the organizer 
features of your device without turning on 
the phone. Also, when the screen is turned 
off, the phone can be on and ready for you 
to receive phone calls or messages.

Turning your phone on

Press and hold Power/End . When 
your smartphone locates a signal, your 
wireless service provider’s name appears 
in the upper-left of the screen and the 

signal-strength  icon appears at the top 
of the screen. 

When you turn on your phone, it connects 
to a mobile network so that you can make 
and receive phone calls and use other 
wireless services (if supported by the local 
network). When you are inside a coverage 
area, the signal-strength  icon has bars 
in it. If you’re outside a coverage area, the 
indicator light flashes amber and no bars 
appear in the signal-strength icon.

Turning your phone off

Press and hold Power/End . When 
your phone is off, the phone-off  icon 
appears at the top of the screen and 
Phone Off appears in the upper-left of the 
screen. Your phone is not connected to any 
mobile network. Although you can no 
longer use the phone, you can still use 
Microsoft Office apps and all the organizer 
features of your smartphone.
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Waking up the screen and turning it off

Wake up the screen and leave the phone 
turned off when you want to use only the 
organizer features of your smartphone, for 
example, when you’re on a plane and want 
to look at your calendar. You can also turn 
off the screen without turning off the 
wireless features on your smartphone. You 
can turn your screen on and off by pressing 
Power/End .

Making calls from the 
Today screen

Your smartphone offers several ways to 
make phone calls from the Today screen.

Dialing from the Today screen

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Using the numbered keys on the 
keyboard, enter a phone number in the 
Dial Lookup field.

DID YOU KNOW? You can also turn your phone on 
and off from the Today screen by pressing 
Menu (right action key), selecting Wireless 

Manager, and then selecting Phone.

DID YOU KNOW? You can go to Wireless Manager 
by tapping the signal-strength icon and 
tapping Wireless Manager.

TIP You can set how long the screen stays on. 
Press Start, select Settings, select the 
System tab, and then select Power. Select 
the Advanced tab. Adjust the number of 
minutes the phone stays on when idle using 
the On battery power setting.
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3 Press Phone/Send  to dial.

NOTE You do not need to press Option to 
access the numbers on the keyboard. 
However, when dialing short numbers, the 
number may conflict with a contact name. 
If this occurs, press Option  to avoid 
starting a contact lookup. For emergencies, 
you can dial your national emergency 
number (such as 911 or 112) without 
pressing Option first. 

Dialing with a speed-dial button 

Your smartphone enables you to create 
both picture and text speed-dial buttons so 
that you can select a button on the Today 
screen to quickly dial a number.

BEFORE YOU BEGIN

• Create some speed-dial buttons. See 
Defining speed-dial buttons. You can 
customize the default speed-dial 
buttons. See Editing a speed-dial 
button.

DID YOU KNOW? When you're dialing a phone 
number or are on a call, you can enter * and # 
without first pressing Option. This makes it 
easy to respond to further dialing instructions 
or to press options when responding to 
automated instructions.

TIP If you press Phone/Send while a number 
is highlighted, your smartphone dials the 
number. If a number is highlighted and you 
want to access the Today screen, deselect the 
number or use the Start menu.

TIP If you lock your smartphone and select 
Simple PIN as the password type, you can dial 
an emergency number by entering the 
number in the password field and pressing 
Phone/Send. You do not need to press 
Option before entering the number. However, 
if you select Strong alphanumeric as the 
password type, you must first press Option 
twice before entering the number in the 
password field. See Locking your smartphone.
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• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

You can make a call using your speed-dial 
buttons by doing any of the following: 

• Highlight a speed-dial button with the 
5-way navigator, and then press 
Center .

• Tap a speed-dial button with the stylus. 

• Press and hold the Quick Key that you 
assigned to the speed-dial button.

• To dial an alternate number for a 
contact, highlight the speed-dial button 
and press and hold Center  or tap 
and hold the button, and then select a 
number from the shortcut menu.

To see more speed-dial buttons, highlight 
the picture speed-dial area and press 
Right  or Left  repeatedly, or highlight 
the text speed-dial area and press Up , 
Down , Right , or Left .

Dialing by contact name

You can look up contacts quickly by 
entering just a few letters of a contact’s 
name directly from your Today screen. 

BEFORE YOU BEGIN Before you can dial a 
number by contact name, you must create 
some contacts (see Adding a contact,) or 
import them by synchronizing (see 
Synchronizing information). 

Make sure your phone is on and that you’re 
inside a coverage area (see Turning your 
phone on).

1 Go to your Today screen. 

2 Using the keyboard, begin entering one 
of the following for the contact you 
want to call:

TIP You can hide your speed-dial buttons on 
your Today Screen and still use your Quick 
Keys to call a speed-dial number. 
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• First name (JOH for John)

• Last name (SMI for Smith)

• First initial, a space, and then last 
initial (J S for John Smith)

• A few letters of the first name, a 
space, and then a few letters of the 
last name (JOH SMI for John Smith)

For example, entering SM finds both 
Smilla Anderson and John Smith. 
Entering SM AN finds only Smilla 
Anderson.

To clear the Dial Lookup field and start 
another Contacts search, press OK. To 
delete letters when correcting a 
misspelled name, press Backspace.

3 Several options for contacting the 
person are displayed, depending on 
what information you have entered for 
the contact. Highlight the phone 
number you want to dial for the contact.

4 Press Phone/Send  or press 
Center  to dial.

Dialing using the onscreen Dial Pad

The onscreen Dial Pad is useful when you 
need to dial numbers that are expressed as 
letters and when you need large numbers 
that you can tap with your finger or the 
stylus. 

TIP To see a contact’s address, company, and 
other details, press Up on the 5-way to 
highlight the name, and then press Center.

DID YOU KNOW? After you look up a contact, you 
can select how you want to communicate 
with that person. When a contact’s name or 
phone number is highlighted on the search 
results list, press and hold Center on the 
5-way or tap and hold with the stylus, and 
then select the communication method you 
want to use.
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BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen. 

2 Press Phone/Send  and select 
Dial Pad.

3 Use the keyboard keys or tap the 
onscreen Dial Pad to enter the number.

4 Press Phone/Send  to dial.

Redialing a recently called number

To dial the last number you called: Go to 
your Today screen, and then press and hold 
Phone/Send .

To select from your most recently dialed 

numbers: Go to your Today screen, press 
Phone/Send , highlight the number or 
contact name you want to call, and then 
press Phone/Send  to dial.

To select from a chronological list of 

calls: Go to your Today screen, press 
Phone/Send , and then select Call 

Log. Highlight the number you want to call, 
and then press either Call  (left 
action key) or Phone/Send  to dial.

DID YOU KNOW? You can paste numbers directly 
into the Dial Pad. Copy a number from another 
application, switch to Dial Pad, and then press 
and hold Center on the 5-way to paste the 
number.
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Other ways of 
making calls

Your smartphone offers several ways to 
make phone calls other than from the 
Today screen. Try them all and you’ll 
discover which methods you prefer.

Dialing by company name

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Press Start  and select Contacts.

2 Press Menu  (right action key) 
and select View By > Company.

3 Press Phone/Send  to go to your 
Today screen.

4 Using the keyboard, begin entering the 
first few letters of the company name.

5 Select the number you want to dial.

6 Press Phone/Send  to dial.

Dialing from a web page or message

Your smartphone recognizes most phone 
numbers that appear in web pages or in 
messages (text, email, or multimedia). 

1 Use the 5-way to highlight the phone 
number you want to dial in the web 
page or message.

2 Press Center  to open the Phone 
dialog box, and then select Yes to dial.

TIP You can also access the Call Log and Dial 
Pad from the Today screen by pressing Menu 
(right action key). 

TIP If you can’t dial a phone number directly 
from a web page or a message, highlight the 
number, select Edit (right action key), and 
then select Copy. Open the Dial Pad, and then 
press and hold Center on the 5-way to paste. 
Press Phone/Send to dial.



Y O U R  P H O N E

R E C E I V I N G  C A L L S42

4
C

H
A

P
T

E
R

Receiving calls

To answer calls, your phone must be on. 
This is different from having only the 
screen turned on (see Turning your phone 
on). When your phone is off, your calls go 
to voicemail.

If music is playing when a call arrives, the 
smartphone rings softly. You can answer 
the phone as you normally would. The 
audio pauses during your call.

To answer a call, do one of the following:

• Press Phone/Send .

• Press Answer  (left action key).

• If the headset is attached, press the 
headset button.

To ignore a call and send it to voicemail, 
press Menu  (right action key) and 
select Ignore, or press Power/End .

To silence the ringer while your 
smartphone is ringing:

• Press the Volume button or any key on 
your smartphone except Phone/Send 

, Power/End , Alt , Start , 
OK , or the 5-way.

• To immediately silence all system 
sounds including the ringer, slide the 
Ringer switch to Sound Off . All 
sounds remain off until you slide the 
Ringer switch back to Sound On .

When you silence the ringer, you can either 
answer the call or let it ring through to 
voicemail.

TIP See a picture of the person calling you! 
Learn how to assign a caller ID picture in 
Adding a contact.

DID YOU KNOW? You can also ignore a call and send 
a text message. Press Menu (right action key) 
and select Ignore with text message. 
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Using voicemail

Setting up voicemail

1 Go to your Today screen.

2 Press and hold 1 on the keyboard or tap 
the Voicemail speed-dial button to dial 
your wireless service provider’s 
voicemail system.

3 Follow the voice prompts to set up your 
voicemail.

Retrieving voicemail messages from the 

Today screen

When you have unretrieved voicemail 
messages, a Voicemail  icon appears at 
the top of your screen.

1 Go to your Today screen.

2 Press and hold 1 on the keyboard to dial 
your wireless service provider’s 
voicemail system. 

3 Enter your voicemail password using 
the keyboard, or press Extra Digits 

 (left action key) if you defined 
this option (see Creating a speed-dial 
button for details).

4 Follow the voice prompts to listen to 
your messages.

DID YOU KNOW? For some wireless service 
providers, the Voicemail speed-dial button 
may not be assigned to a number. If that’s the 
case, you can edit the Voicemail speed-dial 
button to add the number to your service 
provider’s voicemail system (see Editing a 
speed-dial button), or you can create a new 
speed-dial button with the number (see 
Creating a speed-dial button).
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Retrieving messages from a voicemail 

notification

NOTE Not all service plans support 
voicemail notification. Check with your 
wireless service provider for more 
information.

You can retrieve voicemail messages when 
you receive a notification, or you can 
dismiss the notification and retrieve the 
messages later.

• When you have a new voicemail 
message, a notification screen appears.

• To hear your message now, press 
Listen  (left action key). 

• To retrieve your message later, press 
Dismiss  (right action key). 

What can I do during 
a call?

Your smartphone offers many advanced 
telephone features, including call waiting, 
six-way conferencing, and call forwarding. 
These features depend on your service 
plan. Please contact your wireless service 
provider for more information.

When you make or receive a call, the active 
call info appears on your Today screen.

DID YOU KNOW? When a Voicemail icon appears at 
the top of the screen, you can tap this icon to 
retrieve your voicemail.

TIP You can display onscreen voicemail 
playback controls; see Creating a speed-dial 
button.
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During a call, you can do any of the 
following:

Navigate around the Today screen: Use 
Up  and Down  to move around or 
highlight items.

Put the call on hold: Press Hold  
(left action key). To take the call off hold, 
press Off Hold  (left action key).

Use the built-in speakerphone: Select   
Speakerphone . To turn the 
speakerphone off, select 
Speakerphone  again.

Mute the microphone so you can’t be 

heard: Select Mute . To turn the 

microphone back on, select Mute  
again.

Switch to another application: Press 
Start  and select the application.

Ending a call

Do one of the following:

• Press Power/End .

• Press the headset button (if the headset 
is attached and has a button on it). 
Some headsets do not have a button.

Switching applications during an active 

call 

You can use many other applications on 
your smartphone while holding a phone 
conversation, including the organizer and 
text message features. You cannot, 

Current duration 
of call

Caller’s name 
and number

DID YOU KNOW? When a call lasts longer than one 
minute, the screen dims. After two minutes, it 
dims more. Press any key, except Power/End, 
to light up the screen.

DID YOU KNOW? You can send and receive text 
messages during a call. This is a great way to 
stay connected with colleagues during a long 
call.
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however, make some data connections 
during an active call while connected to a 
GPRS network. If you’re connected to a 
GPRS network, you cannot browse the 
web or send and receive email or MMS 
messages while on a voice call. If you’re 
connected to a CDMA2000 (3G or HSDPA) 
network, you can perform simultaneous 
voice and data functions. How can you tell 
which kind of network you’re connected 
to? See What are all those icons?

NOTE Some wireless service providers do 
not support simultaneous voice and data 
functions over an HSDPA network; check 
with your wireless service provider for 
information.

To open an application, see Opening and 
closing applications.

From any application, press Phone/Send 
 to return to your Today screen.

Saving phone numbers

After you hang up a call, you can add the 
number of the person you were talking 
with to Contacts if it's not already in your 
list. If an incoming call uses caller ID 

blocking, you do not see the Add Contact 
prompt.

• To create a new contact for this number, 
select Create New Contact.

• To add this number to an existing 
contact, select Copy and Add, and 
then select a contact name.

• To decline adding the number, press 
Dismiss  (left action key).

• To disable the Add Contact prompt, 
select Don’t show this again.

TIP If you disable the Add Contact prompt, you 
can turn it on again. From your Today screen, 
press Menu (right action key) and select 
Preferences > Phone Settings. On the 
Phone tab, check the After calls from 

numbers that are not in Contacts, ask if I 

want to add them box.

TIP You can also save contact info from other 
applications, such as Inbox.
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If you don’t add a number right away, follow 
these steps to add it later: 

1 Go to the Call Log (see Redialing a 
recently called number). 

2 Highlight the number you want to save. 

3 Press and hold Center  to open the 
shortcut menu, and then select Save to 

Contacts.

4 Enter the information for the entry.

5 Press OK .

Making a second call 

You can make a second call while your first 
call is still active:

1 Place your first call on hold by pressing 
Hold  (left action key).

2 Dial a second number using any of the 
methods described in Making calls from 
the Today screen. If you’re dialing by 
contact name or with the keyboard, you 
must first use the 5-way to select the 
Dial Lookup field.

When two calls are active, your Today 
screen includes two call status sections, 
each representing one of the calls. 

Answering a second call (call waiting)

When you’re on a call and you receive a 
second call, the call waiting notification 
appears if you have chosen to be notified 
(see Setting call waiting notification). You 
can do any of the following:

Send the new call to voicemail: Press 
Menu  (right action key) and select 
Ignore.

Send the new caller a text message: 

Press Menu  (right action key) and 
select Ignore with text message. The 
second call is sent to voicemail. A new text 
message opens with the phone number of 
the caller entered in the To field.
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Hang up the current call and answer the 

new call: Press Menu  (right action 
key) and select Drop and Answer. You can 
also press Power/End  to hang up the 
current call, and then choose to answer or 
ignore the new call.

Place the current call on hold and 

answer the new call: 

Press Answer  (left action key) or 
Phone/Send . After you answer the 
call:

• Press Swap  (left action key) to 
move between callers by placing the 
current active call on hold and talking on 
the other line. 

• Make the calls a conference call. See 
Making a conference call.

Making a conference call

IMPORTANT You can join up to 5 calls into 
a 6-way conference call. The number of 
calls you can join in conference depends on 
your service plan. Additional charges may 
apply, and minutes in your mobile account 
may be deducted for each call. Please 
contact your wireless service provider for 
more information.

1 Answer a second call (see Answering a 
second call (call waiting)), or put the first 
call on hold and make a second call (see 
Making a second call).

2 Press Menu  (right action key) 
and select Conference. This joins the 
two calls with you in a conference.
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3 (Optional) Do one or more of the 
following:

• Make more calls and join them into 
the conference call. The number of 
calls you can join in conference 
depends on your service plan. 

• Extract a caller from the conference 
call to talk with them privately by 
pressing Menu  (right action 
key), selecting Extract, and then 
selecting the name. The extracted call 
becomes the active call.

 

• Swap between the conference call 
and the private call by pressing Swap 

 (left action key).

4 When you’re done, do one of the 
following:

• If you have extracted a call, press 
Power/End  twice to hang up all 
calls or press Power/End  once 
to hang up the active call.

• If you have not extracted a call, press 
Power/End  once to hang up all 
calls.

Forwarding calls

You can forward calls to another phone 
number. Please check with your wireless 
service provider about availability and 
pricing of forwarded calls; additional 
charges may apply.

When all calls are forwarded, the call 
forwarding  icon appears in the title bar.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Preferences > Phone 

Settings. 

3 Select the Services tab, and then select 
Call Forwarding from the list.
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4 Specify your call forwarding settings. 
Some of the settings may already be set 
by your wireless service provider to 
send your calls to voicemail.

5 Press OK .

Defining speed-dial 
buttons

Your smartphone enables you to create 
both picture and text speed-dial buttons so 
that you can select a button on the Today 
screen to quickly dial a number. 

Creating a speed-dial button

You can create up to 20 picture buttons and 
50 text buttons. 

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select New Speed Dial. 

3 Do one of the following:

• Select Link to contact, select the 
contact you want to link to this button, 
and then select the number you want 
to dial with this button.

• Select Label and enter a name for this 
button, and then select Number and 
enter the phone number you want to 
dial with this button.
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4 (Optional) Enter a Quick Key. When the 
Today screen is showing, you can press 
and hold the Quick Key to instantly dial 
this number.

Quick Keys can be letters or numbers, 
but you can’t use both the letter and 
number on the same key. For example, 
the voicemail Quick Key is 1. The letter 
equivalent for that key is E, so you 
cannot assign E as a Quick Key to 
another speed-dial button.

5 If this button is linked to a contact entry 
with a picture, select either Text Speed 

Dial or Picture Speed Dial to indicate 
which type of button you want to 
create. If this button is not linked to a 
contact or the contact doesn’t have a 
picture, the Picture Speed Dial option is 
not available.

6 (Optional) Select the Advanced tab and 
set any of the following options:

Extra Digits: Defines additional 
numbers to dial, such as a password or 

extension. In addition to numbers, you 
can enter the following symbols: star 
(*) and pound (#). To enter a one- 
second pause, enter a comma (,). 

Dial extra digits automatically: Dials 
predefined Extra Digits immediately 
after dialing the phone number. If you 
do not check this box, you must press 
Extra Digits  (left action key) to 
dial these digits.

Show voice mail buttons: Displays the 
voicemail playback controls after you 
dial this speed-dial number. When this 
option is checked, you can enter 
numbers below each control to tailor 
the controls to your voicemail system.

 Plays the previous message.

TIP You can add a special ringtone to a contact 
associated with the speed-dial button. See 
Adding a contact.
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 Saves the current message.

 Plays the current message.

 Deletes the current message.

 Repeats the current message.

 Plays the next message.

7 Press OK . 

Editing a speed-dial button

1 Go to your Today screen.

2 Highlight the speed-dial button you 
want to edit.

3 Press and hold Center  to open the 
shortcut menu, and then select Edit 

Speed Dial. 

4 Make the desired changes.

5 Press OK . 

Deleting a speed-dial button

1 Go to your Today screen.

2 Highlight the speed-dial button you 
want to delete.

3 Press and hold Center  to open the 
shortcut menu, and then select Edit 

Speed Dial. 

4 Press Delete  (right action key).

5 Select Yes to confirm the deletion.

Arranging your speed-dial buttons

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Speed Dial Options.

3 Highlight the button you want to move.

4 Press Option  + Left  or Right  or 
Up  or Down  to move the button 
in that direction.

Using a phone 
headset

You can connect a phone headset for 
hands-free operation. You can use either 
the headset that came with your 
smartphone or a compatible third-party 
headset.

TIP You can also edit a speed-dial button by 
pressing Menu, selecting Speed Dial 

Options, and then selecting the button you 
want to edit.
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IMPORTANT If driving while using a 
smartphone is permitted where you are 
and you need to make a call, we 
recommend using a phone headset or a 
hands-free car kit (sold separately). If you 

must use the wired headset while driving, 
place a speaker in only one ear. Leave the 
other ear free to hear outside noises. Make 
such a call only if it is legal to do so and you 
can do so safely.

Using a wired headset

The headset button is context-sensitive, 
and it performs various actions based on 
the situation. You can press the headset 
button to perform any of the following 
tasks:

• Answer an incoming call

• Respond to call waiting

• Hang up a single active call or all calls on 
a conference call if there is no extracted 
call

Microphone

Speakers

Headset button
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• Swap between calls if there is one 
active call and one call on hold

NOTE Your smartphone works with 
headsets that have a 2.5mm, 3-pin 
connector (look for two colored bands on 
the plug). When in doubt, ask the 
third-party headset manufacturer if the 
product is compatible with your 
smartphone. If you hear a headset buzz or 
poor microphone performance, your 
headset may be incompatible with your 
smartphone.

Connecting to a Bluetooth® hands-free 

device

Your smartphone is also compatible with 
many headsets and car kits (sold 
separately) enabled with Bluetooth® 
wireless technology version 1.1 or 1.2. 

For a list of compatible hands-free devices 
with Bluetooth wireless technology, go to 
www.palm.com/treo800W-support.

After you set up a connection with a 
Bluetooth headset or hands-free car kit, 
you can communicate with that device 
whenever it is within range and the 
Bluetooth feature on your smartphone is 

turned on. The range varies greatly, 
depending on environmental factors. The 
maximum is about 9 meters (30 feet).

1 If necessary, prepare the device with 
which you want to connect to accept a 
new connection. Check the device’s 
documentation for details. Be sure to 
find out if the device has a predefined 
passkey that you need to enter on your 
smartphone in step 7.

2 Go to your Today screen and tap 
Bluetooth .

3 Select the Mode tab and check the Turn 

on Bluetooth box.

DID YOU KNOW? If you have both a compatible 
Bluetooth headset and a car kit, the one you 
connected to your smartphone last becomes 
the active device.
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4 Select the Devices tab, and then select 
Add new device.

5 Wait for your smartphone to search for 
devices and to display the device list.

6 Select the device you want to connect 
to, and then press Next  (right 
action key).

7 Enter a passkey between 1 and 16 
digits long, and then press Next  
(right action key).

IMPORTANT Some hands-free devices 
have a predefined passkey. If your 
hands-free device has a predefined 
passkey, you can find it in the 
documentation for that device. Other 
devices provide a screen where you enter 
a passkey that you make up. In either case, 
you must use the same passkey on both 
your smartphone and your hands-free 
device. We recommend that you use a 
passkey of 16 digits, where possible, to 
improve the security of your smartphone. 
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The longer the passkey, the more difficult 
it is for the passkey to be deciphered.

8 If the passkey is not predefined, enter 
the same passkey on the other 
Bluetooth device, and then press Finish 

 (right action key).

9 Check the Hands Free box, and then 
press Finish  (right action key). 

10 Press OK .

You can now communicate with this device 
whenever it is within range and the 
Bluetooth feature on your smartphone is 
turned on. The range varies greatly, 
depending on environmental factors. The 
maximum is about 9 meters (30 feet).

Using a Bluetooth hands-free device

To learn how to set up and connect to 
Bluetooth devices, see Connecting to a 
Bluetooth® hands-free device. 

Here are tips for working with a Bluetooth 
hands-free device:

• To transfer a call from the handset to a 
Bluetooth hands-free device during a 
call, press Menu  (right action 
key) and select Connect Bluetooth. To 
transfer the call back to the headset, 
press Menu  (right action key) 
and select Cancel Bluetooth.

• To transfer a call from a wired headset 
to a Bluetooth headset or car kit that is 
within range and with which you’ve 
previously set up a partnership 
(Bluetooth headset or car kit required, 
sold separately), unplug the wired 
headset and press the button on the 
Bluetooth headset or car kit. 

• To find out how to transfer your 
contacts from your smartphone to your 
car kit, go to www.palm.com/
treo800W-support.

DID YOU KNOW? The Bluetooth icon on your Today 
screen indicates the status of the Bluetooth 
feature See The Bluetooth status icon for 
details.
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Customizing phone 
settings

Selecting ringtones and display notices

You can set different tones for different 
types of incoming phone calls and 
notifications. You can download MP3, 
MIDI, AMR, WAV, and WMA ringtones 
directly to your smartphone (see 
Downloading files and images from a web 
page). You can also download ringtones to 
your computer and then email them to your 
phone.

1 Press Start  and select Settings.

2 On the Personal tab, select Sounds & 

Notifications .

3 Select the Notifications tab.

4 Select the Event list, and then select 
the type of call or notification for which 
you want to set the ringtone:

Phone: Known Caller: An incoming call 
from someone in your Contacts list or 
Speed Dial list.

Phone: Missed call: A call you did not 
answer.

DID YOU KNOW? If you’re using a Bluetooth 
hands-free device and it is within range, your 
smartphone routes all calls to the hands-free 
device instead of to the earpiece on your 
smartphone. Bluetooth range is up to 9 
meters (30 feet) in optimum environmental 
conditions. 
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Phone: Roaming: A call that comes in 
when you’re outside your home mobile 
network.

Phone: Unknown Caller: An incoming 
call from someone identified by caller 
ID who is not in your Contacts list or 
Speed Dial list. 

Phone: Voice mail: A new voicemail.

5 If you selected Known Caller, Roaming, 
or Unknown Caller, select the ring type 
and the ringtone. Select the Play icon to 
preview the ringtone sound.

6 If you selected Missed call or Voice 
mail, set the following options:

• Check the Play Sound box if you 
want to have a sound played when 
the event occurs. 

• If you checked the Play Sound box, 
then select the sound for the selected 
type of call. You can also check the 
Repeat box to have the sound repeat.

• (Optional) Select the Play icon to 
preview the sound.

• Check the Display message on 

screen box to have a message 
displayed when the event occurs.

7 Check the Vibrate when… boxes to 
turn the vibrate feature on/off based on 
the Ringer switch setting.

8 Repeat steps 4–7 to select ringtones for 
other types of calls. 

9 Press OK .

DID YOU KNOW? You can record, preview, delete, 
and send sounds on your smartphone. You 
can also set sounds for messaging 
notifications and calendar reminders. See 
Selecting Sounds & Notifications.
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Adjusting call and ringer volume

• Call volume: While a call is in progress, 
press Volume (on the side of your 
smartphone) to adjust the call volume. 

• Ringer volume: When a call is not in 
progress and you are not playing music 
or a video, press Volume to adjust 
ringer volume.

Assigning a caller ID ringtone

1 Press Start  and select Contacts.

2 Highlight the contact’s name.

3 Press Menu  (right action key) 
and select Edit.

4 Select Ring tone.

5 Select a tone for this contact entry.

6 Press OK .

Enabling TTY

You can enable your smartphone for use 
with a TTY/TDD device. A TTY (also known 
as a TDD or Text Telephone) is a 
telecommunications device that enables 
people who are deaf or hard of hearing, or 
who have speech or language disabilities, 
to communicate by telephone.

Your smartphone is compatible with select 
TTY devices. You can connect a TTY/TDD 
machine, headset, or hands-free kit to your 
smartphone through the headset jack while 
in TTY/TDD mode. Please check with the 
manufacturer of your TTY device for 
connectivity information. Be sure that the 
TTY device supports digital wireless 
transmission.

NOTE Not all wireless service providers 
support the TTY feature on your 
smartphone. Check with your wireless 
service provider for information.

Volume 



Y O U R  P H O N E

C U S T O M I Z I N G  P H O N E  S E T T I N G S60

4
C

H
A

P
T

E
R

BEFORE YOU BEGIN

• Make sure your smartphone is 
connected to a TTY/TDD machine using 
the headset jack. When you enable TTY, 
all audio modes are disabled on your 
smartphone, including holding the 
smartphone up to your ear and 
listening.

• Turn on your phone to access your 
Phone Settings. See Turning your phone 
on.

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 On the Phone tab, select the TTY/TDD 
list and then select either On or Off.

4 If an alert appears, press OK .

5 Press OK .

NOTE When TTY/TDD is on, a TTY/TDD 
 icon appears at the top of the Today 

screen.

Adding contact numbers from new callers

By default, you are prompted to add 
contact entries for numbers that are not 
already in your Contacts list. You can turn 
this feature on or off.

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 On the Phone tab, check the After calls 

from numbers that are not in 

Contacts, ask if I want to add them 

box.

4 Press OK .

Blocking calls

You can block (bar) incoming or outgoing 
calls.

BEFORE YOU BEGIN You need to do the 
following:

• Make sure that call barring is supported 
by your service plan. Check with your 
wireless service provider for more 
information.
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• Get a call barring password from your 
wireless service provider.

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Preferences > Phone 

Settings.

3 Select the Services tab, and then select 
Call Barring from the list.

4 Select the Block incoming calls list, 
and then select one of the options:

Off: No incoming calls are blocked.

When roaming: All incoming calls are 
blocked when roaming.

All calls: All incoming calls are blocked.

5 Select the Block outgoing calls list and 
then select one of the options:

Off: No outgoing calls are blocked.

International: All outgoing international 
calls are blocked.

International except to home 

country: All outgoing international calls 
are blocked except to the country 
where the phone is based.

All calls: All outgoing calls are blocked.

6 Press OK .

7 Enter the call barring password and 
press Done  (right action key).

Setting caller ID

You can turn caller ID on or off.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Preferences > Phone 

Settings. 
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3 Select the Services tab, and then select 
Caller ID from the list.

4 Select the appropriate option to provide 
your caller ID to Everyone or No one.

5 Press OK .

Setting call waiting notification

You can choose to be notified when you 
receive a call while you are on a call. You 
can choose to accept the call or not. See 
Answering a second call (call waiting).

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Preferences > Phone 

Settings. 

3 Select the Services tab, and then select 
Call Waiting.

4 Select the appropriate option to receive 
a notification or not.

5 Press OK .

Manually selecting your wireless band

IMPORTANT The wireless band setting is 
preset for optimum performance. Do not 
change this setting unless instructed to do 
so by a representative from your wireless 
service provider.
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BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Preferences > Phone 

Settings.

3 Select the Services tab, and then select 
Band Selection from the list.

4 Select the Select network type list, 
and then select one of the following:

Auto: Automatically selects a network.

GSM: Connects only to GSM networks.

CDMA2000: Connects only to 
CDMA2000 (3G or HSDPA) networks.

5 Select the Select your 

CDMA2000 Band list, and then select 
either Auto or one of the bands listed. 
The band options differ depending on 
your wireless service provider.

6 Press OK .

Enabling fixed dialing

Fixed dialing allows you to restrict your 
outgoing calls and messages to selected 
phone numbers included in your fixed 
dialing list. After the service is activated, 
you can call and send messages only to the 
phone numbers from the list.

The list is protected by a PIN2 code. If you 
enter an incorrect PIN2 more times than 
allowed by your wireless service provider, 
the SIM card locks. After the SIM card 
locks, you need the PUK2 (pin unblocking 
key) to unlock the SIM card. Contact your 
wireless service provider for more 
information and your PIN2 and PUK2.
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BEFORE YOU BEGIN

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

• Get your PIN2 from your wireless 
service provider

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Preferences > Phone 

Settings. 

3 Select the Services tab, and then select 
Fixed Dialing.

4 Check the Enable fixed dialing box.

5 Enter your PIN2 and press Done  
(left action key).

6 Press Menu  (right action key) to 
add, delete, or edit the phone numbers 
in the list.

7 Press OK .

Manually selecting your network settings

IMPORTANT The network settings are 
preset for optimum performance. Do not 
change these settings unless instructed to 
do so by a representative from your 
wireless service provider. The network 
settings options vary according to your 
wireless service provider.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Preferences > Phone 

Settings. 

3 Select the Network tab.
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4 To switch to another network, select 
Find Network and select an available 
network.

5 To change your preferred network, 
select Set Networks, check the box 
next to the networks you want, and 
then select your order of preference.

6 From the Network Selection list, select 
an option:

Automatic: The network connection is 
automatically made.

Manual: Network connections are 
manually made. If you are manually 
selecting a network, select a network 
from the list of available networks.

7 Press OK .
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What are all those 
icons?

You can monitor the status of several items 
using icons at the top of your Today screen:

You missed an incoming call.

You have a voicemail message.

You have a new email message.

You have a new text or 
multimedia message.

No SIM card is inserted or 
software is unable to recognize 
the SIM.

You have more than one of the 
conditions listed above.

Your phone is on. The bars 
display the signal strength. 
The stronger the signal, the 
more bars that appear. If you are 
outside a coverage area, no bars 
appear.

Your phone is off.

The SIM card is locked. You need 
to enter a PIN or a PUK to unlock 
the SIM card (see Locking the 
SIM card).

A voice call is in progress.

TTY/TDD is turned on.

All calls are being forwarded.

You are in a roaming coverage 
area. Additional fees may apply 
for calls or data transmission.

Your phone is connected to a 
CDMA2000 (3G or HSDPA) 
network, but you are not actively 
transmitting data. You can still 
make or receive calls.

Your phone is on and a 3G 
CDMA2000 data connection is 
active. You can make and receive 
calls and transmit data 
simultaneously.
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Your phone is connected to a 
HSDPA CDMA2000 network, but 
you are not actively transmitting 
data. You can still make or 
receive calls.

NOTE In most cases, when your 
phone is connected to a 
CDMA2000 network (either 3G 
or HSDPA) but you are not 
actively transmitting data, the 3G 
icon appears. The H icon may 
appear when your phone is 
connected to a HSDPA 
CDMA2000 network, but you are 
not actively transmitting data

Your phone is on and an HSDPA 
CDMA2000 data connection is 
active. You can make and receive 
calls and transmit data 
simultaneously.

Your phone is connected to an 
EDGE network, but you are not 
actively transmitting data. You 
can still make or receive calls.

Your phone is on and an EDGE if 
data connection is active. You 
can still make or receive calls, 
but the data transmission is 
automatically interrupted.

Your phone is connected to a 
GPRS network, but you are not 
actively transmitting data. You 
can still make or receive calls.

Your phone is on and a GPRS 
data connection is active. You 
can still make or receive calls, 
but the data transmission is 
automatically interrupted.

ActiveSync synchronization is in 
progress.

Your smartphone is connected to 
a computer or network, or 
Windows Mobile Device Center 
synchronization is in progress.

A data connection is not available 
or your phone is off.

Your smartphone’s battery is low.
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Your smartphone’s battery is 
charging.

Your smartphone is connected to 
a power outlet and the battery is 
fully charged.

Wireless 
service 
provider 
name

Your phone is on. When you turn 
off your phone, Phone Off 
appears instead.

The Bluetooth® wireless 
technology status indicator 
appears in gray when this feature 
is off, in blue when this feature is 
on, and in reverse blue when 
your smartphone 
is communicating with another 
Bluetooth device. 

A call is in progress and your 
smartphone is connected to a 
Bluetooth headset or car kit. 

You have a reminder. If the 
reminder is not displayed on your 
Today screen, tap the icon to 
open the reminder.

You have an alert from Microsoft. 
If the alert is not displayed on 
your Today screen, tap the icon 
to open the alert.
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Synchronizing information
Synchronizing means that information that has been entered or 
updated in one place—your Palm® Treo™ 800W smartphone, your 
computer, or your corporate server—is automatically updated in 
the other. There’s no need to enter information twice. Some 
types of synchronization can happen on an automated schedule, 
so you don’t even have to think about it.

After you get into the habit of synchronizing regularly, you’ll 
know what a powerful tool synchronization is for transferring, 
updating, and backing up large amounts of information on your 
smartphone.

Benefits

• Quickly enter and update 
information on your computer and 
your smartphone

• Protect your information

• Send photos and videos to your 
smartphone from your desktop 
computer
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Synchronization 
overview

This chapter discusses using desktop sync 
software and other methods to synchronize 
your smartphone and your computer.

When you synchronize, info you enter on 
your smartphone, your computer, or your 
corporate server is automatically updated 
in the other location. There’s no need to 
enter the info twice. This is true whether 
you sync with your computer using 
desktop synchronization software (see 
Setting up your computer for 
synchronization) or wirelessly with your 
company’s Exchange server using 
Microsoft Exchange ActiveSync (see 
Setting up wireless synchronization).

How do I 
synchronize?

There are a number of ways to make 
synchronization occur. You can install 
desktop sync software on your computer 
to synchronize in one of several ways, or 
you may be able to synchronize wirelessly 
with an Exchange server. You can also 
maximize your sync options and sync with 
both an Exchange server and desktop sync 
software to maximize your sync options.

Synchronizing with desktop sync 

software

BEFORE YOU BEGIN Install the software 
from the Windows Mobile Getting Started 
CD, which came with your smartphone. 
You must install this software even if you 
have already installed a previous version of 
desktop sync software. See Installing 
ActiveSync desktop software: Windows XP 
or Installing Windows Mobile Device 
Center: Windows Vista for instructions. 
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After you install desktop sync software, 
you can synchronize in any of the following 
ways:

• By connecting your smartphone to your 
computer using the sync cable (see 
Synchronizing using the sync cable)

• By connecting your smartphone to your 
computer using Bluetooth® wireless 
technology (see Synchronizing over a 
Bluetooth connection)

• By connecting your smartphone to your 
computer using the infrared (IR) ports 
(see Synchronizing over an infrared 
connection)

If you have a Windows XP computer: 
The desktop sync software is called 
ActiveSync® desktop software. 

If you have a Windows Vista computer: 
The desktop sync software is called 
Windows Mobile Device Center. The sync 
application on your smartphone is called 
ActiveSync. 

Synchronizing wirelessly with the server

You can set up your smartphone to 
synchronize email and other information 
wirelessly with Microsoft Exchange Server 

2003 or Exchange Server 2007 using 
Microsoft Exchange ActiveSync (see 
Setting up wireless synchronization). If you 
choose this method, synchronization takes 
place automatically after setup. You do not 
need to install the software from the 
Windows Mobile Getting Started CD.

NOTE We recommend that you install the 
desktop sync software from the CD even if 
you synchronize wirelessly with the server. 
You need the desktop sync software to 
synchronize pictures, videos, music files, 
and other info directly with your computer.

What can I 
synchronize?

If you have Microsoft Office Outlook® 2002 
or later installed on your computer, by 
default, the following information is 
synchronized when you synchronize using 
either desktop sync software or Microsoft 
Exchange ActiveSync:
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You can, however, customize sync settings 
to suit your needs and sync only some of 
these applications. 

If you set up synchronization with your 
computer using the desktop sync 
software, information in the Favorites 
application is synchronized by default as 
well. You can also change settings to 
synchronize Word, Excel, PowerPoint, and 
PDF files, as well as pictures, music, 
videos, and other types of files (see 
Changing which applications sync). 

IMPORTANT To synchronize Calendar, 
Contacts, Inbox (email), and Tasks, you 
must have Outlook 2002 or later installed 
on your computer. If you want to 
synchronize pictures, music, and videos, 
you need to have Windows Media Player 
10 or later installed on your computer.

This table lists the types of info you can 
synchronize and the methods to use.

DID YOU KNOW? Synchronizing Favorites gives you 
an easy way to get favorites from the web 
browser on your computer into the web 
browser on your smartphone. Just add them 
to the folder called Mobile Favorites, which 
shows up in your computer's browser. When 
you sync, they become available on your 
smartphone as well. Backup copies of any 
favorites that you add on the smartphone 
browser are also stored in the Mobile 
Favorites folder.

TIP If you don’t already have Outlook or 
Windows Media Player installed on your 
computer, you can install them from the 
Windows Mobile Getting Started CD. Insert 
the CD into your computer’s CD drive, select 
Add Programs (Windows XP) or Bonus 

Software (Windows Vista), and then select 
Windows Media Player or the link to 
download a trial version of Outlook 2007.

TIP If you want to synchronize with a personal 
information manager (PIM) other than 
Microsoft Office Outlook, you must install a 
third-party solution. Contact the PIM’s vendor 
to learn if software is available for your 
smartphone
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Info type Method Where to learn more

Outlook Contacts, 
Calendar, Tasks

Desktop sync software 
(sync with computer) or 
Exchange ActiveSync 
(direct sync with server)

Setting up your computer for 
synchronization or 

Setting up wireless synchronization

Outlook Email Desktop sync software or 
Exchange ActiveSync

Setting up your computer for 
synchronization or 

Setting up wireless synchronization

Word, Excel, 
PowerPoint, PDF 
files

Desktop sync software Setting up your computer for 
synchronization

Synchronizing your Microsoft Office 
files

Changing which applications sync

Music and video 
files

Desktop sync software 
and Windows Media 
Player

Setting up your computer for 
synchronization

Changing which applications sync

Transferring media files to your 
smartphone

Pictures Windows XP: Desktop 
sync software

Windows Vista: Desktop 
sync software and 
Windows Media Player

Setting up your computer for 
synchronization

Changing which applications sync

Transferring media files to your 
smartphone (Windows Vista)
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Setting up your 
computer for 
synchronization

Before you can synchronize, you need to 
install your desktop sync software and 
connect the sync cable to your computer. 
Even if you already have desktop sync 
software installed on your computer, you 
must install the software that came with 
your smartphone on the Windows Mobile 
Getting Started CD.

System requirements

Your computer must meet the following 
minimum system requirements:

• Windows XP Service Pack 2 or 
Windows Vista (later versions may also 
be supported)

• 32MB of available memory (RAM)

• 170MB of free hard disk space

• CD drive

• Available USB port

• USB sync cable (included with your 
smartphone)

• Adobe Flash Player (required to run the 
installation program)

Outlook Notes Desktop sync software Setting up your computer for 
synchronization

Changing which applications sync

Files to be 
transferred to an 
expansion card

Desktop sync software Setting up your computer for 
synchronization

Changing which applications sync

Info type Method Where to learn more
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Installing ActiveSync desktop software: 

Windows XP

If you have a Windows XP computer, the 
desktop sync software is called ActiveSync 
desktop software. The Windows Mobile 
Getting Started CD recognizes that you 
have a Windows XP computer and 
automatically directs you to install 
ActiveSync desktop software. On your 
smartphone, the sync application is called 
ActiveSync.

BEFORE YOU BEGIN If you are installing 
the software on a computer at work, make 
sure your company allows you to install 
new software. Contact your company’s 
IT department for help.

1 Close any applications that are currently 
running on your computer, including 
those running in the background. Your 
computer must have all its resources 
available to install the software.

2 Insert the Windows Mobile Getting 
Started CD into the CD drive on your 
computer.

3 Follow the installation instructions that 
appear on both your computer and your 
smartphone.

During installation, you connect your 
smartphone to your computer and sync 
for the first time. Be sure to watch 
what’s happening on both your 
computer and your smartphone. For 
more info, see Connecting your 
smartphone to your computer and 
Synchronization.

TIP If you do not have Adobe Flash Player on 
your computer, you can download it for free 
from www.adobe.com.

TIP During software installation, you can select 
an option to synchronize email, contacts, 
calendar events, and tasks directly with 
Microsoft Exchange Server 2003 or 2007. If 
you choose this option, you are prompted to 
enter your mail server address and domain 
name and your Exchange server account 
username and password.

DID YOU KNOW? You can also install additional 
software from the Windows Mobile Getting 
Started CD (see Installing bonus software 
from the CD).
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Installing Windows Mobile Device Center: 

Windows Vista

If you have a Windows Vista computer, the 
desktop sync software is called Windows 
Mobile Device Center. The Windows 
Mobile Getting Started CD recognizes that 
you have a Windows Vista computer and 
automatically directs you to install 
Windows Mobile Device Center. On your 
smartphone, the sync application is called 
ActiveSync.

BEFORE YOU BEGIN If you are installing 
the software on a computer at work, make 
sure your company allows you to install 
new software—for example, that you have 
Administrator privileges. Contact your 
company’s IT department for help.

1 Close any applications that are currently 
running on your computer, including 
those running in the background. Your 
computer must have all its resources 
available to install the software.

2 Insert the Windows Mobile Getting 
Started CD into the CD drive on your 
computer.

3 If prompted, click RunStart.exe.

4 Click Continue.

5 Select your language and click Next.

6 Select Setup and Installation.

7 Make sure the Windows Mobile 

Device Center box is checked, and click 
Install.

8 Follow the installation instructions that 
appear on both your computer and your 
smartphone.

During installation, you connect your 
smartphone to your computer and sync 
for the first time. Be sure to watch 
what’s happening on both your 
computer and your smartphone. For 
more info, see Connecting your 
smartphone to your computer and 
Synchronization.

Using the desktop sync software

After you install the desktop sync software, 
synchronization happens automatically 
anytime you connect your smartphone to 
your computer, as described in the next 
section. You can also open the desktop 
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sync software window on your computer 
to perform the following tasks:

• Install applications from your computer 
to your smartphone (see Installing 
applications from your computer) or to 
an expansion card inserted into the 
expansion card slot on your smartphone 
(see Installing applications onto an 
expansion card)

• Change which applications synchronize 

• In ActiveSync desktop software on a 
Windows XP computer, enter settings 
to synchronize wirelessly with Microsoft 
Exchange Server 2003 or 2007

To open the desktop sync software, do one 
of the following:

Windows XP: To open the ActiveSync 
desktop software window, double-click the 
ActiveSync  icon in the taskbar in the 
lower-right corner of your computer screen.

Windows Vista: To open Windows Mobile 
Device Center, click Start > All Programs 
> Windows Mobile Device Center.

Desktop software installation also creates 
a folder for your smartphone on your 
computer. When your smartphone is 
connected to your computer, opening My 
Computer or Windows Explorer (Windows 
XP) or Computer (Windows Vista) displays 

DID YOU KNOW? You can also change which 
applications synchronize (see Changing which 
applications sync) and enter settings to 
synchronize wirelessly (see Setting up 
wireless synchronization) in the ActiveSync 
app on your smartphone. Whether you enter 
changes on your smartphone or on your 
computer, the changes are transferred to the 
other location the next time you synchronize.

TIP If the ActiveSync icon does not appear in 
the taskbar, go to Start, navigate to 
Programs, and then select Microsoft 

ActiveSync to open the ActiveSync window.

TIP You can enter a setting to have the 
ActiveSync window open automatically when 
you connect your computer and your 
smartphone. In the ActiveSync window, select 
File > Connection Settings, and then check 
the Open ActiveSync when my device 

connects box.
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an icon representing your smartphone. 
Double-clicking this icon displays folders 
containing items you synchronized, such as 
music files, pictures, and videos. 

Connecting your smartphone to your 

computer

NOTE If you’re transferring info from a 
previous Windows Mobile® device or from 
a Palm OS® device, you can learn more 
about how to move content, such as 
pictures, music, and files, to your 
smartphone by going to www.palm.com/
treo800W-support.

1 If international adapters are included in 
your smartphone package, prepare the 
AC charger by connecting the adapter 
that fits the wall outlet you’re going to 
use.

2 Plug the AC charger into a wall outlet.

3 Plug the USB sync cable into an 
available USB port or into a powered 
USB hub on your computer.

4 Connect the sync cable to your 
smartphone by inserting it into the two 
sockets to the left on the bottom of the 
smartphone.

5 Connect the charger cable to the 
remaining socket on the bottom of your 
smartphone.

TIP For best performance, plug your sync cable 
directly into a USB port on your computer. If 
your computer has USB ports on both the 
front and back, we suggest using the back 
port. If you use a USB hub, make sure it’s a 
powered hub.

DID YOU KNOW? The AC charger contains an 
indicator light that glows when the charger is 
connected to a power source.
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Synchronizing using 
the sync cable

Every time you connect your smartphone 
to your computer, the desktop sync 
software automatically turns on and checks 

whether changes you made on the 
computer or on the smartphone need to be 
synchronized.

1 Connect your smartphone to your 
computer (see Connecting your 
smartphone to your computer). 

USB sync
cable

This button has no 
function with your 
smartphone
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2 Check for synchronization progress:

Windows XP: Look for the animated 
ActiveSync  icon at the top of your 
smartphone screen and the ActiveSync 

 icon in the taskbar on your 
computer. 

Windows Vista: Look for the animated 
connection  icon at the top of your 
smartphone screen.

• If you don’t see the correct icon, make 
sure the desktop sync software that 

came with your smartphone is 
running on your computer. 

• If you have any problems 
synchronizing, see Synchronization for 
troubleshooting suggestions.

Setting up wireless 
synchronization

Does your company use Microsoft Outlook 
as its email solution? Does your company 
also use Microsoft Exchange Server 2003 
or 2007 as its email server? If so, you may 
be able to wirelessly synchronize the email 
and other Outlook info on your smartphone 
and the same info stored on the Exchange 
server using Microsoft Exchange 
ActiveSync. 

This button has no 
function with your 
smartphone

TIP We recommend that you install the backup 
and restore app from the Windows Mobile 
Getting Started CD. A backup and restore app 
preserves your data and settings if your 
smartphone is ever lost or stolen, and it 
protects your data during a hard reset.



S Y N C H R O N I Z I N G  I N F O R M A T I O N

S E T T I N G  U P  W I R E L E S S  S Y N C H R O N I Z A T I O N82

5
C

H
A

P
T

E
R

If you are using Exchange Server 2007 or 
Exchange Server 2003 that has been 
upgraded to Service Pack 2, you may be 
able to take advantage of the additional 
features of Direct Push Technology. Direct 
Push Technology is a two-way wireless 
delivery method that keeps your Outlook 
information always up-to-date and provides 
more efficient communication between the 
server and your smartphone. It includes 
features like Global Address List; Tasks 
Over The Air (OTA); and IP-based push 
updating of Calendar, Messaging, and 
Inbox (email).

BEFORE YOU BEGIN To synchronize 
wirelessly, you need to set up an Exchange 
Server account. Work with your system 
administrator to gather the following info, 

and then follow the steps in this section to 
set up an account:

• Mail server address and domain name.

• The username and password you use to 
access your corporate mail server.

• Security connection: Does your server 
use an encrypted (SSL) connection?

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right action key) 
and select Add Server Source. 

4 Enter the server address. Check the 
This server requires an encrypted 

DID YOU KNOW? Because your desktop copy of 
Outlook also syncs with the server, whatever 
is synchronized to the server from your 
smartphone also shows up in Outlook; and 
whatever you enter or change in Outlook on 
your computer syncs to the server and then 
shows up on your smartphone.

TIP If you installed ActiveSync desktop 
software on a Windows XP computer, you 
may have already set up your smartphone to 
synchronize wirelessly with the server. To 
check, press Start, select Programs, and 
then select ActiveSync. Press Menu (right 
action key). If Configure Server appears 
instead of Add Server Source, wireless sync is 
already set up, and you can skip this 
procedure.
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(SSL) connection box if your server 
uses an encrypted connection. 

5 Press Next  (right action key).

6 Enter the username and password you 
use to access your corporate mail 
server, and enter the Exchange server 
domain. 

NOTE You can’t see your password as you 
enter it, so be careful. Be sure Caps Lock 
and Option Lock are not on unless you 
need them. For info on how to enter 
characters, see Entering lowercase and 
uppercase letters and Entering numbers, 
punctuation, and symbols.

7 Check the Save password box.

8 (Optional) Select Advanced to set the 
rules for fixing sync conflicts.

9 Press Next  (right action key) and 
check the boxes for the types of 

TIP The Exchange server settings are case- 
sensitive. Be sure to enter uppercase and 
lowercase letters properly.

TIP Ask your system administrator if it is OK to 
store your corporate email password on your 
smartphone (for increased security, you may 
need to enter your password each time you 
access your email). If it is not OK, don’t check 
the Save password box; you must 
synchronize manually (see Initiating a wireless 
sync manually).
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information you want to synchronize 
with the Exchange server.

10 (Optional) Highlight an item and select 
Settings to change the synchronization 
settings for that type of information. 
Settings are not available for all items. 

11 Press Finish  (right action key). 
Synchronization with your Exchange 
server begins automatically. A status 

bar appears onscreen indicating sync 
progress.

You can set a schedule for synchronization 
to take place anytime info is updated on 
either your smartphone or the server or at 
certain intervals (see Setting the 
synchronization schedule), or allow 
synchronization to take place only when 
you initiate it manually (see Initiating a 
wireless sync manually).

Setting the synchronization schedule

You can set a synchronization schedule in 
either of the following situations:

If you use Microsoft Exchange Server 

2007 or Microsoft Exchange Server 2003 

with Service Pack 2: By default, wireless 
sync takes place anytime info is updated 
on either your smartphone or the server 
using Direct Push Technology. To save 
battery life, however, you can set 
synchronization to take place at intervals 
that you specify.

If you use Microsoft Exchange Server 

2003 that is not upgraded to Service 

Pack 2: By default, wireless sync does not 
take place automatically. Set a 

TIP To automatically download more of an 
incoming email message than the default 
setting, select E-mail in step 9 and select a 
higher number from the Download size limit 
list. If you don’t increase this setting, you can 
manually download the rest of the message at 
your convenience.



S Y N C H R O N I Z I N G  I N F O R M A T I O N

S E T T I N G  U P  W I R E L E S S  S Y N C H R O N I Z A T I O N 85

5

C
H

A
P

T
E

R

synchronization schedule to have sync take 
place either anytime info is updated on 
your smartphone or the server, or at certain 
intervals.

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right action key) 
and select Schedule. 

4 Set any of the following options:

Peak times: Sets the frequency for 
high-traffic time periods such as when 
you are at work or when email volume 
is high.

Off-peak times: Sets the frequency for 
low-traffic time periods such as late at 
night. 

Use above settings when roaming: 
Sets the frequency while you are 
roaming outside your wireless service 
provider’s network. You should keep 
this box checked to ensure that wireless 
sync works properly.

Send/receive when I click Send: Sets 
whether items are sent as soon as you 
select Send in the Inbox application, 
or whether they are held until the next 
synchronization. 

5 Press OK .

Initiating a wireless sync manually

If you want to control exactly when a 
wireless sync takes place, or if it is not OK 
to store your corporate email password on 
your smartphone, you can initiate sync 
manually.

1 To set up manual sync, follow the 
preceding procedure, Setting the 
synchronization schedule. In the Peak 
times and Off-peak times lists, select 
Manual.

2 To initiate a manual sync, press Start 
 and select Programs.
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3 Select ActiveSync .

4 Press Sync  (left action key).

Other ways to 
synchronize

Synchronizing over a Bluetooth 

connection

You can synchronize your computer and 
smartphone using Bluetooth wireless 
technology.

BEFORE YOU BEGIN Do the following:

• Make sure your computer is equipped 
with Bluetooth wireless technology.

• If you have not already done so, install 
the ActiveSync Plug-in for Bluetooth 
wireless technology from the Windows 
Mobile Getting Started CD. The plug-in 
is installed on your computer and is 
needed to synchronize over a Bluetooth 
connection with your smartphone.

1 Do one of the following:

Windows XP: On your computer, 
right-click the ActiveSync  icon in 
the taskbar in the lower-right corner of 
the screen, and select Connection 

Settings.

Windows Vista: Click Start > All 

Programs > Windows Mobile Device 

Center. Select Connect without 

setting up your device, and then 
select Connection settings.

2 Check the Allow connections for one 

of the following box, and then select 
Bluetooth.

3 On your smartphone, press Start  
and select Settings.

4 Select the Connections tab, and then 
select Bluetooth .

TIP To install the plug-in for Bluetooth 
technology, insert the Windows Mobile 
Getting Started CD into your computer’s CD 
drive, and select Add Programs (Windows 
XP) or Bonus Software (Windows Vista). 
Select the plug-in option and follow the 
onscreen instructions.
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5 Select the Mode tab and check the Turn 

on Bluetooth box.

6 Press Start  and select Programs.

7 Select ActiveSync .

8 Press Menu  (right action key) 
and select Connect via Bluetooth.

9 If this is the first time you’re making a 
Bluetooth connection to this computer, 
follow the onscreen prompts to set up a 
Bluetooth partnership with this 
computer. See Connecting to devices 
with Bluetooth® wireless technology for 
more information on partnerships.

10 Select Sync.

11 When synchronization has finished, 
press Menu  (right action key) 
and select Disconnect Bluetooth.

Synchronizing over an infrared 

connection

If your computer has an IR (infrared) port, 
you can synchronize with your computer 
wirelessly using the IR port on your 
smartphone.

BEFORE YOU BEGIN

• Make sure your computer is equipped 
with an IR port.

• Turn on your smartphone’s IR 
functionality (see Beaming information).

1 Set up your computer to receive 
infrared beams. See ActiveSync Help on 
your computer for details.

2 Point the IR port directly on your 
smartphone at your computer’s IR port.

3 On your smartphone, press Start  
and select Programs.

4 Select ActiveSync .

5 Press Menu  (right action key) 
and select Connect via IR.

6 Select Sync.

Synchronizing with multiple computers

You can set up your smartphone to 
synchronize with up to two computers as 
well as with Exchange Server 2003 or 2007. 
When synchronizing with multiple 
computers, the items that you synchronize 
appear on all the computers.

For example, if you set up to sync your 
smartphone with two computers named 
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C1 and C2, when you sync Contacts and 
Calendar on your smartphone with both 
computers, you get the following results: 

• The contacts and calendar 
appointments that were on C1 are now 
also on C2. 

• The contacts and calendar 
appointments that were on C2 are now 
also on C1. 

• The contacts and calendar 
appointments from both computers are 
on your smartphone. 

NOTE Microsoft® Office Outlook® E-mail 
can synchronize with only one computer.

Setting 
synchronization 
options

Changing which applications sync

You must select sync options if you want to 
synchronize notes, pictures, and other 
types of files.

1 Press Start  and select Programs.

2 Select ActiveSync . 

3 Press Menu  (right action key) 
and select Options.

4 Do any of the following: 

• Check the box next to any items you 
want to synchronize. If you cannot 
check a box, you might have to 
uncheck a box for the same 
information type elsewhere in the list. 

• Uncheck the box next to any items 
you want to stop synchronizing. 

• Select an item and then select 
Settings to customize the settings for 
that item. Settings are not available 
for all items.
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Stopping synchronization

If you ever need to manually stop 
synchronization, follow these steps:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Stop  (left action key).

TIP For detailed information on synchronizing 
Word documents, Excel spreadsheets, and 
PowerPoint presentations, see Synchronizing 
your Microsoft Office files. For detailed 
information on synchronizing pictures, videos, 
and music files, see Synchronizing your media 
files.

TIP To end the sync relationship between you 
smartphone and a computer so that items are 
no longer synchronized with that computer, 
select the computer name on the ActiveSync 
screen, and then select Delete.
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CHAPTER

6

Your email
You already know how efficient email is for staying in touch. 
Now your Palm® Treo™ 800W smartphone brings you a new level 
of convenience: email on the go. Enjoy the ease and speed 
of communicating with friends, family, and colleagues 
anywhere you can access your wireless service provider’s data 
network.

You can send photos to your friends and family, or create 
Microsoft Word or Excel files and send them to your 
colleagues. You can also receive attachments to view and edit 
at your convenience.

Benefits

• Receive photos, sound files, Word 
and Excel files, and more

• Attach and send files of almost any 
type

• Save messages from your 
computer to view at a convenient 
time
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Setting up email

You can use the Inbox application to send 
and receive email. Before you use your 
smartphone to send or receive messages, 
consult your wireless service provider for 
pricing and availability of email services and 
data rate plans.

BEFORE YOU BEGIN

• Make sure your phone is on and you’re 
inside a coverage area before you send 
or receive messages. 

• If you want delivery of Outlook email 
using Direct Push Technology, make 
sure that your IT organization uses 
Exchange Server 2007 or Exchange 
Server 2003 with Service Pack 2. 

Entering settings for an email account

DID YOU KNOW? You can enter settings for more 
than one email account; and you can use 
different email setup applications on your 
smartphone to enter settings for different 
accounts, depending on which app best 
meets your needs.

Email account type Type of email you can access How to set up

POP/IMAP You can obtain email from an 
ISP or Internet email account 
such as EarthLink, or from a 
small business or corporate 
Internet email account.

See Setting up a POP/IMAP 
account in the Inbox 
application: Common email 
providers or Setting up a POP/
IMAP account in the Inbox 
application: Other email 
providers.
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Setting up a POP/IMAP account in the 

Inbox application: Common email 

providers

Follow this procedure if you have a 
common email provider such as AOL, 
EarthLink, or Yahoo!. If you are setting up 
the Inbox application to work with your 
corporate email account, or you have a 
less-common email provider, see Setting 
up a POP/IMAP account in the Inbox 
application: Other email providers.

BEFORE YOU BEGIN Ask your email 
provider or system administrator for your 
account username and password if you 
don’t know them.

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Select New E-mail Account.

4 Enter the email address that you want 
to set up. Check the box to have the 
setup process get your account settings 
from the Internet. 

Microsoft Exchange 
server

You can retrieve corporate 
email using a Microsoft 
Exchange server. You can 
access email wirelessly if your 
company is using Microsoft 
Exchange ActiveSync®.

See Setting up wireless 
synchronization.

You may need to check with 
your IT organization to ensure 
that Exchange ActiveSync® is 
supported and to obtain the 
configuration settings.

Free web-based 
email

You can access mail from 
Yahoo! and other free 
web-based systems.

Access the email website 
directly using your 
smartphone’s web browser.

Email account type Type of email you can access How to set up
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5 Press Next  (right action key).

6 If the setup process finds your account 
settings, press Next  (right action 
key).

If the setup process does not find your 
account settings, see Setting up a POP/
IMAP account in the Inbox application: 
Other email providers and continue with 
step 7 of that procedure. 

7 Enter your name and, if you want, 
change your account display name to 
something meaningful. For example, if 
this is your work email account, you can 
change the display name to “Work” or 
your company’s name.

8 Press Next  (right action key).

9 Enter your account username and 
password.

10 If you want your password entered 
automatically, check the Save 

password box. If you want to enter 
your password each time you access 
this account, do not check this box. 

11 Press Next  (right action key).

DID YOU KNOW? Checking the Save password box 
makes it easier to check your email, because 
you don’t have to enter your password each 
time. Leaving the box unchecked keeps your 
email more secure, because no one can 
download messages without entering your 
password.
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12 (Optional) Select either of the following:

Automatic Send/Receive: Change the 
time interval for automatically 
downloading email, from every 5 
minutes to once a day. If you do not 
want to automatically download 
messages, select Manually.

Review all download options: Select 
this option to change download 
settings; see Changing email download 
settings for information.

13 Press Finish  (right action key). If 
prompted, select OK to download 
messages for this account now.

Setting up a POP/IMAP account in the 

Inbox application: Other email providers

You can set up an account in the Inbox 
application to send and receive email 
messages using an email account that you 
have with an Internet service provider 
(ISP), an email account that you access 
using a VPN server connection (such as a 
work account; see Connecting to a VPN), 
or any other IMAP or POP email account.

BEFORE YOU BEGIN Work with your 
email provider or system administrator to 
gather the following info:

• Account type (POP3 or IMAP)

• Mail server name for receiving mail

• Your username and password

• Any special security requirements

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Select New E-mail Account.

4 Enter the email address that you want 
to set up. Check the box if you want the 
setup process to try to get your account 
settings from the Internet. 
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5 Press Next  (right action key).

6 If you did not check the box in step 4 or 
the setup process does not find account 
settings, press Next  (right action 
key). 

If you did check the box and the account 
setup process finds your account 
settings, go to Setting up a POP/IMAP 
account in the Inbox application: 
Common email providers and continue 
with step 7 of that procedure.

7 If prompted, select either of the 
following as your email provider:

Internet e-mail: Select this option if you 
access email from any type of email 
account except a corporate account that 
uses an Exchange mail server.

Exchange server: Select this option if 
you access email from a corporate 
email account using an Exchange 
server.

8 Press Next  (right action key).

9 Enter your name and, if you want, 
change your account display name to 
something meaningful. For example, if 
this is your work email account, you can 
change the display name to “Work” or 
your company’s name.
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10 Press Next  (right action key).

11 Enter the name of the incoming mail 
server.

12 Select the Account type list, and then 
select POP3 or IMAP.

13 Press Next  (right action key).

14 Enter your account username and 
password.

15 If you want your password entered 
automatically, check the Save 

password box. If you want to enter 
your password each time you access 
this account, do not check this box. 

16 Press Next  (right action key).

17 If you receive an alert that your wireless 
service provider has already customized 
the outgoing mail server settings, press 
OK  to close the alert, and then 
press Next  (right action key) on 
the outgoing mail server settings 
screen. Do not enter or change anything 
on the screen.

If you do not receive an alert, go to 
Entering outgoing server settings. 

TIP For a corporate email account, ask your 
system administrator if it is OK to store your 
corporate email password on your 
smartphone (for increased security, you may 
need to enter your password each time you 
access your email). If it is not OK, don’t check 
the Save password box.
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18 (Optional) Select either of the following:

Automatic Send/Receive: Change the 
time interval for automatically 
downloading email, from every 5 
minutes to once a day. If you do not 
want to automatically download 
messages, select Manually.

Review all download settings: Select 
this option to change download 
settings; see Changing email download 
settings for information.

19 Press Finish  (right action key). If 
prompted, select OK to download 
messages for this account now.

Entering outgoing server settings

If, during account setup, you do not receive 
an alert saying that your wireless service 
provider has set the outgoing mail options, 
you need to manually enter these settings.

TIP If you do not receive an alert, and if your 
incoming mail requires SSL, you set that 
option with the outgoing server settings. See 
Entering outgoing server settings and check 
the Require SSL for Incoming e-mail box on 
the Advanced Server Settings screen.

DID YOU KNOW? On the Accounts tab in Messaging 
Options, an asterisk appears next to the 
accounts you create.

TIP To delete an email account or to edit 
account settings—for example, if you need to 
change the name of the outgoing mail 
server—press Menu (right action key) and 
select Tools > Options. To delete an account, 
highlight the account you want, press and 
hold Center on the 5-way, and then select 
Delete. (To delete an Outlook Email account, 
use the ActiveSync application, not the Inbox 
application.) To edit an account, select the 
account and go through the screens to change 
the settings you want to edit. 



Y O U R  E M A I L

S E T T I N G  U P  E M A I L100

6
C

H
A

P
T

E
R

BEFORE YOU BEGIN Work with your 
email provider or system administrator to 
gather the following info:

• Mail server name for sending mail

• Any special security requirements

1 On the screen for entering outgoing 
mail settings, select the correct settings 
for the following:

Outgoing (SMTP) mail server: Enter 
the server name. 

Outgoing server requires 

authentication: Check the box if your 
outgoing mail server requires 
authentication. 

Use the same user name and 

password for sending e-mail: Check 

the box if the server requires you to use 
your account username and password 
when sending email. 

2 Select Advanced Server Settings, and 
then select the correct settings for 
either of the following:

Require SSL for Incoming e-mail: 

Check the box if your account requires 
SSL for incoming messages.

Require SSL for Outgoing e-mail: 
Check the box if your account requires 
SSL for outgoing messages.

Network connection: Select the type 
of connection to use for sending and 
receiving email.
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3 Select Done  (left action key). On 
the outgoing mail server screen, press 
Next  (right action key).

4 (Optional) Select either of the following:

Automatic Send/Receive: Change the 
time interval for automatically 
downloading email, from every 5 
minutes to once a day. If you do not 
want to automatically download 
messages, select Manually.

Review all download settings: Select 
this option to change download 
settings; see Changing email download 
settings for information.

5 Press Finish  (right action key). If 
prompted, select OK to download 
messages for this account now.

Sending and 
receiving messages

Selecting which email account to use

If you set up more than one email account 
on your smartphone (see Setting up email), 
you can select the account you want to use 
to view or send messages in one of two 
ways:

• By default, when you open the Inbox 
application, a list of all of your email 
accounts appears. Select the account 
you want.

• If you turn off the option to display the 
list of accounts (see Customizing your 
email settings), when you open the 
Inbox application, the last account you 
were using is displayed. Press Left  to 
cycle through your accounts until the 
name of the account you want appears 
in the title bar.

TIP Also press Left to switch to a different 
account after you are finished working in the 
first account you selected.
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Creating and sending an email message

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Select the account you want to use to 
send a message.

4 Press Menu  (right action key) 
and select New.

5 Enter the recipient’s email address. 
Here are some shortcuts:

• If the recipient’s name and email 
address are in your Contacts list, 
enter the first few letters of the 
recipient’s first name, last name, or 

email address, and then select the 
recipient’s name.

• If the recipient’s name is in an online 
address book, you can find the name 
and add it. See Using an online 
address book.

6 Select Subject and enter a title for the 
message.

7 Press Down  to go to the body of the 
message. Enter your message, or press 
Menu  (right action key), select 
My Text, and then select a predefined 
phrase you want to insert.

8 (Optional) To attach an item to the 
message, press Menu  (right 
action key) and select Insert. Select the 
type of item you want to attach, and 
then select the file or record a voice 
note.

DID YOU KNOW? You can also access the Inbox 
application from the Start menu.

DID YOU KNOW? When addressing a message, you 
can enter the contact’s first and last initials 
separated by a space.

TIP To address a message to multiple 
recipients, separate the addresses by 
pressing Enter or entering a semicolon (;).
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9 (Optional) Press Menu  (right 
action key) and do one or both of the 
following:

• Select Spell Check. When the spell 
check is complete, press OK .

• Select Message Options. Select the 
Priority list, select a priority setting 
for the message, and then press 
OK .

10 Press Send  (left action key).

Receiving email messages

How you receive email messages depends 
on the type of account you are using and 
how you synchronize:

• If you synchronize wirelessly with your 
Exchange server using Microsoft 
Exchange ActiveSync, new email 
messages are sent to your smartphone 
when they appear on the server, 
according to the schedule you set up 
(see Setting the synchronization 
schedule), or when you manually initiate 
a sync (see Initiating a wireless sync 
manually.

• If you use desktop sync software to 
synchronize your smartphone with your 
computer, messages in Outlook on your 
computer are transferred to your 
smartphone when you connect your 

TIP You can send an email message with a file 
attached from directly within other 
applications on your smartphone; see Sending 
email messages from within another 
application.

TIP To save memory on your smartphone, turn 
off the option to save sent messages in the 
Saved folder. In the Inbox, press Menu (right 
action key) and select Tools > Options. Select 
the Message tab, and then uncheck the Keep 

copies of sent items in Sent folder box.

TIP If you sync email with Microsoft Exchange 
Server 2003 or 2007, you can synchronize 
messages in subfolders you create. In the 
Inbox, press Menu (right action key) and 
select Tools > Manage Folders. Folders 
containing subfolders display a +. Select the + 
to view the subfolders. Check the box to the 
left of any subfolder you want to sync.

TIP If you synchronize email with Microsoft 
Exchange Server 2007, and you receive a 
message containing a link to a document on 
SharePoint or an internal file server, you can 
view the document by selecting the link.
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computer and your smartphone (see 
Connecting your smartphone to your 
computer).

• For all other types of accounts, 
including ISP accounts and accounts 
you access using a VPN server 
connection (typically a work account; 
see Connecting to a VPN), message 
retrieval depends on the option you 
chose from the Automatic Send/
Receive list during account setup (see 
Setting up a POP/IMAP account in the 
Inbox application: Common email 
providers or Setting up a POP/IMAP 
account in the Inbox application: Other 
email providers), as follows:

If you chose a time interval: Your 
smartphone automatically checks for 
and downloads new messages 
according to that interval.

If you chose Manually: Follow these 
steps to send and receive messages:

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Select the account containing the 
messages you want to view.

4 Press Menu  (right action key) 
and select Send/Receive to 
synchronize your smartphone with your 
email server.

Receiving attachments

1 Scroll to the attachment name (below 
the subject) to highlight it. This marks it 
for download.

2 Synchronize the email account that 
contains the message as described in 
the previous sections.

3 Scroll to and select the attachment 
name (below the subject) to open the 
attachment.

TIP Partially downloaded messages appear in 
the message list with a partial envelope icon 
to the left of the subject. To view the full 
message, either press Menu (right action key) 
and select Download Message, or open the 
message and select Get the rest of this 

message.

DID YOU KNOW? You can view messages sent as 
HTML with the HTML formatting intact.
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If you are synchronizing with Outlook on 
your computer and want to download 
attachments automatically, do the 
following: 

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right action key) 
and select Options. 

4 Select E-mail, and then select 
Settings.

5 Check the Include file attachments 
box. 

6 (Optional) To automatically download 
attachments up to a certain size only, 

check the Only if smaller than box and 
enter the maximum attachment size.

7 Press OK .

To automatically download attachments 
from an IMAP4 email account (typically an 
ISP account) or an account that you access 
using a VPN server connection (typically a 
work account; see Connecting to a VPN, do 
the following: 

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Do one of the following:

• If the account list is displayed, press 
Menu  (right action key) and 
select Options.

• If the message list for a specific 
account is displayed, press Menu 

 (right action key) and select 
Tools > Options.

4 On the Accounts tab, select the IMAP4 
account name. 

5 Press Next  (right action key) until 
you reach Server information, and then 
select Options. 

6 Press Next twice, and then select 
either Get full copy of messages and 

DID YOU KNOW? You can receive and open 
attachments in a number of different formats, 
including PDF. PDF file attachments open in 
PDF Viewer on your smartphone (see PDF 
Viewer).

TIP To store attachments on an expansion card, 
insert the card into your smartphone’s 
expansion card slot, press Menu (right action 
key) and select Tools > Options. Select 
Storage and check the When available, use 

this storage card to store attachments box.
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When getting full copy, get 

attachments or Entire message, 
depending on the option displayed. 

Working with email 
messages

Adding a contact from an email message

You can add a contact name or email 
address to your Contacts list directly from 
the To, cc, or bcc field of an email 
message. You can select the name or 
address from either an outgoing or an 
incoming message, and you can either 
create a new contact or add the 
information to an existing contact.

1 In an open message, highlight the name 
or address of the contact you want to 
add. 

2 Press Center . 

3 Press Save  (left action key). 

4 Select <New Contact> to create a new 
contact entry for this name or address, 
or select an existing contact to add the 
name or address to that entry. 

5 Enter or edit the contact information. 

6 Press Save  (left action key). 

Adding an online address book

Many email servers, including servers 
running Exchange Server, can verify names 
with an online address book, also called a 
directory service or a Global Address List. 
After you create and enable an email 
account, the Inbox application checks your 
contacts list and then the directory service 
to verify names that you enter in the To, cc, 
and bcc fields.

DID YOU KNOW? Embedded images and objects 
cannot be received as attachments, unless 
you have an IMAP4 email account with TNEF 
disabled. Note that TNEF must be enabled to 
receive meeting requests.
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BEFORE YOU BEGIN Do the following:

• Ask your system administrator for the 
name of the directory service and the 
server, and whether authentication is 
required for accessing an online address 
book.

• If your company is using Exchange 
Server 2003 upgraded to Service Pack 2 
or Exchange Server 2007, you must first 
synchronize with the Exchange server 
to enable the Global Address List to find 
a contact.

1 In the message list, press Menu  
(right action key) and select Tools > 
Options.

2 Select the Address tab. 

3 Select the address book you want to 
check for email addresses, and then 
select Add. 

4 Enter the name of the directory service.

5 Enter the server name.

6 If your server requires authentication, 
check the box and enter your username 
and password.

7 (Optional) Check the Check name 

against this server box to enable this 
directory service.

8 Select OK.

Using an online address book

You can access contact information, such 
as an email address or phone number, from 
your organization’s online address book or 
Global Address List (GAL). To access a 
GAL, make sure you are accessing either 
Exchange Server 2007 or Exchange Server 
2003 upgraded to Service Pack 2. This 
feature is useful only if you know the exact 
name as it appears in the directory.

TIP To delete a directory service, highlight it, 
press and hold Center on the 5-way, and 
select Delete.

DID YOU KNOW? You can use the Global Address 
List to find a contact. In Contacts, press 
Menu (right action key) and select Company 

Directory. When sending a meeting request, 
select Attendees, press Menu (right action 
key) and select Company Directory. 
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BEFORE YOU BEGIN Add access to an 
online address book to your smartphone 
(see Adding an online address book).

1 In a new message, select To. 

2 Press Menu  (right action key) 
and select Add Recipient.

3 Press Menu  (right action key) 
and select Company Directory. 

4 Enter the contact name as it appears in 
the directory and press Find  (left 
action key). You must spell the contact 
name correctly.

Finding messages

You can find messages containing a 
specific word or phrase. The find feature 
searches names, email addresses, and 
subject lines.

1 Press E-mail  (left action key).

2 Select the account you want.

3 Begin typing the word or phrase you 
want to find. The list display changes to 
show only those messages containing 
the letters you have entered. 

4 Continue entering letters to narrow the 
display until the message you want 
appears.

Replying to a message

1 Open the message to which you want 
to reply.

2 Press Reply  (left action key).

3 Address the message and enter any 
text you want to add.

4 (Optional) Select Edit sender’s 

message to edit the original sender’s 
message text that you include in your 
reply.

5 Press Send  (left action key).

TIP When you sync with Outlook on your 
computer, disable your online address books 
to avoid errors. Press Menu (right action key) 
and select Tools > Options. Select Address, 
select each online address book, and then 
uncheck the Check name against this server 
box. Be sure to turn this option back on if you 
synchronize other email accounts.

DID YOU KNOW? If you synchronize with Microsoft 
Outlook 2007, you can also find messages 
stored on your mail server.
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Forwarding a message

1 Open the message you want to 
forward.

2 Press Menu  (right action key) 
and select Forward.

3 Address the message and enter any 
text you want to add.

4 Press Send  (left action key).

Deleting messages

You can delete a message you are reading, 
or you can delete one or more messages 
from the message list.

To delete a message you are reading:

• Press Menu  (right action key) 
and select Delete.

To delete messages from the message list:

1 Highlight the message(s) you want to 
delete. To highlight multiple messages, 
tap and drag the stylus across the 
messages in the list.

2 Press Delete  (left action key).

3 Select Yes to confirm the deletion.

Using email shortcuts

You can perform common email tasks by 
pressing and holding certain keys on the 
keyboard. Open the message you want, 
and then press and hold any of the 
following:

DID YOU KNOW? If you reply to a message sent as 
HTML, the reply is sent in HTML also.

Press and 

hold... To...

H View all email shortcuts

A Reply to the sender of a 
message and all other 
addressees

R Reply to the sender only

K Mark a message read or 
unread

F Flag a message as high 
priority

M Move a message between 
folders

O Forward a message

D Delete a message
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Adding a signature to your messages

You can use a different signature with each 
email account.

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Do one of the following:

• If the account list is displayed, press 
Menu  (right action key) and 
select Options.

• If the message list for a specific 
account is displayed, press Menu 

 (right action key) and select 
Tools > Options.

4 On the Accounts tab, select 
Signatures.

5 Select the account for which you want 
to create a signature.

6 Check the Use signature with this 

account box to add this signature to 
new messages you create with this 
account.

7 (Optional) Check the Use when 

replying and forwarding box to add 
this signature to messages you reply to 
or forward with this account.

8 Highlight the text “Enter a signature 
here” and enter the signature text you 
want to use.

9 Press OK .

Customizing your email settings

When you customize settings for an email 
account, the options you choose apply to 
that account only.

L Fully download a partially 
downloaded message

S Synchronize your 
smartphone with the server 
to get and send new 
messages
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1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Do one of the following:

• If the account list is displayed, press 
Menu  (right action key) and 
select Options.

• If the message list for a specific 
account is displayed, press Menu 

 (right action key) and select 
Tools > Options.

4 On the Accounts tab, highlight the 
account you want and set any of the 
following options:

Security: Allows you to specify 
whether you receive a warning 
message before you open a URL or file 
link that is not on your smartphone.

Display account picker when opening 

Inbox: Specifies whether a list of your 
email accounts appears when you open 
the Inbox application, allowing you to 
select the one you want to use. If the 
box is unchecked, the Inbox application 
opens to the last account you used.

5 Select the Message tab and set any of 
the following options:

TIP If the Display account picker when 

opening Inbox box is unchecked, repeatedly 
press Left on the 5-way after you open the 
Inbox application to cycle through your 
accounts. 
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When replying to e-mail, include 

body: Indicates whether the body of a 
message you received appears in your 
response to that message.

Keep copies of sent items in Sent 

folder: Indicates whether messages 
you send are stored in the Sent folder.

Warn when deleting messages in the 

message list: Specifies whether a 
confirmation message appears when 
you delete one or more messages from 
the message list.

After deleting or moving a message: 
Specifies what you want to see after 
you delete or move an email message 
you are reading: the account Inbox or 
the next message.

6 Select the Address tab and set any of 
the following options:

In Contacts, get e-mail addresses 

from: Indicates whether you want to 
check Contacts in addition to any 
directory services for email addresses.

Check names using these address 

books: Indicates which directory 
services you want to check for email 
addresses.

Add: Enables you to add directory 
services to the list of online address 
books.

7 Select the Storage tab and set any of 
the following options:
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When available, use this storage card 

to store attachments: Indicates 
whether you want to automatically 
store email attachments on an 
expansion card. You must have a card 
inserted in your smartphone’s 
expansion card slot to select this option.

Empty deleted items: Select 
Immediately to have the Deleted folder 
emptied anytime you delete a message. 
Select On connect/disconnect to have 
the folder deleted anytime you open or 
quit the Inbox application. Select 
Manually to manually empty the 
Deleted folder.

8 Press OK .

Changing email download settings

You can customize the download options 
for each email account that you have with 
an Internet service provider (ISP) or that 
you access using a VPN server connection 
(typically a work account).

NOTE To change options for a Microsoft 
Office Outlook E-mail account, press Start 

, select Programs, and then select 
ActiveSync . Press Menu  (right 
action key) and select Options.

1 Press E-mail  (left action key).

2 Do one of the following:

• If the account list is displayed, press 
Menu  (right action key) and 
select Options.

• If the message list for a specific 
account is displayed, press Menu 

TIP If you choose to manually empty the 
Deleted folder, you delete messages from this 
folder in the same way that you delete any 
other messages (see.Deleting messages). 
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 (right action key) and select 
Tools > Options.

3 Select the email account you want. 

4 Press Next  (right action key) until 
the following screen is displayed.

5 Select either of the following:

Automatic Send/Receive: Specifies 
the time interval for automatically 
downloading email, from every 5 
minutes to once a day. If you do not 
want to automatically download 
messages, select Manually.

Download messages: Specifies the 
number of days’ worth of email to be 
retrieved for each automatic or manual 
retrieval.

6 Select Advanced Settings, and then 
select any of the following:

Send/receive when I click Send: 

Specifies whether you can manually 
send and receive messages, in addition 
to automatically downloading them.

Use automatic send/receive schedule 

when roaming: Specifies whether 
automatic downloading takes place 
when you are roaming. This may result 

TIP To save memory, limit the number of 
emails that are downloaded to your 
smartphone by selecting a larger time interval 
for automatically downloading messages or a 
smaller time interval for how many days’ 
worth of messages are downloaded. 
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in higher connection charges than 
downloading while in your home 
network.

When deleting messages: Specifies 
whether messages should be deleted 
from the mail server when you delete 
them on your smartphone, or whether 
messages you delete on your 
smartphone should remain on the 
server.

7 Press Done  (left action key).

8 Press Next  (right action key).

9 Select either of the following: 

Message format: Select the format for 
sending and receiving messages. If you 
select HTML, messages sent to you as 
HTML are received with their formatting 

intact. If you select Plain Text, all 
messages are received as plain text.

Message download limit: Select the 
size of an incoming message that is 
automatically downloaded. For any 
message that exceeds this size, you 
must manually download the rest of the 
message. Selecting a higher limit 
means more of your messages will be 
fully downloaded, but message retrieval 
might take longer. You can also choose 
to download message headers only, 
regardless of size.

10 Press Finish  (right action key).

DID YOU KNOW? Messages sent to you as plain 
text are always received as plain text, even if 
you select HTML.
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Working with 
meeting invitations

You can receive meeting invitations on your 
smartphone in the same way that you 
receive email messages. 

NOTE You can create meeting invitations 
on your smartphone; see Sending a 
meeting request.

Here are the key features of meeting 
invitations:

• Meeting invitations appear on your 
smartphone in the Inbox application, not 
in the Calendar application. 

• From within the Inbox application, you 
can accept, decline, or tentatively 
accept a meeting invitation. 

• If you accept an invitation, the meeting 
shows up as an appointment in the 
Calendar application. 

• You can reply to and forward meeting 
invitations in the same way as email 
messages.

1 Press E-mail  (left action key).

2 Select the account you want.

3 Select a meeting invitation to open it. 
Meeting invitations are displayed with 
this icon: .

4 To accept the invitation, press Accept 
 (left action key), select whether 

to edit (include comments with) your 
response, and then select OK.

To decline or tentatively accept the 
invitation, press Menu  (right 
action key) and select Decline or 
Tentative.

TIP If you receive an updated meeting 
invitation, you can again choose to accept, 
decline, or tentatively accept. If you receive a 
meeting cancellation, you don’t need to do 
anything.



Y O U R  E M A I L

S E N D I N G  E M A I L  M E S S A G E S  F R O M  W I T H I N  A N O T H E R  A P P L I C A T I O N 117

6

C
H

A
P

T
E

R

Sending email 
messages from 
within another 
application

You can send files such as pictures, videos, 
and ringtones as attachments to email 
messages (see Creating and sending an 
email message). 

You can send certain files as attachments 
from within the application where the file is 
created or stored. For example, if you take 
a picture with the built-in camera on your 
smartphone, you can select an option to 
send the picture as an attachment to an 
email message. You can also use this 
feature with videos and sound files. For 
details, see the chapter on the specific 
application.
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CHAPTER

7

Your text and multimedia 
messages
If you need to get a short message to a friend or a coworker 
fast, send a text message from your Palm® Treo™ 800W 
smartphone to their mobile phone or email address.

If you need more than text to express yourself, use multimedia 
messaging to give your message extra impact by adding a 
photo, video, or sound file.

Benefits

• Enjoy quick communication

• Use text messaging to chat with 
friends

• Be as simple or as creative as you 
want
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Using the Messaging 
application

You can use the Messaging application to 
send and receive brief text messages 
(SMS) and multimedia messages (MMS). 
Before you use your smartphone to send or 
receive messages, consult your wireless 
service provider for pricing and availability 
of text and multimedia messaging 
services.

Creating and sending a text message

Each text message can have up to 160 
characters. You can send a message of 
more than 160 characters, but the 
message will automatically be split into 
several messages. If you send a text 
message to an email address, the email 
address is deducted from the 
160-character count.

BEFORE YOU BEGIN Make sure that your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Press Start  and select Messaging.

2 Press New  (left action key).

3 Enter the recipient’s name, mobile 
phone number, or email address. Here 
are some shortcuts:

• If the recipient’s name and mobile 
number are in your Contacts list, type 
the first few letters of the first or last 
name or simply enter the first initial, 
followed by a space, and then the last 
initial to find a name.

• Press Center  to view a list of 
recently used addresses, and select 
the recipient from the list. Select Add 

DID YOU KNOW? You can send and receive text 
messages even while you are on a phone call. 
This is easiest when using a hands-free 
headset or the speakerphone.
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Recipient to add a recipient from your 
Contacts list.

• If the recipient’s name is in an online 
address book, press Center , 
enter the name, press Menu  
(right action key), and then select 
Company Directory. Select the 
name, and then select either the 
phone number or the email address. 
For more information, see Using an 
online address book.

• If the recipient’s name and mobile 
number are not in your Contacts list, 
enter the full mobile number or email 
address.

4 Enter your message, or tap  and 
then select a predefined phrase you 
want to insert.

5 (Optional) Tap  and then select an 
emoticon to add to your message.

6 Press Send  (left action key).

Creating and sending a multimedia 

message

Multimedia messages consist of pictures, 
videos, text, and sounds presented as one 
or more slides. You can include any of the 
following items: 

Ringtones

• MIDI

Sound clips

• AMR

• QCELP

TIP To address a message to multiple 
recipients, separate the addresses by 
pressing Enter or entering a semicolon (;). You 
can send a message to up to 20 addresses.

TIP To send a message to a different number 
for a contact, select the contact in the To field, 
and then edit the number that appears in the 
box directly below the contact number. You 
can also select a number by pressing Center 
on the 5-way, and then edit it.

TIP You can also access predefined phrases 
and emoticons by pressing Menu (right action 
key) on the message compose screen.

TIP Some symbols can’t be used in text 
messages. Invalid characters are automatically 
replaced by the Messaging application.
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Pictures

• JPEG

• GIF

• WBMP

Videos

• 3GPP

• 3GPP2

• MPEG4

Outgoing multimedia messages can be up 
to 300KB by default, but your wireless 
service provider may have a different 
maximum message size.

BEFORE YOU BEGIN Make sure that your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select New MMS.

3 Enter the recipient’s mobile phone 
number or email address. Here are 
some shortcuts:

• If the recipient’s name and mobile 
number are in your Contacts list, type 
the first few letters of the first or last 
name or simply enter the first initial, 
followed by a space, and then the last 
initial to find a name.

• Press Center  to view a list of 
recently used addresses, and select 
the recipient from the list. Select Add 

Recipient to add a recipient from your 
Contacts list.

• If the recipient’s name is in an online 
address book, press Center , 
enter the name, press Menu  
(right action key), and then select 
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Company Directory. Select the 
name, and then select either the 
phone number or the email address. 
For more information, see Using an 
online address book.

• If the recipient’s name and mobile 
number are not in your Contacts list, 
enter the full mobile number or email 
address.

4 Select Subject and enter a title for the 
message.

5 Select  and select one of the 
following:

Add Picture: Enables you to insert a 
picture. You can take a new picture with 
the built-in camera or insert an existing 
picture.

Add Video: Enables you to insert a 
video. You can capture a new video with 
the built-in camera or insert an existing 
video. 

Add Sound: Enables you to record a 
message, such as a voice caption for a 
picture, or insert an existing sound, such 
as a ringtone. You can add one sound 
per slide; to send more than one sound 

in a message, add another slide to your 
message.

6 (Optional) Select Add Text and enter a 
text caption or message for the slide 
you inserted. Tap  to insert a 
predefined phrase. Tap  to insert an 
emoticon.

7 (Optional) Select Add slide and repeat 
steps 5 and 6 to add another slide in this 
message.

8 (Optional) To add a vCard (contact file) 
to a message, press Menu  (left 
action key) and select Add Media > 
Add vCard.

TIP You can add both a picture and a sound clip 
to the same slide in a message. To add a 
sound to a picture, select the picture 
thumbnail and select Add Sound. To add a 
picture to a sound, select the sound icon, and 
then select Add Picture.

DID YOU KNOW? If you add more than one slide to a 
message, you can set the length of time each 
slide is displayed. Press Menu (right action 
key) and select Slide Timing.
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9 Press Send  (left action key).

Setting message options

You can set options for individual text and 
multimedia messages you send.

1 On the message compose screen, 
press Menu  (right action key).

2 Select Message Options.

3 Select any of the following options:

Request Delivery/Read Receipt 

(multimedia messages only): 
Indicates whether you want to receive 
confirmation that the message has 
been delivered or has been read.

Validity Period: Indicates how long the 
message remains available to be sent if 
the recipient’s phone or email address is 
not available when you originally send 
the message. For example, if a 
message contains information that will 
not be useful to the recipient after an 
hour, you can set the validity for one 
hour. 

Message Priority (multimedia 

messages only): Indicates the priority 
for this message.

TIP To preview a multimedia message as the 
recipient will see it, press Menu (right action 
key) and select Preview Message.

DID YOU KNOW? You can set general preferences 
that apply to all incoming and outgoing 
messages (see Customizing message 
settings). If you set options for an individual 
message, those options override your general 
preferences for that message only.
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4 Press OK .

Receiving text and multimedia messages

When your phone is on and you are in a 
wireless coverage area, you automatically 
receive new text messages. For 
multimedia messages, you can set your 
smartphone to automatically download 
new messages or to notify you that 
messages are ready to download. You can 
also set your smartphone to notify you 
when a new text or multimedia message 
arrives.

The new message notification may include 
any of the following options:

• Go To: Opens a text message so you 
can view its full contents.

• View: Opens a multimedia message 
and plays the included media.

• Download: Downloads the full content 
of a multimedia message.

• Dismiss: Closes the notification and 
puts the message into your Inbox.

If you have multiple messages, the 
notification includes the number of 
messages and the type (text or 
multimedia). 

Viewing/playing a message

You can open a message from a 
notification or from the Inbox of the 
Messaging application. When you open a 
multimedia message, playback starts 
automatically.

DID YOU KNOW? Message notifications include the 
message text unless you have turned on 
privacy mode (see Customizing message 
settings). If privacy mode is on, the 
notification states only the type of incoming 
message.
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1 Do one of the following to open the 
message:

• Press Start  and select 
Messaging. From the Inbox, select 
the message you want to view. 

• From a notification, select Go To (for 
text messages) or View (for 
multimedia messages).

2 Do any of the following:

Pause or resume playback 

(multimedia message only): 

Select Pause  (left action key). To 
resume playback, select Play  (left 
action key).

Save the item that is playing 

(multimedia message only): Press 

Menu  (right action key) and 
select Save.

See a summary of the message, 

including sender, date, and time: 

Press Menu  (right action key) 
and select Message Details.

Reply to the message: Press Menu 
 (right action key) and select 

Reply or Reply All.

NOTE If the message is a single picture 
with no audio, select Reply  (left 
action key) to reply to the message.

Forward the message: Press Menu 
 (right action key) and select 

Forward.

Call the sender: Press Menu  
(right action key) and select Call 

Sender.

Add the sender’s information to your 

Contacts list: Press Menu  (right 
action key) and select Add to Contacts.

Save the message as a template for 

other messages: Press Menu  
(right action key) and select Save as 

Template.
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3 Press OK .

Using Messaging to chat

When you exchange more than one 
message with a single contact, the 
messages you exchange with that person 
are grouped into a chat session. When you 
select a chat session from your message 
list, the upper part of the screen displays all 
messages you’ve exchanged with this 
contact, and the lower part provides a text 
entry area. 

1 Press Start  and select Messaging.

2 Do one of the following:

Start a new chat: Select a message 
and reply to it.

Continue an existing chat: Select a 
message with the chat  icon.

3 Enter your message.

4 Press Send  (left action key).

5 In a received message, select  to 
open a media file, or click a link to 
download and open a new multimedia 
message.

DID YOU KNOW? When viewing a multimedia 
message containing multiple slides, you can 
press Right on the 5-way to move to the next 
slide, or press Left on the 5-way to move to 
the previous slide.

TIP Only the last 50 messages in a chat 
session are displayed. Select View older 

messages near the top of the screen to see 
earlier messages.
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Using links in messages

When you receive a text message that 
contains a telephone number, email 
address, or URL, you can dial the number, 
send an email message, or go to the web 
page immediately. Your smartphone 
automatically opens the appropriate 
application from the link.

1 Open a message in the Inbox or another 
folder.

2 Select the phone number, email 
address, or URL (appears as underlined 
blue text).

Message status icons

The status icons that appear next to each 
message in the Inbox, Outbox, and Sent 
folders indicate the following:

 An unread text message.

 An unread message with pictures or 
videos. 

 An unread message with sound. 

 A read text message. 

 A read message with pictures or 
videos.

 A read message with sound.

 A message that was sent with 
delivery confirmation turned on 
(Sent folder only). 

 Multiple messages exchanged with 
a single recipient (chat). 

 An urgent message. This icon 
appears below the message size on 
the right side of the screen.

TIP Unread messages appear in bold. 
Messages you’ve read appear in plain text. 
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Sorting your messages

You can sort the messages in any folder by 
date or by sender. 

1 Go to the Inbox or other folder you want 
to sort.

2 Press Menu  (right action key) 
and select Sort.

3 Select By Date or By Name.

Deleting a single message

1 Go to the Inbox or other folder 
containing the message you want to 
delete.

2 Highlight the message.

3 Press Menu  (right action key) 
and select Delete.

4 Select Yes to confirm the deletion.

Deleting multiple messages

1 Go to the Inbox or other folder 
containing the messages you want to 
delete.

2 Press Menu  (right action key) 
and select Purge.

3 Select the age of messages to be 
deleted, or select Delete all messages.

4 Select Purge  (left action key).

Customizing the 
Messaging 
application

Customizing message settings

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select Options.
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3 On the Messages tab, set any of the 
following options:

Confirm message deletions: Indicates 
whether you want deletion confirmation 
messages to appear.

Automatically download MMS 

messages: Indicates whether you want 
to automatically receive multimedia 
messages. Check the Even when 

roaming box to download multimedia 
messages both on your home network 
and while roaming.

NOTE You might incur additional charges if 
you download multimedia messages while 
roaming.

Message validity period: Indicates 
how long messages remain available to 
be sent if the recipient’s phone or email 
address is not available when you 
originally send the message. For 
example, if your messages generally 
contain information that will not be 
useful to recipients after an hour, you 
can set the validity for one hour.

Signature: Enables you to add a 
signature to outgoing messages. Select 
the button; then, on the Signature 
screen, check the Use signature with 

new messages box, enter your 
signature text, and then press OK .

4 Press OK . 

Customizing chat settings

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select Options.

DID YOU KNOW? Options you select for an 
individual message (see Setting message 
options) override the general preferences you 
set for all messages.
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3 Select the Chat tab.

4 Select any of the following options:

Create chat from messages: Indicates 
the conditions under which a chat 
session starts.

Show time stamps of each message: 
Indicates whether you want chat 
session items to display a date and time 
indicator.

5 Press OK . 

Customizing notification settings

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select Options.

3 Select the Notification tab.

4 Select any of the following options:

Request MMS receipts: Indicates 
whether you want to receive a 
confirmation when a multimedia 
message is delivered or when it is read.

Privacy mode (hide text): Indicates 
whether you want only the message 
type displayed on a notification for a 
single incoming message. If the box is 
unchecked, the notification displays the 
text of the message.

Acknowledge when messages are 

received/read (multimedia messages 

only): Indicates whether you want a 
confirmation sent to the sender when 
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you receive or read a multimedia 
message.

5 Press OK . 

Customizing network settings

IMPORTANT Changing the network 
settings can cause the Messaging 
application to stop working correctly. We 
recommend that you keep the default 
network settings.

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select Options.

3 Select the Advanced tab.

4 Select Manual, and then select Edit.

5 Edit the network settings you want to 
change.

6 Press OK  twice.

TIP Select Automatic on the Advanced tab to 
restore the default settings.
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CHAPTER

8

Your connections to the web 
and wireless devices
You use the web for so many things: finding driving directions, 
getting news, buying gifts, checking web-based email. Now, with 
your wireless service provider’s network and your smartphone’s 
built-in web browser, you can take the web with you almost 
anywhere you go.

The built-in Bluetooth® wireless technology on your Palm® 
Treo™ 800W smartphone helps you easily set up wireless 
connections to a number of devices, so you can enjoy the 
convenience of cable-free connectivity. You can also use your 
smartphone to connect your computer to the Internet and to 
share contacts or your favorite photos with other people.
Benefits

• Carry the web with you

• Store web pages for offline 
viewing

• Connect to Bluetooth headsets 
and car kits

• Connect your computer to the 
Internet through your smartphone
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Browsing the web

Internet Explorer Mobile provides quick and 
easy access to web pages. You can view 
most sites on your smartphone that you 
can view on your computer, including those 
with security and advanced features, such 
as JavaScript and frames. 

Internet Explorer Mobile supports 
JavaScript, Secure Sockets Layer (SSL), 
and cookies, but does not support plug-ins 
(Flash, Shockwave, VBScript, WML script, 
and so on) or Java applets.

BEFORE YOU BEGIN Do the following:

• Be sure to subscribe to data services 
from your wireless service provider. 
This is necessary for browsing the web.

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

Viewing a web page

By default, Internet Explorer Mobile scales 
web page content to fit your smartphone 
screen so that you can view most of the 
information without scrolling left or right.

1 Press Start  and select Internet 

Explorer.

2 Highlight the address line, enter the 
address of the web page you want to 
view, and then press Center . To 
return to a recently viewed page, select 
the address line list, and then select the 
web address.

DID YOU KNOW? The Security certificates and 
128-bit SSL strong encryption enable you to 
browse secure sites, such as online shopping, 
banking, and email. Remember, some secure 
sites also require a specific browser and may 
not work with Internet Explorer Mobile. Ask 
the organization for an alternate access point 
that is compatible with Internet Explorer 
Mobile.

DID YOU KNOW? You can also start a web search 
from your Today screen by selecting the Web 
search field, entering the item you want to 
find, and then pressing Center on the 5-way. 

DID YOU KNOW? If you browse to a secure web 
page, the lock icon in the address line appears 
closed instead of open.
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3 Press Menu  (right action key), 
select View, and then select one of the 
following:

One Column: Arranges web pages into 
one column that is as wide as the 
screen, so that you don’t have to scroll 
horizontally. 

Fit To Screen: Maintains a layout similar 
to what you see on a desktop computer, 
but it makes items smaller and arranges 
the content so that you can see most of 
it without scrolling horizontally. 

Desktop: Keeps the same layout and 
size as on a desktop computer, which 
requires both horizontal and vertical 
scrolling.

Full Screen: Hides the status and 
navigation areas and fills the entire 
screen with the web page. To exit full 
screen mode, press  (right action 
key), or tap and hold anywhere on the 
screen and uncheck Full Screen.

Show Pictures: Shows or hides 
pictures on web pages. Hiding pictures 
speeds up the time it takes to load 
pages. 

4 Here are some tips on viewing web 
pages and moving around in them:

• To view the previous page, press 
Back  (left action key) or 
Backspace .

• To refresh the page with the latest 
content from the Internet, press 
Menu  (right action key) and 
select Refresh.

• To scroll through the page in One 
Column View or Default View, press 
Up  or Down . In Desktop View, 
press Up , Down , Left , or 
Right  to scroll in all directions.

• To follow a link to another web page 
press Up  or Down  to highlight 
the link, and then press Center  to 
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go to the selected page. You can also 
tap the link on the screen with the 
stylus.

• To send email from a web page, 
select the address link. You need to 
configure an email application on your 
smartphone before you can use this 
feature (see Your email).

• To adjust the size of the text on web 
pages, press Menu  (right 
action key), select View > Text Size, 
and then select the size you want.

• To view a web page’s properties, 
press Menu  (right action key) 
and select Tools > Properties.

• To view each item in a list, select the 
list and scroll using Up  or 
Down .

• In a list, press Left  or Right  to 
cycle between items, and then press 
Center  to accept the change.

• In a form, such as a browser search 
field, press Center  to interact 
with the form, and then press Center 

 to stop interacting with the form.

5 Press OK  to close Internet Explorer 
Mobile.

Creating a favorite

Favorites let you bookmark a web page so 
that you can instantly access it without 
entering the web address.

BEFORE YOU BEGIN Create the folders 
where you want to store your favorites 
first. After you create a favorite, you can’t 
move it to another folder (see Organizing 
your favorites).

1 Go to the page you want to mark as 
a favorite.

2 Press Menu  (right action key) 
and select Add to Favorites.

TIP To send a link, press Menu (right action 
key) and select Tools > Send Link. Select the 
option you want to use to send the link: SMS, 
MMS, or an email account.
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3 (Optional) Select Name and enter a 
different description.

4 (Optional) Select Create in, and then 
select the folder where you want to 
create the favorite.

5 Select Add.

Viewing a favorite

1 Press Start  and select Internet 

Explorer.

2 Press Menu  (right action key) 
and select Favorites.

3 Select the page you want to view in the 
list.

Organizing your favorites

You can create folders to organize your 
favorites. For example, you can store travel 
links in one folder, stock links in another, 
and business links in a third folder.

1 Press Start  and select Internet 

Explorer.

2 Press Menu  (right action key) 
and select Favorites.

3 Select the Add/Delete tab.

4 Select New Folder.

5 Enter a name for this folder, and then 
select Add.

6 Press OK .

Downloading files and images from a web 

page

You can download files that are usable on 
your smartphone, such as new 
applications, MIDI ringtones, or pictures.

TIP To delete a favorite or folder, press Menu 
and select Favorites. Select the Add/Delete 
tab, highlight the item you want to delete, and 
then select Delete. Select Yes to confirm 
deletion and press OK.
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1 Go to the page that contains the link to 
the file you want to download.

2 To download a file, press Left  or 
Right  to highlight the link to the file. 
Press and hold Center , and then 
select Save As. To download an image, 
tap and hold on the image, select Save 

Image, and then select Save As.

3 Select Name and enter a new name for 
the file. 

4 Select the Folder list, and then select 
the folder where you want to save the 
file.

5 Select the Location list, and then select 
where you want to store the file: Main 

memory or Storage card. 

6 Press OK .

Copying text from a web page

You can copy text from a web page and 
paste it in other applications.

1 Use the stylus to highlight the text you 
want to copy.

2 Press Menu  (right action key) 
and select Edit > Copy.

3 Go to the application in which you want 
to paste, and then position the cursor 
where you want to paste the text.

4 Press Menu  (right action key) 
and select Edit > Paste.

Returning to recently viewed pages 

The History list stores the addresses of the 
pages you visited recently.

1 Press Menu  (right action key) 
and select History. 

DID YOU KNOW? You can select the (Downloads) 
favorite to access your wireless service 
provider’s downloads page.

TIP You can copy the text from the entire web 
page. Tap and hold on the page, and then tap 
Select All Text. Tap and hold on the page 
again, and then tap Copy.

TIP If Internet Explorer Mobile does not 
recognize a phone number as dialable, you 
can copy the phone number (as text) and 
paste it into the phone Dial Pad.
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2 (Optional) Tap the Show list in the 
upper-left, and then select how you 
want to sort the History list.

3 Select the web page you want to view.

Customizing your Internet Explorer 

Mobile settings

1 Press Menu  (right action key) 
and select Tools > Options.

2 On the General tab, set any of the 
following options:

Home Page: Sets the page that appears 
when you open Internet Explorer 
Mobile. To use the page you were on 
when you opened the menu, select Use 

Current. To select the original home 
page, select Use Default.

Encoding: Sets the character set for 
the web pages you view.

3 Select the Memory tab and set any of 
the following options:

Save links to pages visited in the 

past: Sets how many days of activity 
the History list stores.

Clear History: Empties the History list.

Delete Files: Removes web files that 
you previously viewed synchronized 
with your computer.

4 Select the Security tab and set any of 
the following options:

Allow cookies: Sets whether your 
smartphone accepts cookies (small files 
containing info about your identity and 
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preferences). The page sends the file 
and stores it on your smartphone.

Clear Cookies: Deletes any cookies 
stored on your smartphone.

Warn when changing to a page that 

is not secure: Sets whether a message 
appears when you switch from a secure 
page to one that is not secure.

Warn when page content is blocked 

due to security settings: Sets whether 
a message appears when you attempt 
to open a page that does not meet the 
security standards associated with your 
smartphone.

5 Press OK .

Connecting to 
devices with 
Bluetooth® 
wireless technology

With the built-in Bluetooth® wireless 
technology on your smartphone, you can 
connect to a number of Bluetooth devices 
such as a headset or hands-free car kit, as 
well as to other phones, handhelds, or 
piconets. When you connect to another 
device, you create a partnership (also 
referred to by terms such as trusted pair, 
trusted device, or pairing) with that device. 
If your computer is enabled with Bluetooth 
wireless technology, you can also 
synchronize wirelessly or use your phone 
as a wireless modem.

You can create a list of Bluetooth devices 
that you trust to communicate with your 
smartphone. When communicating with 
trusted devices, your smartphone skips the 
discovery process and creates a secure link 
as long as the device is within range. 
Bluetooth range is up to 10 meters (30 feet) 
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in ideal conditions. Performance and range 
are affected by physical obstacles, radio 
interference from nearby electronic 
equipment, and other factors. 

When you configure a headset (see 
Connecting to a Bluetooth® hands-free 
device), the headset is automatically added 
to your trusted device list. Follow the steps 
in this section to add other devices to your 
trusted device list, such as your computer.

Entering basic Bluetooth settings

1 Go to your Today screen and tap 
Bluetooth .

2 Select the Mode tab and check the Turn 

on Bluetooth box to turn on the 
Bluetooth feature on your smartphone.

3 Check or uncheck the Make the device 

visible to other devices box.

Check this box to allow Bluetooth 
devices that are not on your Trusted 
Device list to request a connection with 
your device. Your device remains 
accessible to other devices until you 
uncheck the box.

The Bluetooth status icon

The Bluetooth icon on your Today screen 
indicates the status of the Bluetooth 
feature: 

DID YOU KNOW? Check your battery level before 
establishing a Bluetooth connection. If the 
battery level is low, you can’t make a 
Bluetooth connection.
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Requesting a connection with another 

Bluetooth device

BEFORE YOU BEGIN To prepare your 
smartphone to be able to accept a 
connection from a requesting device, enter 
the basic Bluetooth settings as described 
in Entering basic Bluetooth settings.

1 Go to your Today screen and tap 
Bluetooth .

2 Select the Mode tab and check the Turn 

on Bluetooth box to turn on the 
Bluetooth feature on your smartphone.

3 Select the Devices tab, and then select 
Add new device.

4 Wait for your smartphone to search for 
devices and to display the device list.

 Bluetooth off.

 Bluetooth on. 

 Connected to a Bluetooth device.

 Call in progress with a Bluetooth 
headset or car kit.

KEY TERM Partnership Two devices—for 
example, your smartphone and a hands-free 
device—that can connect because each 
device finds the same passkey on the other 
device. After you form a partnership with a 
device, you don’t need to enter a passkey to 
connect with that device again. Partnership is 
also known as paired relationship, pairing, 
trusted device, and trusted pair.
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5 Select the device with which you want 
to connect, and then press Next  
(right action key).

6 Enter an alphanumeric passkey 
between 1 and 16 characters long, and 
then press Next  (right action 
key).

IMPORTANT Some hands-free devices 
have a predefined passkey. If your device 
has a predefined passkey, you can find it in 
the documentation for that device. Other 
devices provide a screen where you enter 
a passkey that you make up. In either case, 
you must use the same passkey on both 
your smartphone and the other device. We 
recommend that where possible, you 
make up a passkey of 16 alphanumeric 
characters (letters and numerals only) to 

improve the security of your smartphone. 
The longer the passkey, the more difficult it 
is for the passkey to be deciphered.

7 If the passkey is not built-in, enter the 
same passkey on the other Bluetooth 
device, and then press Finish  
(right action key).

8 Press OK .

You can now communicate with this device 
whenever it is within range and the 
Bluetooth feature on your smartphone is 
turned on. The range varies greatly 
depending on environmental factors. The 
maximum is about 9 meters (30 feet).

TIP To delete the established partnership with 
a device, go to the Bluetooth Settings screen 
and select the Devices tab. Highlight the 
connection you want to remove, press and 
hold Center on the 5-way, and then select 
Delete. Select Yes to confirm the deletion. 
The deleted device can no longer 
automatically connect with your smartphone.
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Accepting a connection from another 

Bluetooth device 

BEFORE YOU BEGIN To prepare your 
smartphone to be able to accept a 
connection from a requesting device, enter 
the basic Bluetooth settings as described 
in Entering basic Bluetooth settings.

1 Go to your Today screen and tap 
Bluetooth .

2 Select the Mode tab and check the Turn 

on Bluetooth box to turn on the 
Bluetooth feature on your smartphone.

3 If you have already set up a partnership 
with the transmitting device, your 
smartphone is ready to receive the info. 

If you haven’t set up a connection, 
check the Make this device visible to 

other devices box to let the device find 
your smartphone and request a 
connection. 

4 When prompted to add this device, 
select Yes.

5 Enter the same passkey on your 
smartphone and on the Bluetooth 
device.

6 (Optional) To give the partnership a 
more meaningful name, select Display 

Name and enter a new name.

7 Press Finish  (right action key).

8 When your smartphone is receiving 
info, a notification tells you that a 
transmission is in progress. To stop the 
transmission, press Cancel  (right 
action key). To close the notification, 
press Hide  (left action key).

Using your device as 
a wireless modem 

Internet Connection Sharing (ICS) is the 
feature that converts your smartphone into 
a modem so that you can access the 
Internet from your computer.

You can set up Internet Connection Sharing 
in one of two ways:

• Connect your smartphone to your 
computer using the USB sync cable.

• If your computer is enabled with 
Bluetooth wireless technology, you can 
set up your smartphone as a wireless 
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modem using the built-in Bluetooth 
technology.

Setting up a USB Internet Connection 

Sharing connection

1 Connect your smartphone to your 
computer using the sync cable.

2 On your smartphone, press Start  
and select Programs.

3 Select Internet Sharing .

4 Select the PC Connection list, and then 
select USB.

5 Press Connect  (left action key).

6 On your computer, open your web 
browser to confirm that you can 
connect to the Internet.

Creating a Bluetooth Internet Connection 

Sharing connection

BEFORE YOU BEGIN

• Make sure your smartphone is visible 
(see Entering basic Bluetooth settings).

• Create a partnership between your 
smartphone and your computer. We 
recommend that you initiate the 
partnership from your smartphone (see 

Requesting a connection with another 
Bluetooth device).

1 On your computer, double-click the icon 
to open the Bluetooth connections 
window. Check the documentation 
included with your computer for 
instructions.

2 Select the option to view devices within 
range.

3 You should see an icon representing 
your smartphone. Double-click this icon 
to make sure that “Network Access 
Point” or something similar appears in 
the list of Bluetooth services.

4 On your smartphone, press Start  
and select Programs.

5 Select Internet Sharing .

6 Select the PC Connection list, and then 
select Bluetooth PAN.

TIP Don’t see your smartphone icon or the list 
of services? Check the documentation 
included with your computer, or contact your 
computer manufacturer for help. Different 
computer models use different terminology 
for the Bluetooth connection features.
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NOTE Keep the default setting on the 
Network Connection list.

7 Press Connect  (left action key) 
and follow the wizard to set up Internet 
Sharing.

8 On your computer, follow the steps to 
accept or enable a Bluetooth PAN 

connection with your smartphone. 
Check the documentation included with 
your computer for instructions.

9 After you have connected, on your 
computer, open your web browser to 
confirm that you can connect to the 
Internet.
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Your photos, videos, and 
music
Do you have a wallet bulging with photos of friends, family, 
pets, and your most recent vacation?

Are you tired of carrying both your MP3 player and your phone? 

Your Palm® Treo™ 800W smartphone solves both problems. You 
can keep your favorite photos right on your smartphone—
videos, too. And there's no need to carry an expensive MP3 
player, because you can play music on your smartphone. 
Simply transfer songs onto your smartphone or an expansion 
card (sold separately) and then listen through your stereo 
headphones.

Benefits

• Never be far from your favorite 
people, places, and songs

• Arrange your photos, videos, and 
songs

• Avoid having to use a separate 
photo viewer, MP3, CD, or 
mini-disc player
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Synchronizing your 
media files

You can synchronize pictures, videos, and 
music files between your smartphone and 
your computer so that changes you make 
show up on both your computer and your 
smartphone. To synchronize media files, 
you must first choose Media as one of your 
synchronization options on your 
smartphone; see Changing which 
applications sync.

The procedure for synchronizing media 
files is different for computers running 
Windows XP and computers running 
Windows Vista. 

Synchronizing media files: Windows XP

BEFORE YOU BEGIN You must install 
ActiveSync® desktop software from the 
Windows Getting Started Disc (see 
Installing ActiveSync desktop software: 
Windows XP) and select the option to 
synchronize media (see Changing which 
applications sync).

When you synchronize your smartphone, 
your pictures and videos are synchronized 
between your smartphone and your 
desktop computer. On your computer, you 
can view the pictures and videos, and you 
can also send them to friends using your 
desktop email application.

To find all synchronized pictures and videos 
on your computer, look in C:\Documents 
and Settings\<Username>\My 
Documents\Treo My Documents.

You use Windows Media Player to 
synchronize music files; see Transferring 
media files to your smartphone.

Synchronizing media files: Windows Vista

BEFORE YOU BEGIN You must install 
Windows Mobile Device Center from the 
Windows Getting Started Disc (see 
Installing Windows Mobile Device Center: 
Windows Vista) and select the option to 
synchronize media (see Changing which 
applications sync).

On a computer running Windows Vista, 
you use Windows Media Player to 
synchronize all types of media files—
pictures, videos, and music files—that are 
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on your computer to your smartphone. See 
Transferring media files to your 
smartphone.

To synchronize pictures and videos from 
your smartphone to your computer, follow 
these steps:

1 Connect your smartphone to your 
computer with the USB sync cable.

2 On your computer, click Start > All 

Programs > Windows Mobile Device 

Center.

3 Select Connect without setting up 

your device.

4 Select Pictures, Music and Video.

5 Select X new pictures/video clips are 

available for import. 

All new or changed pictures and videos on 
your smartphone are synchronized to your 
computer.

Camera

Your smartphone comes with an 
easy-to-use, built-in, 1.3-megapixel camera 
with 2x digital zoom. You can use the 
camera to take and view pictures and 
videos and send them to your friends and 
family. To add a personal touch to your 
smartphone, use your pictures as your 
Today screen background and as caller ID 
images, or use your videos to create video 
ringtones.

You can receive and view pictures and 
videos, and send pictures and videos as 
attachments or multimedia messages (see 
Pictures & Videos). Or add a picture to a 
contact (see Adding a contact). You can 
also move pictures and videos to a 
computer by synchronizing your 
smartphone with your computer. 

Taking a picture

By default, pictures are stored in the My 
Pictures folder on your smartphone. If you 
want to store your pictures on an 
expansion card, you can change where 
pictures are stored (see Customizing your 
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Camera settings). For information on 
accessing your pictures on your computer, 
see Synchronizing media files: Windows 
XP.

1 Press Start  and select Programs.

2 Select Camera .
 

3 Adjust the position of your smartphone 
until you see the subject you want to 
photograph on the screen. Your 
smartphone has a self-portrait mirror 
next to the camera lens on the back of 
your smartphone. Use the mirror when 
you’re taking a picture and you want to 
be in the picture.

4 (Optional) Adjust any of the following:

Zoom: Press Up  to zoom in or 
Down  to zoom out.

Resolution: Press Menu  (right 
action key) and select Resolution to 
change the image quality.

5 (Optional) Set a five-second timer: Press 
Menu  (right action key), select 
Mode, and then select Timer.

6 Press Center  to capture the picture 
or start the timer.

7 Hold your smartphone still until the 
picture renders, and then do one of the 
following:

• Press Camera  (left action key) 
to take another picture.

DID YOU KNOW? Pictures are captured and stored 
in 16-bit color, JPG format. Resolution settings 
range from a low end of QQVGA (120 x 160 
pixels) to a high end of 1.3-megapixels (1280 x 
1024 pixels). You can change the default 
setting. See Customizing your Camera 
settings for details. 

TIP If you see a camcorder icon below the 
preview image, video mode is on. To turn on 
the still camera, press Menu and select Still. 
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• Press OK  and then press 
Thumbnails  (left action key) to 
return to Thumbnail View.

Taking pictures in burst mode

Burst mode takes five pictures in quick 
succession, with one button press.

1 Press Start  and select Programs.

2 Select Camera .

3 Press Menu  (right action key) 
and select Mode > Burst.

4 Press Center .

Recording a video

Videos can be any length, provided you 
have enough storage space available. By 
default, videos are stored in the My 
Pictures folder on your smartphone. If you 
want to store your videos on an expansion 
card, see Customizing your Camera 
settings to change where videos are 
stored. For information on accessing your 

videos on your computer, see 
Synchronizing media files: Windows XP.

1 Press Start  and select Programs.

2 Select Camera .

3 Press Menu  (right action key) 
and select Video.

4 Adjust the position of your smartphone 
until you see the subject you want to 
record on the screen. Your smartphone 
has a self-portrait mirror next to the 
camera lens on the back of your 
smartphone. Use the mirror when 
you’re recording a video and you want 
to be in the video.

5 Press Menu  and select Quality 
to change the video resolution.

6 Press Center  to start recording.

DID YOU KNOW? After three minutes of inactivity 
when previewing an image, the camera goes 
into standby mode. Press any key or tap the 
screen to return to the image preview. 
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7 When you’re finished recording, press 
Stop  (left action key) or Center 

 to stop recording.

8 (Optional) To review the video in 
Windows Media Player Mobile, press 
Thumbnails  (left action key), 
highlight the video, and then press 
Center . Press OK  to return to 
Thumbnail View. 

Customizing your Camera settings

1 Press Start  and select Pictures & 

Videos .

2 Press Menu  (right action key) 
and select Options.

3 On the General tab, set any of the 
following options:

Use this picture size: Sets the size of 
pictures you send with the Inbox 
application.

When rotating a picture, rotate 90 

degrees: Sets the direction in which 
pictures rotate.

4 Select the Slide Show tab, and set any 
of the following options:

TIP If you don’t like a video you recorded, 
delete it. See Deleting a picture or video for 
details.

DID YOU KNOW? After three minutes of inactivity 
when previewing an image, the camera goes 
into standby mode. Press any key or tap the 
screen to return to the image preview. If the 
camera goes to standby while the recording is 
paused, the video recording is stopped and 
the video is saved.
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During slide shows, optimize for 

viewing: Sets whether pictures are 
optimized for portrait or landscape 
format during slide shows.

Play screensaver when connected to 

my PC and idle for 2 minutes: Sets 
whether the pictures in your My 
Pictures folder are used as a 
screensaver when your smartphone is 
connected to your computer and 
ActiveSync® desktop software is not 
running.

5 Select the Camera tab, and set any of 
the following options:

Type filename prefix: Assigns a name 
to a series of pictures to be captured, 
such as Seattle001, Seattle002, and so 
on.

Save files to: Specifies whether 
pictures and videos are stored on your 
smartphone or on an expansion card.

Still image compression level: 
Sets the default quality and size for 
newly captured  still pictures.
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6 Select the Video tab, and set any of the 
following options:

Include audio when recording video 

files: Turns the microphone on and off 
so that you can record videos with or 
without sound.

Time limit for videos: Limits the length 
of videos you record. You can select the 
No limit option.

7 Press OK  to return to 
Thumbnail View.

Pictures & Videos

Viewing a picture

In addition to viewing the pictures you 
capture with the built-in camera, you can 
view pictures captured on many popular 
digital cameras or downloaded from the 
Internet. Your smartphone supports the 
following picture formats:

• JPG 

• PNG

• BMP

• GIF

1 Press Start  and select Programs.

2 Select Pictures & Videos .

3 Select the picture you want to view. 

4 Press OK  to return to Thumbnail 
View.

Viewing a video

In addition to viewing the videos you 
capture with the built-in camera, you can 
view videos captured on many popular 
digital cameras or streamed from 

DID YOU KNOW? Videos are captured and stored in 
3GP format. Video resolution ranges from 176 
x 144 pixels to 352 x 288 pixels. You can 
change the resolution setting by pressing 
Menu (right action key) and selecting Quality. 
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websites. Your smartphone supports and 
streams the following types of video files:

• MPEG-4

• 3GPP2

• 3GPP

• WMV, WMA, ASF

• RTSP Streaming

1 Press Start  and select Programs.

2 Select Pictures & Videos .

3 Select the video you want to view. For 
more info on viewing videos, see 
Playing media files on your smartphone.

4 Press OK  to return to Thumbnail 
View.

Viewing a slide show

1 Press Start  and select Programs.

2 Select Pictures & Videos .

3 Press Menu  (right action key) 
and select Play Slide Show. The slide 
show plays automatically.

4 Press Center  to display the slide 
show toolbar, which you can use to 
Rotate , Play , Pause , Reverse 

, Forward , and Stop  the slide 
show.

Sending a picture or video

You can send a picture or video to other 
picture-enabled mobile smartphone 
devices or to an email address as an 
attachment.

You cannot send copyrighted pictures or 
videos that appear with a lock icon in 
Thumbnail View.

1 Highlight the picture or video you want 
to send. 

2 Press Menu  (right action key) 
and select Send.

3 Select the option you want to use to 
send the picture or video: an email 
account or MMS

4 When the Inbox or Messaging 
application opens, address and send the 
message (see Creating and sending an 
email message or Creating and sending 
a multimedia message).

TIP To view pictures or videos in a different 
folder, tap the Show list in the upper-left, and 
then select the album you want to view. 
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Creating a video ringtone

You can save a video that you record as a 
ringtone.

1 Highlight the video you want to use as a 
ringtone.

2 Press Menu  (right action key) 
and select Save to Contact Ring Tone.

3 Select the contact to whom you want to 
assign the ringtone.

Organizing pictures and videos

You can move or copy pictures and videos 
to other folders or between your 
smartphone and an expansion card.

1 Highlight the picture or video you want 
to move or copy.

2 Do one of the following:

• To move the picture or video to 
another location, press Menu  
(right action key) and select Edit > 
Cut.

• To keep the picture or video in two 
locations, press Menu  (right 
action key) and select Edit > Copy.

3 Tap the Show list in the upper-left, and 
select the location where you want to 
place the picture or video.

4 Press Menu  (right action key) 
and select Edit > Paste.

You can also view a specific folder or 
expansion card and arrange the pictures 
and videos by name, date, or size.

1 Tap the Show list in the upper-left, and 
then select the folder you want to view.

2 Tap the Sort By list in the upper-right, 
and then select the sort method: 
Name, Date, or Size.

Using a picture as the Today screen 

background

1 Highlight the picture you want to use.

2 Press Menu  (right action key) 
and select Set as Today Background.

3 Select the Transparency level list and 
select the appropriate level. Use a 
higher percentage for a more 
transparent picture and a lower 
percentage for a more opaque picture.

4 Press OK  to return to Thumbnail 
View.
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Editing a picture

For more extensive edits, just download 
your picture or video to your computer and 
edit it in your favorite graphics program. 
Then sync the picture or video back to your 
smartphone.

1 Select the picture you want to edit.

2 Press Menu  (right action key) 
and select Edit.

3 Do any of the following: 

• To rotate the picture 90 degrees, 
press Rotate  (left action key). 

• To crop the picture, press Menu 
 (right action key) and select 

Crop. Tap and drag the stylus to 
highlight the area to crop. Tap outside 
the box to stop cropping. 

• To adjust the brightness and contrast 
levels of the picture, press Menu 

 (right action key) and select 
AutoCorrect. 

• To undo an edit, press Menu and 
select Undo.

• To cancel all unsaved edits you made 
to the picture, press Menu  
(right action key) and select Revert to 

Saved.

Deleting a picture or video

1 Highlight the picture or video you want 
to delete.

2 Press Menu  (right action key) 
and select Delete.

3 Select Yes to confirm the deletion. 

Renaming a picture or video

1 Highlight the picture or video you want 
to delete.

2 Press Menu  (right action key) 
and select Properties.

3 Enter a new name for the picture or 
video.

4  Press OK  to return to Thumbnail 
View.
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Windows Media 
Player Mobile

Windows Media Player Mobile can play 
music, audio, and video files that are 
stored on your smartphone or on an 
expansion card (sold separately) in any of 
the following file formats:

• WMA 

• WMV 

• MP3

• 3GP

• AAC

• AAC+

• MPEG-4

IMPORTANT You must have QuickTime 
Player version 6.5 or later installed on your 
computer to play videos recorded by your 
smartphone. You can download the videos 
from an expansion card or you can click the 

video thumbnail after synchronizing the 
files.

You can listen to these music, audio, and 
video files through the speaker on the back 
of your smartphone or through stereo 
headphones.

Transferring media files to your 

smartphone

Use the Sync feature in the desktop 
version of Windows Media Player to 
transfer digital music, audio, video, and 
playlist files from your computer to an 
expansion card or your smartphone. Using 
the Sync feature ensures that the files are 
transferred correctly.

BEFORE YOU BEGIN Do the following:

• Be sure you have Windows Media 
Player 10 or later installed on your 
computer. On a Windows XP computer, 
Windows Media Player 10 must be 

DID YOU KNOW? You can also download animated 
GIF files and view them in Internet Explorer 
Mobile. 

TIP For tips on using the desktop version of 
Windows Media Player, go to the Help menu 
in Windows Media Player on your computer.
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installed on your computer before you 
install ActiveSync desktop software. 
Both Windows Media Player 10 and 
ActiveSync desktop software can be 
installed from the Windows Mobile 
Getting Started CD that came with your 
smartphone. (If you are having trouble, 
see My video and music files won’t 
sync.)

NOTE Windows Media Player 11 is already 
installed on Windows Vista computers.

• To sync media files with your computer, 
set the Media sync option on your 
smartphone (see Setting 
synchronization options).

1 On your computer, open Windows 
Media Player.

2 (Optional) If you’re transferring media 
files to an expansion card, insert a 
32MB or larger expansion card into your 
smartphone.

3 Connect your smartphone to your 
computer with the USB sync cable.

4 Do one of the following:

Windows XP: When the Device Setup 
Wizard opens on your computer, 
click Automatic. Check the Customize 

the playlists that will be 

synchronized box.

Windows Vista: Select the Sync tab, 
and then select Treo > Set Up Sync. 
Check the Sync this device 

automatically box.

5 Select the playlists you want to sync. 
On a Windows Vista computer, select 
the All Photos and All Videos playlists 
to synchronize pictures and videos 
between your smartphone and your 
computer.

6 Click Finish to begin the transfer. If you 
are transferring files to an expansion 
card, be patient; transferring media files 
to an expansion card can take several 
minutes.

Playing media files on your smartphone

1 Press Start  and select Programs.

2 Select Windows Media .

3 Press Menu  (right action key) 
and select Library. 
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4 Select the Library list in the upper-left, 
and then select the library you want to 
use. If you can’t find a media file on your 
expansion card, update the library (see 
Working with libraries).

5 Select the item you want to play (such 
as a song, album, or artist name).

6 Press Play  (left action key). See 
the next page for playback controls.

7 Press Menu  (right action key) 
and select any of the following during 
playback:

Library: Displays the Library screen so 
you can select a different song to play.

Shuffle/Repeat > Shuffle: Plays the 
Now Playing playlist in random order. A 
check appears next to this command 
when it is on.

Shuffle/Repeat > Repeat: Plays the 
Now Playing playlist repeatedly. A check 
appears next to this command when it 
is on.

Stop: Ends playback.

Use any of the following onscreen controls 
during playback:

 or Center  plays the current file.

 or Center  pauses the current file.

 or Left  skips to the beginning of the 
current file or to the previous file.

 or Right  skips to the next file.

 sets the point from which playback 
begins. Tap and drag the slider to 
change the current position.

 or Volume button increases the 
volume level.

 or Volume button decreases the 
volume level.

 turns the sound on or off.

 displays a video using the full 
screen.

TIP  To play a file that is not in a library, go to 
the Library screen, press Menu, and select 
Open File.

TIP To repeat the current song, press Menu 
and select Repeat Song.
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 displays a website where you can 
find music and videos to play.

 indicates the rating of the current 
file. Select the star to change the rating.

Working with libraries

A library represents each of the storage 
locations available to Windows Media 
Player Mobile, so you should have two 
libraries: My Device and My Storage Card. 
Each library contains links to the media 
files in that location. Windows Media 
Player Mobile usually updates the My 
Device library automatically, but you must 
manually update the My Storage Card 
library.

1 Press Start  and select Programs.

2 Select Windows Media .

3 Press Menu  (right action key, and 
select Library.

4 Press Menu  (right action key) 
and select Update Library.

5 Wait for the files to be added, and then 
select Done.

DID YOU KNOW? You can play streaming files from 
the web. To play an MMS (Microsoft Media 
Streaming) file, press Menu on the Library 
screen and select Open URL. Select URL and 
enter the website address, or select History 
and select a site you’ve visited before. 

DID YOU KNOW? If you close the Windows Media 
Player Mobile window, your music continues 
to play in the background.

TIP If you don’t see a media file that you added, 
manually update the library.

TIP To delete an item from a library, highlight 
the item and then press and hold Center on 
the 5-way to open the shortcut menu. Select 
Delete from Library, and select Yes to 
confirm the deletion.

DID YOU KNOW? If you move files between your 
smartphone and an expansion card, be sure to 
update your libraries, or you won’t be able to 
see the files in their new location.
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Working with playlists

A playlist is a list of media files that play in 
a specific order. You can use playlists to 
group audio files together or video files 
together for convenient playback. For 
example, in the desktop Windows Media 
Player, you can create a playlist of upbeat 
songs for when you exercise and a playlist 
of soothing songs for a long flight. When 
you synchronize, your favorite playlists are 
automatically copied to your smartphone. 
Your playlists appear in your libraries (in the 
My Playlists category).

A temporary playlist, called Now Playing, 
appears on the Now Playing menu. It lists 
the currently playing file, as well as any 
files that are queued up to play next. You 
can add to, modify, or clear the files on the 
Now Playing playlist.

1 Go to the Now Playing screen:

• If you are on the Library screen, 
select the Now Playing category.

• If you are on the Playback screen, 
select Now Playing.

2 Do any of the following:

• To move a file up or down one slot, 
highlight the file and select Move 

Up  or Move Down .

• To add a file, highlight the file, select 
Add , press Menu  (right 
action key), and then select Queue 

Up.

• To delete a file from the playlist, 
highlight the file and select Remove 

.

TIP You can also move a file in the Now Playing 
playlist by tapping and dragging it to a new 
position.
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• To view more info about a file, 
highlight the file and select 
Properties .

• To remove all items from the Now 
Playing playlist, press Menu  
(right action key) and select Clear 

Now Playing.

Customizing Windows Media Player 

Mobile

1 If you are on any screen other than the 
Playback screen, press OK  to go to 
the Playback screen.

2 Press Menu  (right action key) 
and select Options.

3 On the Playback tab, set any of the 
following options:

Show time as: Sets whether the time 
remaining or time elapsed appears in 
the Playback screen.

Pause playback while using another 

program: Sets whether playback 
continues if you switch to another 
application.

Resume playback after a phone call: 

Sets whether playback continues after 
you finish a phone call.

4 Select the Video tab and set any of the 
following options:

Play video in full screen: Sets whether 
videos automatically play in full screen 
format.

Scale to fit window: Sets whether 
videos are automatically scaled to fit the 
Playback screen.

5 Select the Network tab and set the 
following options:

Protocol: Enables and disables the 
available protocols. You must select at 
least one protocol. You can also set a 
UDP Port.
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Internet connection speed: Specifies 
the speed of your network connection, 
and specifies whether you want the 
device to detect connection speed.

6 Select the Library tab and set whether 
you want to see the Library or Playback 
screen when you open Windows Media 
Player Mobile.

7 Select the Skins tab and select 
Previous or Next to set the player’s 
background.

8 Select the Buttons tab to change any of 
the available button settings:

• To assign a button, highlight the item 
you want to set, select Assign, and 
then press the button you want to use 
for that item.

• To restore an item’s factory setting, 
highlight the item and select Reset.

• To unassign an item, highlight the 
item and select None.

9 Press OK .
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CHAPTER

10

Your personal information 
organizer
Say good-bye to paper calendars and throw away those 
scribbled to-do lists. Your Palm® Treo™ 800W smartphone is all 
you need to organize your personal information and keep it with 
you wherever you go.

You never lose your information, even if your battery is 
completely drained. All your personal information is backed up 
each time you synchronize, and your information is kept private 
when you use the security features available on your 
smartphone. Also, you can easily share info with others 
electronically.

Benefits

• Track current, future, and past 
appointments

• Make to-do lists that get done 

• Set reminders for appointments, 
birthdays, important tasks, and 
more
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Contacts

Adding a contact

1 Press Start  and select Contacts.

2 Press New  (left action key).

3 Select the type of contact to create:

Outlook Contact: This type of contact 
is stored in the Contacts application on 
your smartphone and synchronizes with 
the Contacts application in Microsoft 
Outlook on your computer.

SIM Contact: This type of contact is 
stored on the SIM card in your 
smartphone and does not synchronize. 
If you use the SIM card with another 
smartphone, you can access any 
contacts on the SIM card (see Using 
SIM Manager).

4 Use the 5-way navigator to move 
between fields as you enter 
information.

Here are some helpful tips for entering 
info:

• To enter complete name or address 
(work, home, or other) information, 
tap the arrow on the right side of the 
line and enter the information in the 
box that appears. When finished, tap 

TIP Take some time to scroll down through all 
the fields in a new contact. There are fields for 
multiple addresses, phone numbers, email 
addresses, and much more.

TIP Be sure to enter mobile numbers and email 
addresses in the correct fields so that Inbox 
and Messaging can find this info when you 
address a message and Calendar can find your 
contacts when you want to invite them to 
meetings.
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outside the box to accept the 
information and close the box.

• To add a caller ID picture that displays 
when that person calls, select 
Picture, and then select Camera and 
take a picture, or select an existing 
picture from Thumbnail View. 

• To assign the entry to one or more 
categories, select Categories and 
then check the categories under 
which you want this entry to appear.

• To assign a ringtone to the entry, 
select Ring tone and select a tone.

5 To add a note to an entry, select the 
Notes tab.

6 After you enter all the information, press 
OK . 

Viewing or changing contact information

1 In the Contacts list (viewed by name), 
begin entering one of the following for 
the contact you want to view or edit:

• First name

• Last name

• First initial and last initial separated by 
a space

• Phone number

2 Select the entry you want to open.

3 Press Menu  (right action key) 
and select Edit.

4 Make changes to the entry as 
necessary.

5 Press OK .

DID YOU KNOW? When you select a contact entry, 
you are presented with several options for 
contacting the person, depending on what 
information you have entered for the contact. 
For example, you may see options for calling a 
number associated with the contact, sending 
an email to the contact’s email address, or 
calling the last number you dialed to call the 
contact.

DID YOU KNOW? You can find a contact by company 
name. Press Menu (right action key) and 
select View By > Company. Select a 
company name to see the contacts who work 
there.

TIP To view a particular group of contacts, 
press Menu (right action key), select Filter, 
and then select the category you want to 
view.
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Deleting a contact

1 In the Contacts list, highlight the 
contact you want to delete.

2 Press Menu  (right action key) 
and select Delete Contact.

3 Select Yes to confirm the deletion.

Customizing Contacts

1 Go to the Contacts list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Show alphabetical index: Displays the 
alphabet at the top of the Contacts list. 
You can use this index to find a contact.

Show contact names only: Enables 
you to fit more names on the Contacts 
list by hiding everything but the 
contact’s name.

Area code: Specifies the default area 
code for new contact entries.

4 Press OK .

Finding a contact in an online address 

book

In addition to having contacts on your 
device, you can also access contact 
information from your organization’s online 
address book or Global Address List (GAL).

BEFORE YOU BEGIN Do the following:

• Make sure you are accessing Exchange 
Server 2007 or Exchange Server 2003 
upgraded to Service Pack 2.

• Add access to the online address book 
to your smartphone. See Adding an 
online address book.

• After adding the online address book, 
you must synchronize with the 
Exchange server in order for the 
Company Directory option to appear.

1 Press Start  and select Contacts.

2 Press Menu  (right action key), 
select Company Directory, enter the 
name of the contact, and then select 
Search. 
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Using SIM Manager

You can manage the contacts on your SIM 
card, including deleting numbers and 
transferring numbers between the card 
and the Contacts application on your 
smartphone.

1 Press Start  and select Contacts.

2 Press Menu  (right action key) 
and select SIM Manager.

3 Highlight the contact you want.

4 Press Menu  (right action key) 
and select the option you want to edit 
the contact’s information, delete the 
contact, copy it to the Contacts 
application, and more. 

5 Press OK 

Calendar

Displaying your calendar

1 Press Start  and select Calendar.

2 Press Menu  (right action key) 
and select View.

3 Select one of the following views:

Agenda: Shows your daily schedule in 
list format. Upcoming appointments are 
bold; past appointments are dimmed.

Day: Shows your daily schedule in 
day-planner format. Day View displays a 
horizontal time strip at the top to show 
at a glance when you have 
appointments.

Week: Shows your schedule for an 
entire week.TIP If a contact has more than one phone 

number, you can automatically copy one or 
more of the numbers to the SIM card. In SIM 
Manager, press Menu (right action key) and 
select Tools > Options. Check the boxes next 
to the numbers you want automatically copied 
to the SIM card.

DID YOU KNOW? If your schedule contains a 
conflict—two appointments that overlap—you 
can see the conflict in both Day View and 
Week View.
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Month: Shows your schedule for a 
whole month. 

 A morning appointment

 An afternoon appointment

 Both morning and evening 
appointments 

 An all-day event

Year: Shows a calendar for a six-month 
period.

4 Use the 5-way to move to another day, 
week, month, or year (depending on the 
current view).

Creating an appointment

1 Press Start  and select Calendar.

2 Press Menu  (right action key) 
and select New Appointment.

3 Enter a subject (description) and a 
location.

4 Select Starts and select the starting 
date and time.

5 Select Ends and select the ending date 
and time.

6 Press OK .

TIP To switch views, press the left action key. 
Don’t confuse the view name displayed above 
the left action key with the current view. The 
left action key displays the name of the next 
view you see when you press the key.

TIP To “pencil in” an appointment, open the 
appointment, select Status, and then select 
Tentative.

TIP You can display your appointments on your 
Today screen (see Selecting which items 
appear on your Today screen).
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Adding an alarm reminder to an event

1 Create an event and then select it.

2 Press Menu  (right action key) 
and select Edit.

3 Select Reminder and then select 
Remind Me.

4 Enter the number of minutes, hours, 
days, or weeks before the event you 
would like to receive the alarm.

5 Press OK .

Creating an untimed event

An untimed event, such as a birthday, 
anniversary, or vacation, does not occur at 
a particular time of day. These events 

appear as banners at the top of your 
calendar; they don’t occupy blocks of time. 
For example, “Submit Final Draft” in the 
screenshot shown below is an untimed 
event.

1 Press Start  and select Calendar.

2 Press Menu  (right action key) 
and select New Appointment.

3 Enter a subject (description).

4 Select the starting and ending dates.

5 Select All Day, and then select Yes.

6 Press OK .

Type of time units

Number of time units

DID YOU KNOW? An untimed event can last longer 
than a day.
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Scheduling a repeating appointment

1 Create an appointment or untimed 
event, and then select it.

2 Press Menu  (right action key) 
and select Edit.

3 Select Occurs, and then select a repeat 
pattern. To create a repeat pattern, 
select Edit pattern and follow the 
onscreen instructions.

4 Press OK .

Sending a meeting request

You can email meeting invitations to 
contacts who use Microsoft Office 
Outlook® or Outlook Mobile.

BEFORE YOU BEGIN Create contact 
entries with email addresses for the people 
you want to invite to a meeting. You can’t 
access contact entries without email 
addresses from your calendar.

1 Create an event, and then select it.

2 Press Menu  (right action key) 
and select Edit.

3 Select Attendees. Select Add 

Required Attendees, and then select 
the name of the contact you want to 
invite. To invite other attendees, select 
Add Required Attendees, and then 
select the names.

4 (Optional) To invite optional attendees, 
select Add Optional Attendees, and 
then select the names.

5  Press OK .

The next time you synchronize, the 
meeting request is sent to the attendees. 
When attendees accept your meeting 
request, the meeting is automatically 
added to their schedules. When you 
receive their response, your calendar is 
updated as well.

TIP To enter a birthday or an anniversary, create 
an untimed event that repeats every year.

DID YOU KNOW? If you are using Exchange Server 
2007 or Exchange Server 2003 with Service 
Pack 2, you can use your corporate Global 
Address List to find contact information for an 
attendee. Select Attendees, press Menu 
(right action key), and then select Find 

Online. Enter the name of the attendee and 
select Find.
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Replying to a meeting request

You receive and reply to meeting requests 
in the Inbox application (see Working with 
meeting invitations). If you accept or 
tentatively accept an invitation, it shows up 
as an appointment in your Calendar.

Marking an event as sensitive

If other people have access to your 
Microsoft Office Outlook calendar on your 
computer and you don’t want them to see 
an appointment, you can mark that 
appointment as private to hide it from other 
Microsoft Office Outlook users.

1 Create an event, and then select it.

2 Press Edit  (left action key).

3 Select Sensitivity, and then select one 
of the following:

Personal: Displays the event on your 
smartphone and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Personal” near the 
top of an open appointment.

Private: Displays the event on your 
smartphone and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Private” near the 

top of an open appointment. If you sync 
with an Exchange server, other users 
who can access your folders can’t see 
your private events; they see private 
events as unavailable time slots.

Confidential: Displays the event on 
your smartphone and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Confidential” near 
the top of an open appointment. 

4 Press OK .

Organizing your schedule

Use categories to view various types of 
events.

1 Create an event, and then select it.

2 Press Menu  (right action key) 
and select Edit.

3 Select Categories, and then check the 
categories that apply to this event. 

TIP If you don’t see an option on the screen, 
press Down on the 5-way to scroll to other 
options. For example, when editing an event, 
you don’t see the Sensitivity option until you 
scroll toward the bottom of the entry.
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To add a new category, press 
New  (left action key), enter the 
category name, and then press OK .

4 Press OK  two more times.

5 After you assign events to categories, 
press Menu  (right action key) 
and select Filter.

6 Select the type of events you want to 
view.

Deleting an event

1 Highlight the event you want to delete.

2 Press Menu  (right action key) 
and select Delete Appointment.

3 Select Yes to confirm the deletion.

Customizing Calendar

1 Press Menu  (right action key) 
and select Tools > Options.

2 On the General tab, set any of the 
following options:

Start in: Specifies which view is 
displayed when you open Calendar.

1st day of week: Specifies Sunday or 
Monday as the first day of the week for 
all Calendar views.

Week view: Specifies whether five, six, 
or seven days appear in Week View.

Show half hour slots: Specifies 
whether time slots appear in hour or 

TIP Wonder why you’re not seeing all the 
events in your day? Check to make sure that 
the filter is set to All Appointments.
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half-hour increments in Day View and 
Week View.

Show week numbers: Specifies 
whether week numbers (1–52) appear 
in Week View.

3 Select the Appointments tab and set 
any of the following options:

Set reminders for new items: 

Specifies whether a reminder is 
automatically added to new events and 
how long before the event the reminder 
appears. You can override this setting 
for individual events.

Show icons: Specifies which icons 
appear next to events. 

 The event has a reminder.

 The event repeats in a specified 
pattern.

 The event has a note attached.

 A location has been assigned to the 
event.

 The event is a meeting.

 The event is marked private.

Send meeting requests via: Specifies 
the email account used to send meeting 
requests.

4 Press OK .

Tasks
You can use Tasks to remind you of tasks 
you need to complete and to keep a record 
of completed tasks.

TIP Not all icons appear in all Calendar views.
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Adding a task

1 Press Start  and select Programs.

2 Select Tasks .

3 Press Menu  (right action key) 
and select New Task.

4 Enter a description of the task in the 
Subject field.

5 Set any of the following:

Priority: Specifies the priority level for 
this task. Later you can arrange your 
tasks based on the importance of each 
task.

Status: Indicates whether the task is 
now completed.

Starts: Specifies when the task begins.

Due: Specifies the due date for the 
task.

Occurs: Indicates if the task repeats at 
regular intervals and how often it 
repeats.

Reminder: Sets an alarm for this task 
and indicates when you want to be 
reminded.

Categories: Assigns the task to one or 
more categories.

Sensitivity: Marks this task as Normal, 
Personal, Private, or Confidential.

Notes: Enables you to enter additional 
text for the task.

6 Press OK .

TIP You can also add a task by selecting the 
Tasks entry bar at the top of the task list 
screen, entering the task description, and 
tapping anywhere outside of the entry bar. 
Select the icons to the left of the bar to set 
the task as high or low priority.

TIP You can display your tasks on your Today 
screen (see Selecting which items appear on 
your Today screen).
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Checking off a task

1 Highlight the task you want to check off.

2 Press Complete  (left action key).

Organizing your tasks

1 In the Tasks list, press Menu  
(right action key) and select Filter.

2 Select which tasks you want to view: 
All Tasks, Recently Viewed, 
No Categories, Active Tasks, 
Completed Tasks, or a specific 
category, such as Business or Personal.

3 Press Menu  (right action key) 
and select Sort By.

4 Select the sort method: Status, 
Priority, Subject, Start Date, or 
Due Date.

Deleting a task

1 Highlight the task you want to delete.

2 Press Menu  (right action key) 
and select Delete Task.

3 Select Yes to confirm the deletion.

Customizing Tasks

1 Go to the Tasks list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Set reminders for new items: 

Automatically adds a reminder to new 
tasks. The default reminder is set to 
8:00 on the morning the task is due. You 
can override this setting for individual 
tasks.

Show start and due dates: Displays 
task start and due dates in the Tasks 
list.

TIP You can also mark a task complete by 
tapping the check box next to the task on the 
Tasks list.

DID YOU KNOW? Overdue tasks appear in red.
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Show Tasks entry bar: Displays the 
Tasks entry bar at the top of the Tasks 
list.

4 Press OK .

Notes

Notes are a great way to capture thoughts, 
questions, and meeting notes on your 
smartphone. You can also create a voice 
note or add a recording to an existing note.

BEFORE YOU BEGIN To take advantage of 
all the sync features available in the Notes 
application, install ActiveSync desktop 
synchronization software from your 
Windows Mobile Getting Started CD.

Creating a note

1 Press Start  and select Programs. 

2 Select Notes .

3 Press New  (left action key).

4 Do one of the following:

• Type the text with the keyboard.

• If you turned on writing mode (see 
Customizing Notes), write the text 
with the stylus.

• Press Menu  (right action key), 
select Draw, and then draw a sketch 
with the stylus, crossing at least three 
ruled lines.

5 Press OK .

Creating a voice note

1 Press Start  and select Programs.

2 Select Notes .

3 To add a voice recording to an existing 
note, open the note to which you want 
to add the recording.
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4 If the voice note controls are not visible 
at the bottom of the screen, press 
Menu  (right action key) and 
select View Recording Toolbar. 

5 Tap the Record  icon.

6 Speak into the microphone on your 
smartphone, or hold it close to another 
sound source.

7 When you finish recording, tap the Stop 
 icon. A Recording  icon appears 

in the note or note list, depending on 
where you recorded the note.

8 Press OK .

Creating a note from a template

1 Go to the Notes list.

2 Tap the Show list in the upper-left, and 
then select Templates.

3 Open the template you want to use.

4 Enter the information.

5 Press OK .

6 Rename the note and move it to the 
appropriate folder. See Organizing your 
notes for details.

Voice 
note 
controls

DID YOU KNOW? You can add several voice notes 
within a single note.

TIP To play a recording, select the voice note in 
the Notes list or open the note containing the 
recording and tap the Recording icon. Tap the 
controls at the bottom of the screen to control 
playback and volume.

TIP To create a new template, open the note 
you want to save as a template. Press Menu 
(right action key) and select Rename/Move. 
Select Name, and then enter a name for the 
template. Tap the Show list, select Template, 
and press OK.
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Organizing your notes

You can rename your notes, move notes to 
another folder, and move notes between 
your smartphone and an expansion 
(storage) card.

1 Go to the Notes list and highlight a note 
you want to move.

2 Press Menu  (right action key) 
and select Rename/Move.

3 Select Name and enter a new name for 
the note.

4 Select Folder, and then select the folder 
in which you want to store the note.

5 Select Location, and then select Main 

memory or Storage Card.

6 Press OK .

Deleting a note

1 Go to the Notes list and highlight the 
note you want to delete.

2 Press Menu  (right action key) 
and select Delete.

3 Select Yes to confirm the deletion.

Customizing Notes

1 Go to the Notes list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Default mode: Makes the default entry 
mode either Writing or Typing. The 
default is Typing; if you change it to 
Writing, you can write notes directly on 
the screen using the stylus.

Default template: Specifies the default 
template for new notes.

Save to: Indicates the default location 
where new notes are stored.

Record button action: Specifies what 
happens when you press the Side 
button to record a voice note while in 
another application: whether the Notes 
application opens or whether you stay 
in the current application.

TIP To create a new folder, go to the Notes list, 
tap the Show list in the upper-left, and then 
select Add/Delete. Select New, enter a name 
for the folder, and then press OK.
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4 Press OK .
TIP To use the Record button action feature, 
you need to assign the Side button to open 
Notes. See Reassigning buttons.

TIP Tap Global Input Options to set options 
for entering text in any application (see Setting 
input options).
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11

Your Microsoft Office and 
other document tools
Your Palm® Treo™ 800W smartphone enables you to take your 
office with you—including your Microsoft Office files. With 
Microsoft Office, you can carry, create, view, and edit Microsoft 
Word and Excel files directly on your smartphone. You can also 
view, carry, and manage PowerPoint files on your smartphone. 
You can keep updated copies of the files on both your 
smartphone and your computer so that you can work on them 
in the most convenient location at any time.

You can also use PDF Viewer to view PDF files on your 
smartphone.

Benefits

• Manage Word, Excel, and 
PowerPoint files on your 
smartphone

• Improve productivity by taking 
important docs, spreadsheets, and 
presentations with you

• Work with PDF files
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Synchronizing your 
Microsoft Office files

You can create and edit Microsoft Office 
files on your computer or on your 
smartphone and then synchronize the files 
so that changes you make show up on both 
your computer and your smartphone. To 
synchronize Microsoft Office files, you 
must first choose Files as one of your 
synchronization options on your 
smartphone if you did not do so during 
desktop software installation; see Setting 
up your computer for synchronization and 
Changing which applications sync.

The procedure for synchronizing files is 
different for computers running Windows 
XP and computers running Windows Vista. 

Synchronizing files: Windows XP

1 Connect your smartphone to your 
computer with the USB sync cable.

NOTE Most ActiveSync desktop software 
options are available only when your 
smartphone is connected to your 
computer.

2 On your computer, double-click the 
ActiveSync®  icon in the taskbar in 
the lower-right corner of your computer 
screen to open the ActiveSync desktop 
software window.

3 Under Information Type, double-click 
Files to view a list of all synchronized 
files.

TIP If the ActiveSync icon does not appear in 
the taskbar, go to Start, navigate to 
Programs, and then select Microsoft 

ActiveSync to open the ActiveSync window.
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4 Do any of the following:

• To delete a file from the file sync 
folder on your computer and from 
your smartphone, highlight the file 
name and click Remove.

• To copy a file from your computer to 
your smartphone, click Add, browse 
to and highlight the file, and then click 
Open.

NOTE If you receive an error while 
synchronizing files, make sure that all of 
the files you’re trying to sync are closed on 
both your computer and on your 
smartphone.

Synchronizing files: Windows Vista

1 On your computer, copy or save the file 
to the Documents\Documents on 
username’s Smartphone folder.

2 Connect your smartphone to your 
computer with the USB sync cable. 
Synchronization takes place 
automatically.

Where are the changes I made to my file?

Don't look for the changed file in its original 
location on your computer. Only the 
synchronized version contains the changes, 
and that version is in the ActiveSync file 
sync folder. To find this folder, do one of 
the following:

Windows XP: On your computer desktop, 
double-click the file sync folder icon. This is 
a shortcut to the file sync folder.

Windows XP: In ActiveSync desktop 
software, double-click Files. The location of 
the file sync folder appears in the File 
Synchronization Settings dialog box (under 
On this computer, synchronize the files in 
this folder).

Windows Vista: Open the Documents\ 
Documents on username’s Smartphone 
folder.

On your smartphone, you can find the 
synchronized file by doing either of the 
following:

TIP If Files doesn’t appear under Information 
Type, open the Tools menu and select 
Options. Make sure the Files box is checked.

DID YOU KNOW? The Documents on username’s 
Smartphone folder is created when you select 
the option to sync Files.
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• Press Start , select Programs, and 
then select Office Mobile . Select 
the application that opens the file: Word 
Mobile , Excel Mobile , or 
PowerPoint Mobile .

• Press Start , select Programs, and 
then select File Explorer . Tap the 
Show list in the upper-left and select 
My Device > My Documents.

Word Mobile

You can create and edit documents and 
templates and save them as DOC, RTF, 
TXT, and DOT files. You can also edit 
Microsoft Office Word documents and 
templates that you create on your 
computer. However, keep in mind that 
some of the information and formatting 
may be lost when you save the document 
on your smartphone.

The following features are not supported in 
Word Mobile:

• Backgrounds.

• Bidirectional text.

• Document protection.

• Metafiles.

• Artistic page borders. Lined page 
borders are supported.

• Password-protected files. Remove 
password protection on your computer 
before opening the file on your 
smartphone.

• Shapes and text boxes.

• Smart tags.

The following features are partially 
supported in Word Mobile:

Picture bullets. Regular bullets are 
supported.

Revision marks. Documents appear as 
though all revisions were accepted; if the 
document is saved, revision marks are lost.

Table styles. Some or all of the 
formatting is lost if the document is saved.

DID YOU KNOW? If you have a PDF file (.pdf), you 
can view the file using PDF Viewer. Press 
Start, select Programs, and then select PDF 

Viewer (see PDF Viewer).
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Underline styles. Unsupported styles 
are mapped to one of the four supported 
styles: regular, dotted, wavy, or thick/bold/
wide.

Legacy Pocket Word files. You can open 
PSW files, but if you edit a file, you need to 
save it in DOC, RTF, TXT, or DOT format.

The following features are not supported 
on your smartphone, but they remain in the 
file so that when you open the file on your 
computer, they appear as expected: 

Fonts and font sizes. Original fonts are 
listed on your smartphone and are mapped 
to the closest font available.

Footnotes, endnotes, headers, and 

footers.

Lists. Indented lists are mapped to the 
closest indentation level supported by 
Word Mobile.

Page breaks. Although not displayed, all 
page breaks, except a break placed at the 
end of a document, are retained in the 
document.

Creating a document

1 Press Start  and select Programs.

2 Select Office Mobile .

3 Select Word Mobile .

4 The first time you open Word Mobile, a 
new document opens. Otherwise, 
press New  (left action key). 

5 Enter the text of the document.

6 Press OK  to save the file. When you 
save a new document, it is 
automatically named after the first 
several words in the file.

Opening an existing document

1 Press Start  and select Programs.

2 Select Office Mobile .

3 Select Word Mobile .

4 In the document list, select the 
document you want to open.

TIP To zoom in or out, press View, select 
Zoom, and then select the zoom level.
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Creating a document from a template

1 Go to the documents list.

2 Tap the Show list in the upper-left and 
select Templates. If you don’t see 
Templates in the Show list, select More 

Folders to access this folder.

3 Open the template you want to use.

4 Press Menu  (right action key) 
and select File > Save As.

5 Select Name and enter a new name for 
the file.

6 Select the Folder list, and then select 
the folder where you want to save the 
file.

7 Select the Type list, and then select the 
format in which you want to save the 
file.

8 Select the Location list, and then select 
Main Memory or Storage Card.

9 Select Save.

Finding or replacing text in a document

1 Open the document containing the text 
you want to find.

2 Press Menu  (right action key) 
and select Edit > Find/Replace.

3 Select Find what and enter the text you 
want to find.

4 (Optional) Check the Match case box to 
find text that matches the capitalization 
in the text you entered step 3.

5 (Optional) Check the Match whole 

words only box to find only full words 
that match the text you entered in 
step 3.

6 Select Find to locate the first instance 
of the text you entered in step 3, or 
select Replace and enter the 
replacement text.

7 Select Next to find the next instance of 
the text, or select Replace to replace it. 
To replace all instances of the text, 
select Replace All.

8 When you see a message that the 
search is done, press OK .

TIP To create a new template, open the 
document you want to save as a template. 
Press Menu (right action key) and select File 

> Rename/Move. Select Name and enter a 
name for the template. Select Folder, and 
then select Template. Press OK.
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Moving or copying text

1 Open the document containing the text 
you want to move or copy.

2 Highlight the text you want to move or 
copy.

3 Press Menu  (right action key) 
and select Copy to copy the text, or 
select Cut to move the text.

4 Open the document where you want to 
insert the text and position the cursor 
where you want the text to appear.

5 Press Menu  (right action key) 
and select Paste.

Saving a copy of a document

NOTE If a document was previously saved 
on a computer, any unsupported formatting 
may be lost when you save the file.

1 Open the document you want to copy.

2 Press Menu  (right action key) 
and select File > Save As.

3 Select Name and enter a new name for 
the file.

4 Select the Folder list, and then select 
the folder where you want to save the 
file.

5 Select the Type list, and then select the 
format in which you want to save the 
file.

6 Select the Location list, and then select 
whether you want to store the file on 
your smartphone (Main memory) or on 
an expansion card (Storage card).

7 Select Save.

Formatting text

1 Open the document you want to 
format.

2 Highlight the text you want to format.

3 Press Menu  (right action key) 
and select Format > Font.

4 Set any of the following options for the 
highlighted text:

Font: Specifies the typeface.

Font color: Specifies the color.

Size: Specifies the point size. 

Bold: Indicates whether the text 
appears normal or thick. 
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Italics: Indicates whether the text 
appears upright or slanted.

Underline: Indicates whether the text 
appears with an underscore.

Highlight: Indicates whether the text 
appears with a yellow highlight.

Strikethrough: Indicates whether the 
text appears with a line through it.

5 Press OK  to return to the document.

Formatting paragraphs and lists

1 Open the document you want to 
format.

2 Position the cursor in the paragraph you 
want to format.

3 Press Menu  (right action key) 
and select Format > Paragraph.

4 Set any of the following options:

Alignment: Aligns the text paragraph 
with the left, right, or center of 
the page.

List: Creates a bulleted or numbered 
list.

Indentation: Changes the paragraph 
margins.

• Left: Sets the left margin for the 
entire paragraph.

• Right: Sets the right margin for the 
entire paragraph.

• Special: Lets you indent the first line 
or set a hanging indent.

• By: Sets the size of the special 
indentation.

5 Press OK  to return to the document.

Checking spelling in a document

1 Open the document you want to check.

2 Press Menu  (right action key) and 
select Tools > Spelling. To check the 
spelling of specific text, highlight it 
before you select the Spelling 
command.

3 If an unknown or misspelled word is 
encountered, do one of the following:

TIP You can also use the Formatting toolbar to 
create a list and to align text. To indent text in 
lists, you must use the Formatting toolbar. 
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• Select the correct word in the list if 
the word is spelled incorrectly.

• Select Ignore if the word is spelled 
correctly.

• Select Add to add a new word to the 
spelling dictionary.

Organizing your documents

You can rename your documents, move 
your documents to another folder, and 
move your documents between your 
smartphone and an expansion card.

1 Go to the documents list.

2 Highlight a file.

3 Press Menu  (right action key) 
and select Rename/Move.

4 Select Name and enter a new name for 
the document.

5 Select the Folder list, and then select 
the folder to which you want to move 
the document.

6 Select the Location list, and then select 
Main memory or Storage card.

7 Press OK .

Deleting a document

1 Go to the documents list.

2 Highlight the document you want to 
delete.

3 Press Menu  (right action key) 
and select Delete.

4 Select Yes to confirm the deletion.

Customizing Word Mobile

1 Go to the document list.

2 Press Menu  (right action key) 
and select Tools > Options.

3 Set any of the following options:

Default template: Sets the default 
template for new documents.

Save to: Sets the default location 
where new documents are stored.

TIP To create a new folder, go to the 
documents list, tap the Show list in the 
upper-left and select Add/Delete. Select 
New, enter a name for the folder, and then 
press OK.

TIP When you go to a folder, you can easily 
search your documents by sorting by type.
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Display in list view: Sets the types of 
files that appear in the documents list.

4 Press OK .

PowerPoint Mobile

With PowerPoint Mobile, you can open and 
view slide show presentations created on 
your computer. Many presentation 
elements such as slide transitions, 
animations, and URL links are also 
supported. Microsoft Office PowerPoint® 
features not supported on your 
smartphone include the following: 

• Notes written for slides 

• Rearrangement or editing of slides

• Files created in PPT format earlier than 
Microsoft PowerPoint 97

• HTML files in HTM and MHT formats

Playing a presentation

NOTE If a presentation is set up as a timed 
slide show, the slides advance 
automatically. Presentations pause during 
zooming.

1 Press Start  and select Programs.

2 Select Office Mobile .

3 Select PowerPoint Mobile .

4 In the presentation list, highlight the 
presentation you want to play.

5 Press Center .

6 Do any of the following:

• Press Right  to advance to the next 
slide or Left  to view the previous 
slide.

• Press Menu  (right action key), 
select Go to Slide, and then select 
the slide you want to view.

• Select Next or Previous to play 
animations.

• Press Menu  (right action key), 
select Zoom In, and then select  to 
zoom in or  to zoom out. To scroll 
within the current slide, tap and drag 
the slide. To return to the slide show, 
select .

• Press Menu  (right action key) 
and select End Show.
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Setting presentation playback options

1 Open the presentation for which you 
want to change the settings.

2 Press Menu  (right action key) 
and select Set up show.

3 On the Orientation tab, select the 
orientation you want. To select the 
orientation that best fits your 
smartphone screen, select Default.

4 Select the Playback tab, and check the 
Override playback options for all files 
box.

5 Set any of the following options:

Show without animation: Turns off 
builds and other animations.

Show without slide transition: Turns 
off transition effects between slides.

Use timings, if present: Enables the 
timings recorded with each slide in a 
presentation. If a presentation is set up 
as a timed slide show, the slides 
advance automatically. Presentations 
pause during zooming.

Loop continuously: Advances to the 
first slide after playing the last slide in a 
presentation.

6 Press OK .

Excel Mobile

With Excel Mobile you can create and edit 
workbooks and templates on your 
smartphone. You can also edit workbooks 
and templates that you create on your 
computer. However, keep in mind that you 
may lose some of the information and 
formatting when you save the workbook on 
your smartphone.

Note the following formatting 
considerations:

Alignment: Vertical text appears 
horizontal.

Borders: Appear as a single line.

Cell patterns: Patterns applied to cells are 
removed.

TIP To turn the presentation into a continuously 
looping slide show, check both the Use slide 

timings, if present, and the Loop 

continuously boxes.
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Fonts and font sizes: The original font is 
listed on your smartphone and mapped to 
the closest font available. Original 
fonts reappear on your computer.

Number formats: Microsoft Office Excel® 
97 conditional formatting is displayed in 
Number format.

Formulas and functions: Unsupported 
functions are removed, and only the 
returned value of the function appears. 
Formulas containing the following are also 
converted to values:

• An array or array argument, for example, 
=SUM({1;2;3;4})

• External link references or an 
intersection range reference

• References past row 16384 are 
replaced with #REF!

Protection settings: Most protection 
features are disabled but not removed. 
However, password protection is removed. 
You must remove the password protection 
in Microsoft Office Excel on your computer 
before opening the file on your 
smartphone.

Zoom settings: Worksheet-specific zoom 
settings are not retained. The zoom setting 
applies to the entire workbook.

Worksheet names: Names that refer to 
other workbooks, arrays, array formulas, or 
intersection ranges are removed from the 
name list, causing those formulas to be 
resolved as “#NAME?” All hidden names 
are not hidden.

AutoFilter Settings: AutoFilters that cause 
rows to be hidden are supported. Use the 
Unhide command to display hidden rows. 
Other AutoFilters are removed, but you can 
use the AutoFilter command in Excel 
Mobile to perform similar functions.

Chart Formatting: All charts are saved as 
they appear in Excel Mobile. Unsupported 
chart types are changed to one of these 
supported types: Column, Bar, Line, Pie, 
Scatter, and Area. Background colors, 
gridlines, data labels, trend lines, shadows, 
3D effects, secondary axes, and 
logarithmic scales are turned off.

The following features aren’t supported in 
Excel Mobile and are removed or modified 
when you open a workbook on your 
smartphone:
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• Hidden, dialog, and macro sheets

• VBA modules

• Text boxes

• Drawing objects and pictures

• Lists

• Conditional formats and controls

• Pivot table data (converted to values)

Creating a workbook

1 Press Start  and select Programs.

2 Select Office Mobile .

3 Select Excel Mobile .

4 The first time you open Excel Mobile, a 
new workbook appears. Otherwise, 
press New  (left action key).

5 Highlight a cell where you want to enter 
text or other info.

6 Enter the info in the cell, and then press 
Enter .

7 Repeat steps 4 and 5 to enter the 
remaining info.

8 Press OK  to save the file. When you 
save a new workbook, it is automatically 
named and placed in the workbook list.

Creating a workbook from a template

1 Go to the workbook list.

2 Tap the Show list in the upper-left and 
select Templates. If you don’t see 
Templates in the Show list, select More 

Folders to access this folder.

3 Open the template you want to use.

4 Press Menu  (right action key) 
and select File > Save As.

5 Select Name and enter a new name for 
the workbook.

6 Select the Folder list, and then select 
the folder where you want to save the 
workbook.

7 Select the Type list, and then select the 
format in which you want to save the 
workbook.

8 Select Save.

TIP To create a new template, highlight the 
workbook you want to save as a template. 
Press Menu (right action key), select 
Rename/Move, select Name, and then enter 
a name for the template. Select the Folder list 
and select Templates. Press OK.
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Viewing a workbook

1 Press Start  and select Programs.

2 Select Office Mobile .

3 Select Excel Mobile .

4 In the workbook list, select the 
workbook you want to view.

5 Press View  (left action key) and 
select any of the following:

Full Screen: Shows as much data as 
possible on the screen. To return to the 
normal view, select Restore in the 
upper-right.

Zoom: Sets the magnification level so 
that you can easily read the worksheet.

Sheet: Lets you switch to a different 
worksheet.

Split: Divides the window into two 
scrollable areas. To move the split bar, 
tap and drag it. To remove the split bar, 
select View > Remove Split.

Freeze Panes: Locks rows and columns 
so they remain visible while you scroll. 
Highlight the cell at the point at which 
you want to lock before you select this 
command. To unlock the rows or 
columns, select View > Unfreeze 

Panes.

Toolbar: Indicates whether the toolbar 
appears onscreen.

Status Bar: Indicates whether the 
status bar appears onscreen.

Show: Indicates whether headings and 
scroll bars appear onscreen.

Calculating a sum

1 Press View  (left action key) and 
select Toolbar.

2 Highlight the cell where you want to 
insert the sum.

3 Select . 

DID YOU KNOW? You can also switch worksheets 
by selecting the sheet list at the bottom of the 
screen.

TIP To jump to a cell or region, press Menu and 
select Edit > Go To. Select Cell reference or 

name and enter the target cell info or select 
Current region. Select OK.
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4 Tap and drag the stylus across the cells 
you want to add. 

5 Press Enter .

Entering a formula

1 Highlight the cell where you want to 
enter the formula.

2 Enter equals sign ( = ) followed by any 
values, cell references, name 
references, operators, and functions.

Examples:

• =(B4/25)+100

• =Revenue-Expenses

3 Press Enter . 

Referring to a cell or range in a formula

1 Open the workbook where you want to 
refer to a cell or range in a formula.

2 Begin entering a formula in a cell.

3 Select the cell, or select an entire range 
to set the reference.

4 Finish entering the formula and press 
OK .

Inserting a function

1 Open the workbook where you want to 
insert the function.

2 Press Menu  (right action key) 
and select Insert > Function.

TIP For simple calculations, use the Calculator 
(see Calculator). 

TIP To insert a symbol, place the cursor where 
you want the symbol. Press Menu and select 
Insert > Symbol. Highlight the symbol you 
want to insert, and select Insert.

TIP To refer to a cell from another worksheet in 
your formula, enter the worksheet name 
followed by an exclamation point (!) and the 
cell, range, or name reference. 
Example: =Sheet1!Earnings

TIP To create a 3-D reference in your formula, 
specify two or more sheets in a workbook; 
use a colon between the first and last 
worksheet names.
Example: =SUM(Sheet2:Sheet6!$A$2:$C$5)
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3 Select the Category list, and then 
select the type of function you want to 
insert.

4 Select the Function list, and then select 
the specific function you want to insert.

5 Select OK.

Entering a sequence automatically

1 Highlight both the cells containing the 
info you want to automate and the 
adjacent destination cells.

2 Press Menu  (right action key) 
and select Edit > Fill.

3 Select the Direction list, and then 
select the direction you want to 
populate.

4 Select the Fill type list, and then 
select Series.

5 Select the Series type list, and then 
select the type of series you want. If 
you select Date or Number, enter a 
Step value increment.

6 Select OK.

Adding cells, rows, and columns

1 Open the workbook you want.

2 Highlight the area where you want to 
insert elements.

3 Press Menu  (right action key) 
and select Insert > Cells.

4 Select how you want to insert the 
elements:

Shift cells right: Inserts the same 
number of new cells as the number of 
cells you highlighted horizontally in step 
2—for example, if you selected an area 

TIP Select Autofill as the series type to quickly 
fill cells with repetitive data such as numbers 
or repeated text. Autofill takes the content of 
the first cell in the highlighted row or column 
and copies it down or across the rest of the 
selection.
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containing two cells horizontally (say, A1 
and B1), selecting Shift cells right 
inserts two horizontal cells; so the 
original A1 and B1 (and their contents) 
are now C1 and D1. The highlighted area 
and all cells on the right move the same 
number of columns—two in this 
example—to the right.

Shift cells down: Inserts the same 
number of new cells as the number of 
cells you highlighted vertically in step 
2—for example, if you selected an area 
containing two cells vertically (say, A1 
and A2), selecting Shift cells down 
inserts two vertical cells; so the original 
A1 and A2 (and their contents) are now 
A3 and A4. The highlighted area and all 
cells below it move the same number of 
rows—two in this example—down.

Entire row: Inserts the same number of 
new rows as the number of cells you 
highlighted vertically in step 2—for 
example, if you selected an area 
containing two cells vertically (say A1 
and A2), selecting Entire row inserts 
two rows; so the original rows 1 and 2 
(and their contents) are now rows 3 and 
4. The rows containing the highlighted 

area and all rows beneath it move the 
same number of rows—two in this 
example—down.

Entire column: Inserts the same 
number of new columns as the number 
of cells you highlighted horizontally in 
step 2—for example, if you selected an 
area containing two cells horizontally 
(say, A1 and B1), selecting Entire 
column inserts two columns; so the 
original columns A and B (and their 
contents) are now columns C and D. 
The columns containing the highlighted 
area and all columns on the right move 
the same number of columns—two in 
this example—to the right.

5 Select OK.

TIP To add a new worksheet, press Menu and 
select Format > Modify Sheets. Select 
Insert, enter a name for the worksheet, and 
then press OK. To change the order of the 
worksheets, highlight a worksheet you want 
to move, select Move Up or Move Down, 
and then press OK.
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Formatting cells

1 Open the workbook you want to format.

2 Highlight the cells you want to format.

3 Press Menu  (right action key) 
and select Format > Cells.

4 Select any of the following tabs:

Size: Sets the row height and column 
width.

Number: Sets the type of information 
the cells contain.

Align: Sets whether text wraps within 
the highlighted cells, and sets horizontal 
and vertical alignment position.

Font: Sets the typeface, color, size, and 
style attributes.

Borders: Turns borders on and off for 
various cell edges, and sets the border 
and background colors.

5 Press OK .

Formatting rows and columns

1 Open the workbook you want to format.

2 Highlight the rows or columns you want 
to format.

3 Press Menu  (right action key) 
and select Format > Row or Format > 
Column.

4 Select any of the following:

AutoFit: Adjusts the size of the 
highlighted rows or columns to their 
contents.

Hide: Hides the highlighted rows or 
columns.

Unhide: Displays hidden rows or 
columns in the highlighted area.

TIP To name the highlighted cell or range of 
cells, press Menu and select Insert > Define 

Name. Enter the name and select Add. Press 
OK.

DID YOU KNOW? You can adjust the column and 
row size by tapping and dragging the right 
edge of the column or the bottom edge of the 
row. To automatically fit rows and columns to 
their contents, double-tap the lower edge of 
the row heading or the right edge of the 
column heading.
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Renaming a worksheet

1 Open the workbook containing the 
worksheet you want to rename.

2 Press Menu  (right action key) 
and select Format > Modify Sheets.

3 In the Sheets list, highlight the 
worksheet you want to rename.

4 Select Rename, enter a new name for 
the worksheet, and then press OK  
twice.

Sorting info in a worksheet

1 Highlight the cells you want to sort.

2 Press Menu  (right action key) 
and select Tools > Sort.

3 Select the Sort by list, and then select 
the primary sort column.

4 Check the Ascending box to sort in 
ascending order. Leave the box 
unchecked to sort in descending order.

5 (Optional) Select the Then by lists, and 
then select second- and third-level 
sorting options.

6 Check or uncheck the Exclude header 

row from sort box to indicate whether 
you want to sort the header row.

7 Select OK.

Filtering info in a worksheet

1 Highlight the cells that contain the info 
you want to filter.

2 Press Menu  (right action key) 
and select Tools > AutoFilter. A list 
appears at the top of each related 
column.

3 Select one of the new lists, and then 
select a filter. This hides all rows that do 
not include the selected filter.

4 (Optional) Do any of the following:

• Select the other lists, and select other 
filters.

• To display all rows again, select the 
filter lists, and select All. 

• To turn off filtering, press Menu and 
select Tools > AutoFilter again.

DID YOU KNOW? You can also create custom filters 
where you specify comparisons. Select the 
filter lists, and then select Custom.
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Creating a chart

1 Open the workbook in which you want 
to create a chart.

2 Highlight the cells you want to include 
in the chart.

3 Press Menu  (right action key) 
and select Insert > Chart.

4 Select the type of chart, and then press 
Next  (right action key).

5 Confirm the area you want the chart to 
include, and then press Next  
(right action key).

6 Select the data layout, and then press 
Next  (right action key).

7 Check the boxes to indicate whether 
the first row and column represent 
labels.

8 Select whether you want the chart to 
appear as a separate worksheet within 
the current workbook, or as part of the 
current worksheet.

9 Press Finish  (right action key).

Formatting or changing a chart

1 Open the workbook that contains the 
chart you want to format.

2 Open the chart.

3 Press Menu  (right action key) 
and select Format > Chart.

4 Select any of the following tabs:

Titles: Specifies the title of the chart 
and headings, whether a legend 
appears, and the placement of the 
legend.

Scale: Specifies the minimum and 
maximum scales for charts with x and y 
axes.

Type: Specifies the chart style. You can 
use this setting to convert your chart to 
a different format.

Series: Lets you add, modify, format, or 
delete related data points without 
affecting the info in your worksheet.

5 Press OK .

Finding or replacing info in a workbook

1 Open the workbook containing the info 
you want to find.

2 Press Menu  (right action key) 
and select Edit > Find/Replace.
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3 Select Find what and enter the info you 
want to find.

4 (Optional) Check the Match case box to 
find text that matches the capitalization 
in any text you entered in step 3.

5 (Optional) Check the Match whole 

words only box to find only full words 
that match any text you entered in 
step 3.

6 Select Find to locate the first instance 
of the info you entered in step 3, or 
select Replace and enter the 
replacement info.

7 Select Next to find the next instance of 
the info, or select Replace to replace it. 
To replace all instances of the info, 
select Replace All.

8 When you see a message that Excel 
Mobile is done searching, press OK .

Organizing your workbooks

You can rename your workbooks. You can 
also move them to another folder or move 
them between your smartphone and an 
expansion card.

1 Go to the workbook list.

2 Select a file.

3 Press Menu  (right action key) 
and select File > Rename/Move.

4 Select Name and enter a new name for 
the workbook.

5 Select the Folder list, and then select 
the folder to which you want to move 
the workbook.

6 Select the Location list, and then select 
Main memory or Storage card.

7 Press OK .

Deleting cells, rows, and columns

1 Open the workbook containing the 
elements you want to delete.

2 Highlight the area you want to delete.

3 Press Menu  (right action key) 
and select Edit > Delete Cells.

4 Select how you want to remove the 
elements:

Shift cells left: Deletes the highlighted 
cells and moves all cells on their right to 
the left.

TIP When you go to a folder, you can easily 
search your files by sorting by type. 
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Shift cells up: Deletes the highlighted 
cells and moves all cells below them up.

Entire row: Deletes the entire row(s) in 
which the highlighted cells are located, 
and moves all rows below up. 

Entire column: Deletes the entire 
column(s) in which the highlighted cells 
are located, and moves all columns on 
their right to the left.

NOTE Excel Mobile adjusts formulas to 
reflect the new cell locations. However, a 
formula that refers to a deleted cell 
displays the #REF! error value.

5 Select OK.

Customizing Excel Mobile

1 Go to the workbook list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Template for new workbook: 
Specifies the default template for new 
workbooks.

Save new workbooks to: Specifies 
where new workbooks are stored.

Files to display in list view: Specifies 
which types of files appear in the 
workbook list.

4 Press OK .

PDF Viewer

Picsel PDF Viewer lets you view PDF files 
whether they are saved to your 
smartphone, attached to email messages, 
stored on an expansion card inserted into 
your smartphone’s expansion card slot, or 
downloaded from the web. You can 
customize the document display.

TIP To delete a workbook, go to the workbook 
list and highlight the workbook you want to 
delete. Press Menu (right action key) and 
select Delete. Select Yes to confirm.

TIP To delete a worksheet, press Menu (right 
action key) and select Format > Modify 

Sheets. Highlight the worksheet you want to 
delete, and then select Delete. Select Yes and 
press OK.
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Opening a file

1 Press Start  and select Programs.

2 Select PDF Viewer .

3 Select the Folder list, and then select 
the folder containing the file you want 
to open. If you’re not sure which folder 
the file is in, select All Folders.

4 Select the Type list, and then select the 
type of file you want to open.

5 Select the file you want.

6 (Optional) Optimize your viewing of the 
file by doing any of the following:

• To switch between zoom mode and 
pan mode, press Center .

• In zoom mode, to zoom in and out 
while viewing the PDF file, press 
Up , or Down .

• In pan mode, to pan the display in a 
given direction, press Right , 
Left , Up , or Down .

• To rotate the displayed page, press 
Menu  (right action key) and 
select Page > Rotate.

TIP Select the Name, Folder, or Date column 
heading to sort the displayed files by that 
heading. This can help you find the file you 
want more quickly.

TIP To close the Open screen without making a 
selection, select Cancel.

TIP To see which mode you are in, press Show 

Mode (left action key) to display the mode 
icon. Press Hide Mode (left action key) to hide 
the mode icon.

TIP To open a file you have recently opened, 
open PDF Viewer, press Menu (right action 
key), and then select Recent > [the name of 

the file you want].
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Moving around in PDF files

To move around within a PDF file, do either 
of the following:

• To go to the next or previous page in the 
file, press Menu  (right action 
key) and select Page > Next Page or 
Page > Previous Page.

• To go to the first or last page in the file, 
press Menu  (right action key) 
and select Page > First page or Page > 
Last page.

Customizing the display

You can choose between two views for 
displaying PDF files. You can also hide the 
toolbar to view the file on the full screen.

1 Press Menu  (right action key) 
and select Page.

2 Select one of the following options:

Fit to width: Resizes the file so that the 
width of the file matches the width of 
the screen; you may need to scroll up or 
down to view the entire document.

Fit to page: Resizes the file so that the 
entire file—both width and height—fits 
on one screen.

Customizing PDF Viewer

1 Press Menu  (right action key) 
and select Settings.

2 Select any of the following options:

Clear History: Deletes all files from the 
Recent list (see Opening a file).

Files: Specifies which file types can be 
opened with PDF Viewer.

About: Contains information on the PDF 
Viewer application.



Y O U R  M I C R O S O F T  O F F I C E  A N D  O T H E R  D O C U M E N T  T O O L S

P D F  V I E W E R214

11
C

H
A

P
T

E
R



CHAPTER

12

Your application and info 
management tools
Your Palm® Treo™ 800W smartphone comes equipped with a 
variety of tools for managing and organizing your information. 
Get the most out of your smartphone: Install some of the 
thousands of business, education, or leisure-time applications 
available. After you use your smartphone to create or capture 
important business and personal information, use one of 
several options to share the info with others. Insert expansion 
cards (sold separately) for a compact and limitless answer to 
the storage dilemma. And because there’s one on your 
smartphone, you never need to carry a separate calculator.

Benefits

• Locate info in any application

• Install applications, games, and 
other software

• Keep others up-to-date with 
meaningful business and personal 
information

• Store, carry, and exchange info

• Always have a calculator with you
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Finding information

Quickly find who or what you’re looking for 
by using one of these search features:

• Lookup: Find and dial your contacts by 
name or phone number. See Dialing by 
contact name for details.

• Search: Look through the text in all the 
applications on your smartphone.

• File Explorer: Browse through the files 
and folders on your smartphone or on 
an expansion card.

• Global Address List Lookup: Look up 
names in your online corporate address 
list.

• Email message search: Display only 
those messages whose senders, 
recipients, or subjects match the text 
you enter (see Finding messages).

Using Search

Search for files and other items stored in 
the My Documents folder on your 

smartphone or on an expansion card. You 
can search by file name or by words 
located in the item. For example, you can 
search for words within notes, 
appointments, contacts, and tasks.
 

1 Press Start  and select Programs.

2 Select Search .

3 Select Search for, and then enter the 
file name, word, or other info you want 
to find.

TIP For information on opening and closing 
apps, see Opening and closing applications.

DID YOU KNOW? Contacts on your SIM card do not 
appear in the search results list.

DID YOU KNOW? You can also open Search by 
pressing Option + left Shift.
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4 Select the Type list, and then select the 
kind of information you want to find.

5 Press Search  (left action key).

6 Use the 5-way to select and view an 
item from the results of the search. A 
storage card symbol appears next to the 
names of files that are located on an 
expansion card.

Exploring files and folders

You can use File Explorer to browse the 
contents of folders on your smartphone or 
on an expansion card. The root folder on 
your smartphone is named My Device. My 

Device is similar to My Computer 
(Windows XP) or Computer (Windows 
Vista) on your computer.

1 Press Start  and select Programs.

2 Select File Explorer .

3 Select the folder you want to explore. If 
the folder you want is not displayed, tap 
the Show list in the upper-left and 
select My Device to view all folders.

TIP If you’ve looked for an item before, select 
the Search for list, and then select the item in 
the list. 

TIP When two or more words are entered in 
the Search for field, the search results 
contains only items that contain all of the 
words.

TIP If you are searching for information in 
certain applications, such as Inbox or Word 
Mobile, select Advanced for more search 
options. 

Show list

Sort by 
list
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4 Do any of the following:

• To open an item, select it.

• To quickly delete, rename, beam, or 
email an item, highlight the item, 
press and hold Center  to open 
the shortcut menu, and then select 
the appropriate command.

• To move a file to another folder, 
highlight the item, press and hold 
Center  to open the shortcut 
menu, and select Cut or Copy. Open 
the destination folder, press and hold 
Center  to open the shortcut 
menu, and then select Paste.

• To highlight multiple items, tap and 
drag the stylus.

IMPORTANT Do not delete any files that 
you cannot identify. These files may be 

required for your smartphone to function 
properly.

Installing applications

Your smartphone comes with several 
built-in and ready-to-use applications. You 
can also install any of the additional 
software included on the Windows Mobile 
Getting Started CD as well as other 
third-party applications that are compatible 
with Microsoft Windows Mobile® 6 
Professional edition devices, such as 
business software, games, and more.

Applications you download to your 
computer are likely to be in a compressed 
format such as ZIP. If the file is 
compressed, you need to use a 
decompression utility on your computer, 
such as WinZip, to decompress the file 
before you install the application on your 
smartphone.

These instructions tell you how to install 
basic files onto your smartphone. Some 
software uses an installer or wizard to 
guide you through the process. For details, 

DID YOU KNOW? When the items in a folder are 
displayed, you can sort them by name, date, 
size, or type. Select the Sort by list in the 
upper-right, and then select the sort method.

TIP The storage card symbol appears next to 
the names of files that are stored on an 
expansion card.
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consult the documentation that came with 
the software.

Installing bonus software from the CD

The Windows Mobile Getting Started CD 
includes several bonus software 
applications that you can install on your 
smartphone. You can install these 
applications when you install the desktop 
software, or you can install them later.

1 Insert the Windows Mobile Getting 
Started CD into the CD drive on your 
computer.

2 Click Add Programs (Windows XP) or 
Bonus Software (Windows Vista).

3 Click the name of the application you 
want to install.

4 Click Install (on the right side of the 
screen).

5 (Optional) Repeat steps 3 and 4 to 
install additional applications.

6 Synchronize your smartphone with your 
computer to install the application(s) on 
your smartphone.

Installing third-party applications

When installing third-party applications, 
note the following:

• Install only apps that are designed for 
Microsoft Windows Mobile 6 
Professional. 

• Apps designed for Microsoft Windows 
Mobile 6 Standard or any edition of 
Windows Mobile 5.x software are not 
compatible with your smartphone.

• If you can try a free or trial version of 
the software before purchasing it, you 
can test it first to make sure it works 
properly.

NOTE If you encounter a problem with a 
third-party application (such as an error 
message), contact the application’s vendor. 
For general troubleshooting of third-party 
applications, see Third-party applications.

TIP If an application does not have a Microsoft 
Mobile to Market certificate, you see a 
message indicating that the application is 
untrusted. If this occurs, you can indicate 
whether you want to continue the installation.
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Installing applications from the Internet

You can use Internet Explorer Mobile to 
install Windows Mobile apps in the CAB 
file format directly from the Internet. For 
files in any other format except CAB, you 
must first download the files to your 
computer and then install them to your 
smartphone by synchronizing.

1 Make sure your phone is on and that 
you are in a coverage area (see Turning 
your phone on).

2 Press Start  and select Internet 

Explorer.

3 Go to the page that contains the link to 
the application you want to download.

4 Press Left  or Right  to highlight the 
link to the file, and then press Center 

 to start the download process.

5 When the download has finished, press 
Start  and select Programs.

6 Select File Explorer .

7 Go to the My Documents folder in File 
Explorer.

8 Tap the file you downloaded to start the 
installation program.

Installing applications from your 

computer

BEFORE YOU BEGIN To install an 
application from your computer to your 
smartphone, you must first install the 
desktop synchronization software on 
your computer (see Installing ActiveSync 
desktop software: Windows XP or 
Installing Windows Mobile Device Center: 
Windows Vista).

1 Open My Computer or Windows 

Explorer on your computer.

2 Double-click the icon representing your 
smartphone.

3 Copy the application file(s) into the 
folder.

4 Connect your smartphone to your 
computer to synchronize and install the 
application(s) on your smartphone.

DID YOU KNOW? You can purchase a third-party 
application that lets you run Palm OS® 
applications on your smartphone.
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Installing applications onto an expansion 

card

BEFORE YOU BEGIN To install an 
application from your computer to an 
expansion card, you must first install the 
desktop synchronization software on 
your computer (see Installing ActiveSync 
desktop software: Windows XP or 
Installing Windows Mobile Device Center: 
Windows Vista).

1 Insert the expansion card into the 
expansion card slot (see Inserting and 
removing expansion cards).

2 Connect your smartphone to your 
computer using the USB sync cable.

3 Open My Computer or Windows 

Explorer on your computer.

4 Double-click the icon representing your 
smartphone.

5 Navigate to the folder representing the 
expansion card.

6 Copy the application file(s) into the 
expansion card folder.

Removing 
applications

To free up memory on your smartphone, 
you can remove applications that you no 
longer use. You can remove only 
applications, patches, and extensions that 
you install; you cannot remove the built-in 
applications that reside in the Read-Only 
Memory (ROM) portion of your 
smartphone.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Remove Programs .

3 Highlight the application that you want 
to remove.
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4 Select Remove.

5 Select Yes to confirm the deletion.

Sharing information

Your smartphone comes equipped 
with a variety of options for sharing 
information, so that you can choose the 
quickest, most convenient way to send 
your info or to receive info from another 
device.

• When you have a file open in a program 
such as Notes or PowerPoint Mobile, 
you can easily share a file by selecting 
the Menu, and then selecting Send via 

E-Mail or Beam File.

• In Microsoft Outlook®, you can insert a 
picture or attach a note or other file to 
an email. You can also receive pictures 
and attachments (see Your email).

• You can attach a picture, video, or sound 
file to a multimedia message (see 
Creating and sending a multimedia 
message).

• You can synchronize to share info 
between your smartphone and your 
computer or between your smartphone 
and Microsoft Exchange Server 2003 or 
2007 (see Synchronizing information).

• If you are near someone, you can beam 
files and applications between your 
smartphone and your neighbor’s device 
using the IR port or Bluetooth® wireless 
technology (see Beaming information).

• You can also store files on an expansion 
card and share the expansion card (see 
Using expansion cards).

Beaming information

Your smartphone is equipped with an IR 
(infrared) port that enables you to beam 
information to another device with an IR 
port. The IR port is located on the side of 
your smartphone closest to the stylus, near 
the top. You can also beam using the 

DID YOU KNOW? Built-in applications that cannot be 
deleted are not listed in the Remove Programs 
list.
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built-in Bluetooth wireless technology on 
your smartphone.

The normal range for beaming with IR is 
about 20 centimeters (8 inches). The 
maximum range for beaming with 
Bluetooth technology is about 9 meters 
(30 feet). Performance and range are 
affected by physical obstacles, radio 
interference from nearby electronic 
equipment, and other factors.

By default, the beaming option on your 
smartphone is turned off. You need to turn 
the beam option on before you can beam 
using either the IR port or Bluetooth 
wireless technology.

Turning on the beam option

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Beam .

3 Check the Receive all incoming 

beams box.

Beaming an entry or file 

1 Highlight the entry or file you want to 
beam.

2 Press Menu  (right action key) 
and select Beam… (the menu item 
changes names based on the type of 
item you highlighted).

3 Do one of the following:

TIP For best results, the path between the two 
devices must be clear of obstacles, and both 
devices kept stationary. If you have difficulty 
beaming, shorten the distance and avoid 
bright sunlight.

DID YOU KNOW? The type of information you can 
beam depends on the type of device you are 
beaming to. Other Windows Mobile 6 
Professional devices are always compatible 
with your Treo 800W smartphone.
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Bluetooth: When the name of the 
receiving device appears, select Tap to 

send to begin the transfer. A blue icon 
indicates a Bluetooth connection.

IR: Point the IR port on your smartphone 
directly at the IR port of the receiving 
device. A red icon indicates an IR 
connection.

4 Wait for Done to appear next to the 
name of the receiving device before you 
continue using your smartphone.

Receiving beamed information

1 Turn on your screen if it is not already 
on.

2 If you are beaming over an IR 
connection, point the IR port on your 
smartphone directly at the IR port of the 
transmitting device.

3 When the Receiving Data message 
appears, select Yes to receive the 
beam.

Using expansion 
cards

The expansion card slot on your 
smartphone enables you to add miniSD 
cards to extend the storage capacity of 

TIP The regional setting determines the list of 
characters that can be used when info is 
beamed between devices. If you try to send 
or receive a character that is not on the list, it 
appears as a question mark (see Setting 
display formats).

TIP If you can’t receive beamed info, press 
Start and select Settings. Select the 
Connections tab, and then select Beam. 
Make sure the Receive all incoming beams 
box is checked. If you still can’t receive info, 
try a soft reset (see Resetting your 
smartphone).
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your smartphone. For example, miniSD 
expansion cards can store the following:

Expansion cards are sold separately.

Inserting and removing expansion cards

1 Open the expansion card slot door by 
sliding your fingernail or another thin 
object into the notch.

2 Hold your smartphone with the screen 
facing you and hold the card with the 
label facing you. The notch on the card 
should be toward the bottom of your 
smartphone.

3 Insert the card into the expansion card 
slot until you feel it lock into place and 
you hear the confirmation tone.

• Pictures 
• Videos

• Games
• Applications

• MP3 audio files
• Email attachments

• Databases

TIP We recommend that you purchase 
preformatted expansion cards. To format a 
card on your own, you need to connect a card 
reader (sold separately) to your computer.

Notch
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4 To remove an expansion card, press in 
and release the card.

5 After you feel the expansion card slot 
eject the card, remove the card 
from the slot.
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Opening applications on an expansion 

card

After you insert an expansion card into the 
expansion card slot, you can open any of 
the applications stored on the expansion 
card.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Tap the Show list in the upper-left and 
select Storage Card.

5 Select the application you want to open.

Saving files to an expansion card

You can save space on your smartphone by 
saving files to an expansion card. For 
example, when you create new Word 
Mobile documents, notes, Excel Mobile 
workbooks, pictures, videos, and audio 
files, you can save them directly to an 
expansion card. Saving files to an 
expansion card also makes it easy to share 
those files with others. (Some applications 
may not support this feature.)

TIP To run an application on an expansion card, 
your smartphone must have enough free 
space in the internal memory to run the 
application.

Show list
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1 Insert an expansion card into the 
expansion card slot.

2 Open the application from which you 
want to save the info.

3 Press Menu  (right action key) 
and select Options.

4 Select the option for where to save info, 
and then select Storage Card. The 
option name changes depending on the 
application you are in.

5 Press OK .

Moving info between your smartphone 

and an expansion card

1 Insert an expansion card into the 
expansion card slot. 

2 Open the application from which you 
want to move the info.

3 Go to the list view, tap the Show list in 
the upper-left, and select the file or 
application you want to move.

4 Press Menu  (right action key) 
and select Rename/Move.

5 Select the Location list, and then select 
where you want to move the info: 
Storage Card or Main Memory.

6 Press OK .

Copying or moving applications and files 

between your smartphone and an 

expansion card

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Select the file or application you want to 
copy or move (see Exploring files and 
folders).

5 Press Menu  (right action key) 
and select Edit > Copy or Edit > Cut.

6 Go to the folder where you want to 
place the selected item.

TIP If you don’t see a Save to option on the 
Options screen, look on the other tabs (if 
present). If you still can’t find a Save to list, the 
application may not support this feature.

TIP Your applications are usually located in the 
My Device/Program Files folder.
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7 Press Menu  (right action key) 
and select Edit > Paste.

8 Press OK .

Viewing available expansion card 

memory

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Settings.

3 Select the System tab, and then select 
Memory .

4 Select the Storage Card tab.

5 Press OK .

Exploring files on an expansion card

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Tap the Show list in the upper-left and 
select Storage Card.

5 Select the folder or files you want to 
view.

6 Press OK .

Renaming an expansion card

If you change the contents of an expansion 
card, you may at some point want to 
rename the card to better match its 
contents.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Tap the Show list in the upper-left and 
select My Device.

5 Highlight the current expansion card 
name (Storage Card by default).

6 Press Menu  (right action key) 
and select Rename.

7 Enter a new name for the card.

8 Press OK .

TIP Before copying information to or renaming 
the files or folders on an expansion card, or 
renaming the card itself, make sure the card is 
not write-protected. See the instructions that 
came with your card for details.
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Encrypting an expansion card

When you encrypt an expansion card, the 
info on the card can be read only by your 
smartphone—so no one can see what’s on 
the card if it gets lost or stolen.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Settings.

3 Select the System tab, and then select 
Encryption.

4 Check the Encrypt files placed on 

storage cards box.

NOTE If your organization enforces an 
encryption policy, you can see that the box 
is checked but cannot uncheck it.

Calculator

You can use Calculator for basic arithmetic 
calculations, such as addition, subtraction, 
multiplication, and division.

Performing calculations

1 Press Start  and select Programs.

2 Select Calculator .

3 Enter numbers and perform 
calculations, including the following:

 Clears the last digit in a multi-digit 
entry.
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 Clears the current calculation or the 
displayed number.

 Calculates the reciprocal of a 
number.

 Calculates percentage.

 Calculates the square root of a 
number.

 Switches a number between 
negative and positive.

Using the Calculator memory

• To store a displayed number, tap the box 
to the left of the entry box or press M. 
An M appears in the box.

• To add the displayed number to the 
number stored in memory, tap  or 
press P.

• To display the number stored in 
memory, tap  or press R. 

• To clear the memory, tap  or press L.

TIP You can paste numbers into Calculator as 
well as copy calculation results to be pasted 
into another app.

TIP For more advanced calculations, use Excel 
Mobile. See Excel Mobile for details.

DID YOU KNOW? When you store a number in 
memory, it replaces the number that is 
currently stored.
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Your personal settings
Customizing is optional. But why not personalize your Palm® 
Treo™ 800W smartphone to make it match your lifestyle and 
work even harder for you?

You can easily customize the sounds, fonts, screen colors, and 
more on your smartphone. Take advantage of various levels of 
security. Prevent making an accidental (and expensive) phone 
call by locking the keyboard. Some preference settings can help 
extend the life of your battery. There are lots of ways to make 
your smartphone work better for you.

Benefits

• Conserve power

• Secure your phone and your data

• Make your screen easy to read

• Streamline smartphone use
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Today screen settings

Selecting your Today screen background

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 On the Appearance tab, check the Use 

this picture as the background box.

4 Select Browse.

5 Select the picture you want to use.

6 Press OK .

Selecting which items appear on your 

Today screen

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 Select the Items tab.

4 Check the boxes next to the items you 
want to appear on your Today screen, 
and uncheck any items that you do not 
want to appear.

5 (Optional) Highlight an item and select 
Move Up or Move Down to change the 
order in which items appear on the 
Today screen.

6 (Optional) Highlight an item and select 
Options (if available) to configure the 
settings for the item. Press OK  to 
return to Today Settings.

TIP To change the color theme for your 
smartphone, select a new theme from the 
Appearance tab in Today Settings (see 
Changing the system color scheme). 
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7 Press OK .

Changing the clock format

You can change the format of the clock on 
the Today screen from digital to analog and 
back. If you select analog format, a clock 
icon  appears displaying the time.

1 Tap and hold the clock display with the 
stylus.

2 Select Analog or Digital.

System sound 
settings 

When you’re in a meeting, at the movies, 
or anywhere that silence is required, you 
can immediately silence all sounds on your 
smartphone, including Calendar 
notifications and system sounds. This does 
not mute the speaker during phone calls.

Silencing sounds

1 Slide the Ringer switch to Sound Off 
. The smartphone vibrates briefly.

2 To hear all sounds again, slide the 
Ringer switch to Sound On .

When you slide the Ringer switch back to 
the Sound On position, it restores the 
previous sound settings. For example, if 
the smartphone ring volume is set to the 
loudest setting and you slide the Ringer 
switch to Sound Off, you do not hear the 
smartphone ring. When you move the 
Ringer switch back to Sound On, the 
smartphone ring volume is still set to the 
loudest setting.

DID YOU KNOW? There are lots of third-party 
plug-ins available for your Today screen.

Sound OffSound On
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Selecting Sounds & Notifications

1 Press Start  and select Settings.

2 On the Personal tab, select Sounds & 

Notifications .

3 On the Sounds tab, set any of the 
following options:

Events: Turns sounds on/off for system 
warnings and error messages.

Programs: Turns sounds on/off in the 
applications on your smartphone.

Notifications: Turns alarms and 
reminders on/off in the applications on 
your smartphone.

Screen taps: Turns sounds associated 
with tapping the screen on/off, and sets 
the volume level when this sound is 
turned on.

Hardware buttons: Turns sounds 
associated with pressing buttons on/off, 
and sets the volume level when this 
sound is turned on.

4 Select the Notifications tab and set 
any of the following options:

TIP Can't get music to play out of the built-in 
MP3 player? Check the Ringer switch. If it’s 
set to Sound Off, you won’t be able to hear 
music. 

DID YOU KNOW? Your smartphone includes a silent 
alarm that can vibrate even when the Ringer 
switch is set to Sound Off. 

TIP To record, preview, delete, and send 
sounds, select the Manage tab. To record a 
sound, press Menu and select New Sound. 
To play a sound, select it and press Play (left 
action key). To delete a sound, highlight it and 
press Backspace. To send a sound, highlight 
it, press Menu, and select Send Sound.
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Event: Specifies the action for which 
you want to change the settings. The 
remaining options vary based on the 
event you select.

Play sound: Lets you turn the sound 
on/off for the selected event. To select a 
different sound, select the list to the 
right of this setting, and then select a 
different sound. To preview the sound, 
select Play Sound, and then select 
Play.

Repeat: Indicates whether the sound 
plays more than once, if turned on.

Display message on screen: Indicates 
whether a notification message appears 
onscreen for the selected event.

Vibrate: Indicates whether your 
smartphone vibrates to notify you about 
the selected event.

5 Press OK .

Display and 
appearance settings

Adjusting the brightness

1 Press Option  and then press . 

2 Press Left  and Right  to adjust the 
brightness.

3 Press OK .

Changing the text size and clarity

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 Select the Text Size tab.

4 Press Left  and Right  to adjust the 
text size.

5 Select the Clear Type tab.

6 To smooth the edges of screen fonts, 
check the Enable Clear Type box.
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7 Press OK .

Setting display formats

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Regional Settings .

3 On the Region tab, select a region from 
the list. The region selection sets the 
default format settings.

4 (Optional) Select any of the following 
tabs to customize the format settings:

Number: Sets the decimal symbol and 
number of decimal places, the digit 
grouping symbol and group size, list 
separators, negative number sign 
symbol and format, leading zero display, 

and measurement system (metric vs. 
U.S.).

Currency: Sets the currency symbol 
and position, the decimal symbol and 
position, digit grouping symbol and 
group size, and negative number 
format.

Time: Sets the time style, separators, 
and AM and PM symbols.

Date: Sets the short date style, 
separators, and long date style.

5 Press OK .

Aligning the screen to correct tapping 

problems

Occasionally, your screen may need to be 
readjusted. You know your screen needs 
adjustment when the wrong feature is 
activated when you tap the screen. To fix 
the problem, align the screen.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 On the General tab, select Align 

Screen. 
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4 Tap the screen where indicated.

5 Press OK .

Changing the system color scheme

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 On the Appearance tab, select a theme 
in the list.

4 Press OK .

Changing screen orientation

Landscape orientations are determined by 
which hand you would hold the stylus in.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 Select the General tab. 

4 Select an orientation:

• Portrait

• Landscape (right-handed)

• Landscape (left-handed)

5 Press OK .

Application settings

Arranging the Start menu

You can change the seven applications 
listed on the Start menu. You can still 
access the remaining applications by 
selecting Programs from the Start menu, 
and then selecting the application’s icon.

1 Press Start  and select Settings.

2 On the Personal tab, select Menus .

3 Check the boxes next to the 
applications you want to see in the Start 
menu.

TIP You can also set the background for your 
Today screen (see Selecting your Today 
screen background).
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4 Press OK .

Reassigning buttons

You can use Buttons Settings to select 
which applications to associate with many 
of the buttons and key combinations on 
your smartphone.

1 Press Start  and select Settings.

2 On the Personal tab, select 
Buttons .

3 On the Program Buttons tab, highlight 
the button or key combination you want 
to change in the Button list. The 
hardware buttons are mapped to the 
following items:

• Start  = Start menu

• OK  = OK/Close

• Option  + Phone/Send  = 
Messaging

• Option  + Start  = Calendar

• Option  + OK  = Task Manager

• Hold Side = Windows Media Player

4 Select the Assign a program list, and 
then select the application you want to 
assign to the button or key combination 
you selected in step 3.

5 Select the Up/Down Control tab and 
adjust the settings for the Up  and 
Down  buttons on the 5-way.

6 Press OK .

Setting up voice commands

IMPORTANT The Voice Command 
application is available only for English, 
French, and German.

TIP Don’t forget the six icons across the top of 
the Start menu. They’re the apps you opened 
most recently, and it’s easy to get back to 
them: just use the 5-way to select one of the 
icons.
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Voice commands enable you to use speech 
to execute some commands on the Start 
menu and the Programs screen.

1 Assign the Hold Side button to Voice 
Command. See Reassigning buttons for 
details.

2 Press Start  and select Settings.

3 On the Personal tab, select Voice 

Command.

4 Select Enabled.

5 Select the items you want to enable. If 
an item is highlighted and the Options 
button is active, select Options to 
choose the features you want enabled 
for the highlighted item.

6 Select Notifications and select the 
options for how you want to receive 
voice command notifications.

Using voice commands

IMPORTANT Do not use voice commands 
in your car until you read the End user 
notice about this kind of usage; see End 
user notice.

1 Set the Ringer switch at the top of your 
smartphone to Sound On .

2 Hold your device about nine inches 
(230mm) away from your mouth, and 
then press and release the assigned 
Voice Command button (see Setting up 
voice commands). A tone plays and a 
microphone icon appears at the top of 
your screen.

3 In a clear voice say the command. For 
example:

• To access Help, say “Help.” After 
Voice Command finishes speaking, a 
microphone icon appears at the top of 
your screen. Say your answer. For 
example, say “General” to access 
general Help topics.
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• To access your Calendar, say “Start 
Calendar.”

• To access your music, say “Start 
Windows Media.” After Voice 
Command finishes speaking, a 
microphone icon appears at the top of 
your screen. Say your answer.

Setting input options

1 Press Start  and select Settings.

2 On the Personal tab, select Input .

3 On the Input Method tab, set any of the 
following options:

NOTE The Input Method options you 
specify apply only to entering info using the 
screen. You can still enter info using your 
smartphone’s keyboard regardless of the 
onscreen input method you choose.

Input method: Specifies which 
onscreen input method you want to 
use:

• Block Recognizer: Use a single 
stroke to write letters, numbers, 
symbols, and punctuation, which are 
then converted into typed text. Use 
gestures to enter Return and 
Backspace.

• Keyboard: Tap keys on the onscreen 
keyboard to enter text.

TIP You can move quickly through voice 
commands by stopping the voice command 
response before it finishes. When Voice 
Command responds, you can press the Voice 

Command button before it completes the 
question. After the microphone icon is visible, 
you may say your answer.
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• Letter Recognizer: Write individual 
letters, numbers, and punctuation, 
which are converted into typed text.

Large/Small keys: If you selected 
Keyboard, select whether to use large 
or small onscreen keys. If you select 
Large keys, check the box if you want to 
use gestures for the space, backspace, 
shift, and enter keys.

Options: If you selected Letter 
Recognizer, select Options and select 
the options you want.

4 Select the Word Completion tab and 
set any of the following options:

Suggest words when entering text: 
Indicates whether word suggestions 
appear as you enter text. You can also 

specify how many letters you want to 
enter before a suggestion appears, how 
many suggestions you want to see, and 
whether a space appears after you 
insert a suggested word.

Clear Stored Entries: Deletes the 
database of word suggestions.

Enable Auto Correct: Indicates 
whether common misspellings such as 
“teh” are corrected automatically.

5 Select the Options tab and set any of 
the following options:

TIP To enter a suggested word, press Down to 
highlight the suggestion, and then press 
Center to accept it. 



Y O U R  P E R S O N A L  S E T T I N G S

L O C K I N G  Y O U R  S M A R T P H O N E  A N D  I N F O 245

13

C
H

A
P

T
E

R

Voice recording format: Specifies the 
format in which you save voice notes.

Default zoom level for writing: 
Specifies the initial size of text entered 
from onscreen writing methods.

Default zoom level for typing: 
Specifies the initial size of text entered 
using the keyboard.

Capitalize first letter of sentence: 
Specifies whether the first letter of a 
sentence automatically appears in 
uppercase, without requiring you to 
press a Shift key.

Scroll upon reaching the last line: 
Specifies whether the display 
automatically scrolls when you select 
the last line of visible info.

6 Press OK .

Locking your 
smartphone and info

Your smartphone includes several features 
that help you protect your smartphone 
from inadvertent use and keep your 
information private. The built-in security 
software lets you use your smartphone for 
emergency calls, such as dialing your 
national emergency number (such as 911 
or 112), even if it is locked.

Keyguard: Manually disables all buttons 
and the screen’s touch-sensitive feature 
to prevent accidental presses in your 
briefcase or pocket.

Auto-Keyguard and touchscreen 

lockout: Automatically enables Keyguard 
after a period of inactivity and lets you 
disable the screen’s touch-sensitive feature 
during an active call.

Phone Lock: Requires a PIN to turn on 
your phone so you can make and answer 
calls.
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System password lock: Requires a 
password to see any information on your 
smartphone.

Locking your keyboard (Keyguard)

By default, your keyboard locks so that you 
don’t accidentally press buttons or activate 
screen items while your smartphone is in a 
pocket or bag.

• To dismiss Keyguard, press Center .

• To manually turn on Keyguard when 
your smartphone screen is on, press 
Option  + Power/End .

Turning on Auto-Keyguard

Auto-Keyguard enables you to configure 
the Keyguard feature.

1 Press Start  and select Settings.

2 On the Personal tab, select 
Keyguard .

3 Select the Auto-Keyguard list and then 
disable the Auto-Keyguard feature or set 
the period of inactivity that passes 
before the keyboard automatically locks.

4 Press OK .

Locking your screen

1 Press Start  and select Settings.

2 On the Personal tab, select 
Keyguard .

TIP To avoid accidentally pressing onscreen 
buttons while you’re holding your smartphone 
up to your ear to speak, you can disable the 
screen’s touch-sensitive feature during active 
calls. When the screen’s touch-sensitive 
feature is disabled, you must use the 5-way 
navigator to access items on the screen.

TIP If you’re using a headset or hands-free 
device and your smartphone is in a pocket or 
bag, you can manually turn on Keyguard 
during a call to prevent accidental key 
presses.
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3 Check or uncheck the Disable 

touchscreen box to determine whether 
the screen’s touch-sensitive feature is 
enabled during a call.

4 Press OK .

Locking the SIM card

You can lock your SIM (Subscriber Identity 
Module) card to prevent unauthorized use 
of your mobile account. When your SIM 
card is locked, you must enter the PIN to 
power on your phone to make or receive 
calls, except for emergency numbers. The 
SIM card remains locked even if you move 
the card to another phone.

When your SIM card is locked, you can 
unlock your SIM card by trying to turn on 
the phone. A dial pad appears for you to 
enter your PIN.

BEFORE YOU BEGIN

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

• Get your default PIN from your wireless 
service provider.

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 Select the Security tab.

4 Check the Require PIN when phone is 

used box.

5 Enter the PIN and press Done  
(left action key).

6 Press OK .

7 Turn your phone off to activate the 
phone lock feature.

Your SIM card locks when you turn off your 
phone and turn it back on. When your SIM 
card is locked, you can unlock your SIM 
card by entering your PIN.
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NOTE You need your PIN number to edit 
your PIN number or remove the locking 
feature. If you enter an incorrect PIN more 
times than allowed by your wireless 
service provider, the SIM card locks. After 
the SIM card locks, you need the PUK (PIN 
Unlock Key) to unlock the SIM card. 
Contact your wireless service provider for 
more information and the PUK.

Locking your smartphone

To protect your personal information, you 
can lock the system so that you need to 
enter your password to access any of your 
information or use other features of 
your smartphone.

IMPORTANT If you lock your system, you 
must enter the exact password to unlock it. 
If you enter an incorrect password, you are 
given another chance. Each time an 
incorrect password is entered, you are 

given progressively longer time periods 
between your chances to enter the 
password. If you forget the password, you 
need to perform a hard reset to resume 
using your smartphone. Performing a hard 
reset deletes all the entries in your 
smartphone. However, you can restore all 
previously synchronized info the next time 
you sync (see Synchronizing information).

1 Press Start  and select Settings.

2 On the Personal tab, select Lock .

3 On the Password tab, check the 
Prompt if device unused for box to 
turn on the password feature.

4 Select the first list, and then select how 
long a period of inactivity must pass 
before you are prompted to enter a 
password to unlock the system.

5 Select the Password type list, and then 
select a format for your password:

Strong alphanumeric: A strong 
alphanumeric password must contain at 
least 7 characters and must contain a 
combination of letters, numerals, and 
punctuation. You must press Option or 
Alt before entering numerals or 
punctuation.

DID YOU KNOW? You can permanently unlock your 
SIM card. From your Today screen, press 
Menu and select Preferences > Phone 

Settings. Select the Security tab, and 
uncheck the Require PIN when phone is 

used box.
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Simple PIN: A simple PIN must contain 
at least 4 characters and includes 
numerals only. You do not need to press 
Option before entering the PIN 
numerals.

6 Select Password and enter your 
password.

7 Select Confirm and enter the password 
again.

8 (Optional) Select the Hint tab and enter 
a hint to help you recall your password.

9 Press OK .

Entering owner information

You can enter personal information that you 
want to associate with your smartphone, 
such as your name, company name, and 

phone number. You can also set whether 
you want this information to appear when 
you turn on your smartphone. If you lose 
your smartphone, this feature can help the 
person who finds it return it to you.

1 Press Start  and select Settings.

2 On the Personal tab, select Owner 

Information .

3 On the Identification tab, enter any of 
the information you want to include.

4 Select the Notes tab and enter any 
additional text you want to include.

5 Select the Options tab and check the 
boxes to indicate which info (if any) you 
want to appear on the screen when you 
turn on your smartphone.

6 Press OK .

TIP If you lock your smartphone and use a 
Simple PIN as the password, you can dial an 
emergency number by entering the number in 
the password field and pressing Phone/Send. 
You do not need to press Option before 
entering the number. However, if you select 
Strong alphanumeric as the password type, 
you must first press Option twice before 
entering an emergency number in the 
password field.
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System settings

Setting the date and time

Use Clock & Alarms Settings to set the 
time zone, time, and date for your home 
location and a location that you visit.

To set the display format for the date and 
time, see Setting display formats.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 On the Time tab, select Home.

4 Select the first list, and then select the 
time zone for your home location.

5 Select the hour, and then press Up  
or Down  to increase or decrease the 
hour setting. Repeat this process for the 
minute, seconds, and AM/PM settings.

6 (Optional) Select Visiting and set the 
info for a location that you visit often.

7 Press OK .

8 If prompted, select Yes to accept your 
changes.

Synchronizing the date, time, and time 

zone with the network

By default your smartphone synchronizes 
the date, time, and time zone with your 
wireless service provider’s network 

TIP You can also display your Owner 
Information on your Today screen. See 
Selecting which items appear on your 
Today screen for details.
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whenever your phone is on and you are 
inside a coverage area. 

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the More tab.

4 To disable this option, uncheck the 
Enable local network time box. 

5 If you want to keep your smartphone 
date and time set for your selected 
location, uncheck the Use network 

time zone box.

Setting system alarms

System alarms let you set alarms that are 
not associated with a task or appointment. 
For example, you can use your smartphone 
as an alarm clock when you travel, or set 
alarms to remind you when it’s time to take 
medication or pick up the kids. 

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the Alarms tab.

4 Check a box to turn on that alarm.

5 Select the description next to the box 
you checked and enter a description for 
the alarm.

6 Select the days of the week you want 
the alarm to go off. You can select 
multiple days for each alarm.

7 Select the time you want the alarm to 
go off, and then press OK .

8 Select the alarm  icon, and then 
check the boxes to select how you want 
the alarm to go off. You can choose a 
flashing light, a single sound, a 
repeating sound, or vibration.
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9 Press OK  twice.

10 If prompted, select Yes to accept your 
changes.

Managing identity certificates

Your smartphone may include preinstalled 
certificates. Certificates are digital 
documents that are used to authenticate 
and exchange information on networks. 
Certificates can be issued for a user, a 
device, or a service.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Certificates .

3 Select any of the following tabs:

Personal: Displays certificates that 
establish your identity when you log in 
to a secured network, such as a 
corporate network.

Intermediate: Displays certificates 
issued by the root whose purpose is to 
then issue personal certificates.

Root: Displays certificates that identify 
the computers, such as servers, to 
which you connect. These certificates 
help prevent unauthorized users from 
accessing your smartphone and 
information.

4 Press OK .

Enabling error reporting

Error Reporting sends info that helps 
diagnose application errors for devices 
running Windows Mobile® software. When 
an error is detected, a text file is created. 
You can review the file and choose 
whether you want it delivered to Microsoft 
technical support. The information is used 
by programming groups at Microsoft for 
quality control and is not used for tracking 
individual users or installations for any 
marketing purpose. The info that is 
collected is technical info about the state of 

TIP To change the alarm sound, select the 
alarm sound icon, select the Play Sound list, 
and then select the alarm sound you want to 
use.

TIP To delete a certificate, tap and hold the 
certificate in the list, and then select Delete 

from the shortcut menu.
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your system when the error occurred. No 
documents (or any info contained in them) 
are intentionally sent with the report. To 
ensure further security, the report is 
transmitted via a secure connection and is 
kept confidential and anonymous in a 
limited-access database.

Your smartphone must be connected to 
your computer when you send the error 
report—provided your computer is 
connected to the Internet.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Error Reporting .

3 Select whether you want to enable or 
disable error reporting.

4 Press OK .

How much storage space do I have left?

1 Press and hold OK .

2 Select any of the following tabs:

Main: Displays the amount of memory 
assigned to your applications and info, 
as well as the amount of memory in use 
versus the available memory.

DID YOU KNOW? This error reporting method meets 
the privacy regulations of the European Union 
(EU) as well as the Fair Information Practice 
Principles of the Federal Trade Commission in 
the United States. To view the Fair 
Information Practice Principles, visit the 
Federal Trade Commission website at 
www.ftc.gov/reports/privacy3/fairinfo.htm.

TIP If storage memory is low, consider using an 
expansion card to store files (see Using 
expansion cards). If program memory is low, 
close some applications to avoid slow 
smartphone performance (see Closing 
applications).
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Storage Card: Displays the amount of 
memory available on an expansion card 
that is inserted in the expansion slot on 
your smartphone.

Running Programs: Lists the 
applications that are in use on your 
smartphone. To switch to an application, 
highlight it and select Activate. To close 
an application, highlight it and select 
Stop. To close all open applications, 
select Stop All.

3 Press OK .

Optimizing power settings

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Power .

3 On the Battery tab, view the power 
remaining in your battery.

4 Select the Advanced tab and set 
whether your smartphone screen turns 
off automatically after a specified period 
of inactivity. You can assign different 
intervals for battery power and external 
power.

TIP An easy way to check the battery level is by 
tapping the Battery icon in the title bar.



Y O U R  P E R S O N A L  S E T T I N G S

S Y S T E M  S E T T I N G S 255

13

C
H

A
P

T
E

R

5 Press OK .

Turning wireless services on/off 

1 From the Today screen, press 
Menu  (right action key) and 
select Wireless Manager.

2 Turn the wireless features on your 
smartphone on/off. Select All to turn all 
wireless features on/off.

3 Press OK .

You can also turn wireless services on and 
off by tapping the signal-strength  icon 
at the top of the screen, and selecting 
Wireless Manager. 

TIP To conserve additional battery power, 
adjust the display backlight setting. Press 
Start and select Settings. Select the System 
tab, and then select Backlight. On the Battery 
Power tab, set whether the display backlight 
turns off automatically after a period of 
inactivity.

TIP To change the settings for one of the 
displayed wireless features, press Menu (right 
action key) and select the wireless feature you 
want to change.
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Connection settings

Managing ISP settings

Your smartphone is already set up to 
connect to the Internet using a high-speed 
data connection on your wireless service 
provider’s network. To connect to the 
Internet, simply start Internet Explorer 
Mobile.

For special situations, such as connecting 
to your internet service provider (ISP) or to 
a remote access server (RAS), you can set 
up another connection.

BEFORE YOU BEGIN Obtain the following 
information from your ISP or system 
administrator:

• ISP server phone number or access 
point

• Username

• Password

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections .

3 On the Tasks tab, select Manage 

existing connections.

4 Select the Modem tab. 

5 Highlight the connection you want to 
view or change, and then select Edit, or 
to create a new connection, select 
New.

6 Follow the onscreen instructions to edit 
or create the connection.

Connecting to a VPN

If you want to use your smartphone to 
access your corporate email account or 
other files on your corporate server, you 
may need to set up a VPN (virtual private 
network). A VPN enables you to log in to 
your corporate server through the 
company’s firewall (security layer).

BEFORE YOU BEGIN Check with your 
company’s system administrator to see if a 
VPN is required to access the corporate 
network. If you need a VPN, you 
must purchase and install a third-party VPN 
client to use this feature.
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Ask your corporate system administrator 
for the following information:

• Your username and password

• Your server’s domain name

• Your server’s TCP/IP settings 

• Your server’s host name or IP address

1 Install your third-party VPN client (see 
Installing applications).

2 Press Start  and select Settings.

3 Select the Connections tab, and then 
select Connections .

4 On the Tasks tab, select Add a new 

VPN server connection.

5 Follow the onscreen instructions to 
enter the settings provided by your 
corporate system administrator.

Setting up a proxy server

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections .

3 On the Tasks tab, select Set up my 

proxy server.

4 Check both boxes near the top of the 
screen.

5 Select Proxy server and enter the proxy 
server name.

6 Press OK .

Ending a data connection

If your service plan includes 
minutes-of-use fees for data connections, 
you can reduce costs by ending the data 
connection when you’ve finished browsing 
the web.

1 Use the stylus to tap one of the data 
connection icons (  or ) on the title 
bar.

TIP To manually start a data connection on your 
wireless service provider’s network or another 
network, go to Connections Settings, and on 
the Tasks tab, select Manage existing 

connections. Tap and hold the connection 
you want to start, and then select Connect 
from the shortcut menu. 

TIP To change settings such as the port 
number, proxy server type, or credentials, 
select Advanced.
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2 Select Disconnect from the shortcut 
menu.

Submitting usage 
information to 
Microsoft

You can choose to anonymously send 
information about your smartphone usage 
to Microsoft. This information helps the 
company improve its Windows Mobile 
software. No personal information is 
submitted, you do not incur data charges, 
and participation is voluntary.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Customer Feedback .

3 Select Send Feedback.



CHAPTER

14

Troubleshooting
Although we can’t anticipate all the questions you might have, 
this chapter provides answers to some of the most commonly 
asked questions. For additional information and answers to 
other common questions, visit www.palm.com/
treo800W-support.
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Transferring info from 
another device

For information on transferring your info 
from a previous Windows Mobile® device 
or from a Palm OS® device to your new 
Palm® Treo™ 800W smartphone, visit 
www.palm.com/treo800W-support for 
instructions.

IMPORTANT Do not use a backup utility to 
transfer your info from another device to 
your new smartphone. This can cause your 
smartphone to malfunction.

Reinstalling the 
desktop software

If you have problems synchronizing using 
your desktop sync software, you may need 
to reinstall the software.

BEFORE YOU BEGIN Make sure your 
computer profile includes administrator 
rights to install software. In large 
organizations, these are usually granted 
by the system administrator.

1 Shut down your computer and turn it on 
again.

2 On your computer, click Start > Control 

Panel > Add or Remove Programs.

3 Remove your desktop software. For 
computers running Windows XP, the 
software is called Microsoft ActiveSync. 
For computers running Windows Vista, 
the software is called Windows Mobile 
Device Center.

4 Quit any active applications, including 
virus scanners and Internet security 
applications.

DID YOU KNOW? You can purchase a third-party 
application that lets you run Palm OS® 
applications on your smartphone.

DID YOU KNOW? If you have questions about 
Windows Mobile, you can go to the Microsoft 
Windows Mobile website. Search for Palm 
devices for information.
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5 To reinstall the software, insert the 
Windows Mobile Getting Started CD 
into your computer’s CD drive, and 
follow the onscreen instructions. See 
Installing ActiveSync desktop software: 
Windows XP or Installing Windows 
Mobile Device Center: Windows Vista 
for detailed instructions.

You must install the desktop sync 
software that came with your 
smartphone on the Windows Mobile 
Getting Started CD. Other versions do 
not work with this smartphone.

Resetting your 
smartphone

Performing a soft reset

Performing a soft reset is similar to 
restarting a computer. If your smartphone 
is not responding or you have trouble 
synchronizing with your computer, a soft 
reset may help.

1 If your smartphone responds to key 
presses, press and hold Power/End 

 to turn off your phone.

2 If the screen display is on, press 
Power/End  to turn off the screen.

3 Open the expansion card slot door on 
the side of your smartphone.

4 Use the stylus tip to gently press the 
reset button next to the expansion card 
slot.

DID YOU KNOW? The Windows Mobile Getting 
Started CD installs the software and drivers 
that let you synchronize with Microsoft Office 
Outlook®. If you want to synchronize with a 
different personal information manager (PIM), 
you must install a third-party solution. Contact 
the PIM’s vendor to learn if software 
is available for your smartphone.
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5 Wait for the progress bar on the Treo 
logo screen to fill before continuing to 
use your smartphone.

Performing a hard reset

A hard reset erases all personal 
information, such as appointments, 
contacts, and tasks, as well as programs 

you have added, such as third-party 
software on your smartphone. Never do a 
hard reset without first trying a soft reset. 
You can restore previously synchronized 
information the next time you sync.

IMPORTANT Synchronize to restore your 
Outlook data, such as Outlook email, 
Calendar, Contacts, Notes, and Tasks. You 
can use a backup and restore solution. 
Make sure it’s an application that’s 
approved by Palm, such as the one 
included on the Windows Mobile Getting 
Started CD. 

TIP You can also do a soft reset by removing 
the battery and reinserting it.

DID YOU KNOW? If the phone or the Bluetooth® 
wireless technology feature was on before a 
reset, these automatically turn on after the 
reset.

TIP Some third-party applications do not create 
a backup on your computer when you 
synchronize. If you do a hard reset, you may 
lose info in these applications and you need to 
reinstall the application on your smartphone 
after the hard reset. Please contact the 
application vendor to find out if your info is 
backed up during synchronization.

DID YOU KNOW? When you synchronize after a hard 
reset, the source folder in My Documents 
changes from Treo My Documents to 
WM_your name.
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A hard reset can tell you whether a 
problem stems from your smartphone or 
from an application installed on it. If you do 
not experience the problem after you 
perform a hard reset, the problem may be 
related to software you installed. See 
Third-party applications for suggestions on 
diagnosing third-party software issues.

1 Synchronize your smartphone with your 
computer so that your smartphone 
applications and info can be restored by 
synchronizing again after you perform 
the hard rest.

2 Open the expansion card slot door on 
the side of your smartphone.

3 If the screen is off, press Power/End 

 to wake up the screen.

4 While pressing and holding Power/End 
, use the tip of the stylus to gently 

press and hold the reset button next to 
the expansion card slot.

5 Continue pressing and holding both 
buttons until the “Erase all data?” 
prompt appears. 

6 Press Up  to confirm the hard reset.

7 Wait for the progress bar on the Treo 
logo screen to fill before continuing to 
use your smartphone.

8 (Optional) Synchronize to restore your 
previously synchronized info. If you use 
a backup utility, you may also need to 
restore a backup to recover additional 
info and settings.

Replacing the battery

Your smartphone comes with a replaceable 
battery. Be sure to use a replacement 
battery from Palm that is compatible with 
Treo 800W models. Do not use a battery 
from any earlier model of smartphone.

TIP Be sure to dispose of your old battery in an 
environmentally responsible and legal way. In 
some areas, disposal in household or 
business trash is prohibited. Visit 
www.palm.com/environment for more 
information.

DID YOU KNOW? Your smartphone stores all your 
info even when you remove the battery.
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1 Press Power/End  to turn off the 
screen.

2 Use one hand to press the Battery 

door release and use the other hand to 
slide the battery door downward to 
remove it from your smartphone.

3 Place a finger in the notch between the 
stylus and the battery, and lift the 
battery at a 45-degree angle.

4 Align the new battery’s contacts with 
the phone contacts inside the battery 
compartment.

5 Insert the new battery into the 
compartment at a 45-degree angle, 
pressing it into place. Slide the battery 
door onto the back of the smartphone 
until it clicks into place.

6 Wait for the screen to turn on.

Battery door 
release

Notch

Phone 
contacts

Battery 
contacts
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Performance

The applications are running slower than 

usual

1 Press Start  and select Settings.

2 Select System, and then select 
Memory .

3 Select Running Programs. 

4 Select Stop All to close all your open 
applications.

5 Press OK .

If the previous steps don’t fix the problem, 
try doing a soft reset (see Performing a soft 
reset). If the problem persists, follow these 
steps to turn off the Voice Command 
setting, if it is enabled:

1 Press Start  and select Settings.

2 Select Personal, and then select Voice 

Command .

3 Uncheck the Enabled box.

4 Press OK .

My battery seems to drain quickly

If you have a push email solution (such as 
GoodLink™ wireless messaging) or if you 
have set up a schedule for wireless 
synchronization, check with your email 
provider or system administrator to make 
sure that the server is set up properly to 
work with your smartphone. Incorrect 
server setup can cause excessive drain on 
your battery.

For more tips on conversing battery life, 
see Maximizing battery life).

TIP Be sure that third-party applications are 
designed for Windows Mobile 6 Professional. 
Applications written for Windows Mobile 6 
Standard or earlier versions of Windows 
Mobile software do not work with your 
smartphone. 

If you can try a free version of the software 
before purchasing it, you can test it first to 
make sure it works properly.
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Screen

The screen appears blank

1 If you’re on a call, when the time period 
specified in Backlight Settings expires, 
the screen dims; one minute later, the 
screen automatically turns off. 
Press any key except Power/End to 
wake up the screen. Pressing Power/
End hangs up the call.

2 Look closely at the screen. If you can 
see a dim image, try adjusting the 
screen brightness (see Adjusting the 
brightness).

3 If that doesn’t work, perform a soft 
reset (see Performing a soft reset).

4 If that doesn’t work, connect your 
smartphone to the AC charger (see 
Charging the battery) and perform a soft 
reset again.

5 If that doesn’t work, perform a hard 
reset (see Performing a hard reset).

The screen doesn’t respond accurately to 

taps or activates wrong features

1 Make sure there is no debris trapped 
under the edges of the screen.

2 Press Start  and select Settings. 

3 Select the System tab, and then select 
Screen .

4 On the General tab, select Align 

Screen.

5 Tap the screen where indicated.

6 Press OK .

Network connection

Signal strength is weak

1 If you’re standing, move about 3 meters 
(10 feet) in any direction.

2 If you’re in a building, move near a 
window. Open any metal blinds.

3 If you’re in a building, move outdoors or 
to a more open area.

4 If you’re outdoors, move away from 
large buildings, trees, or electrical wires.

TIP If you are using a third-party application, 
make sure that the application supports 
240x240 screen resolution. 
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5 If you’re in a vehicle, move your 
smartphone so that it’s level 
with a window.

My smartphone won’t connect to the 

mobile network

1 Try the suggestions above for weak 
signals.

2 Turn off your phone and turn it on again 
(see Turning your Palm® Treo™ 800W 
smartphone on/off).

3 Perform a soft reset (see Performing a 
soft reset).

My phone seems to turn off by itself

If a system error and reset occur, the 
phone automatically turns on if it was on 
before the reset. However, if your 
smartphone can’t determine if your phone 
was on before the reset, it does not 
automatically turn on the phone (see 
Turning your phone on).

I can’t tell if data services are available 

The following icons appear in the title bar 
to indicate whether data services are 
available:

TIP Become familiar with low coverage areas 
where you live, commute, work, and play so 
you know when to expect signal strength 
issues.
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Your phone is connected to a 
CDMA2000 (3G or HSDPA) 
network, but you are not actively 
transmitting data. You can still 
make or receive calls.

Your phone is on and a 3G 
CDMA2000 data connection is 
active. You can make and receive 
calls and transmit data 
simultaneously.

Your phone is connected to a 
HSDPA CDMA2000 network, but 
you are not actively transmitting 
data. You can still make or 
receive calls.

NOTE In most cases, when your 
phone is connected to a 
CDMA2000 network (either 3G 
or HSDPA) but you are not 
actively transmitting data, the 3G 
icon appears. The H icon may 
appear when your phone is 
connected to a HSDPA 
CDMA2000 network, but you are 
not actively transmitting data

Your phone is on and an HSDPA 
CDMA2000 data connection is 
active. You can make and receive 
calls and transmit data 
simultaneously.

Your phone is connected to an 
EDGE network, but you are not 
actively transmitting data. You 
can still make or receive calls.

Your phone is on and an EDGE if 
data connection is active. You 
can still make or receive calls, 
but the data transmission is 
automatically interrupted.

Your phone is connected to a 
GPRS network, but you are not 
actively transmitting data. You 
can still make or receive calls.

Your phone is on and a GPRS 
data connection is active. You 
can still make or receive calls, 
but the data transmission is 
automatically interrupted.



T R O U B L E S H O O T I N G

N E T W O R K  C O N N E C T I O N270

14
C

H
A

P
T

E
R

My smartphone won’t connect to the 

Internet

Your smartphone supports GPRS or 
CDMA2000 (3G or HSDPA) wireless data 
networks. To connect to the Internet, you 
must subscribe to data services with your 
wireless service provider.

• Contact your wireless service provider 
to verify that your subscription plan 
includes data services and that these 
services have been correctly activated. 
Your wireless service provider should 
also be able to tell you if there are any 
outages in your location.

• Press and hold Power/End  to turn 
off your phone, then press and hold the 
same button to turn it back on.

• Perform a soft reset (see Performing a 
soft reset).

• Confirm that data services are correctly 
configured on your smartphone by 
doing the following:

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections . 

3 On the Tasks tab, select Manage 

existing connections.

4 If your wireless service provider’s name 
appears in the list, press OK . If not, 
contact your wireless service provider 
for assistance.

I can’t send or receive text or multimedia 

messages

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

• Contact your wireless service provider 
to verify that your plan includes 
messaging services, that these services 
have been correctly activated, and that 
they are available at your location. Your 
wireless service provider should be able 
to tell you if messaging services have 
been experiencing transmission delays.

• If possible, contact the recipient or 
sender of the message, and make sure 
the receiving device can handle the type 
of message you’re sending.

• If a text message arrives but does not 
display a notification, perform a soft 
reset (see Performing a soft reset).
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I can’t make or receive calls using a 

hands-free device with Bluetooth® 

wireless technology

Verify all of the following:

• The Turn on Bluetooth box is checked 
in Bluetooth Settings.

• Your Bluetooth device is charged and 
turned on.

• Your smartphone is within range of the 
hands-free device. Bluetooth range is 
up to 10 meters (30 feet) in optimum 
environmental conditions, which include 
the absence of the following: obstacles, 
radio interference from nearby 
electronic equipment, and other factors.

• The Bluetooth Settings screen is closed.

• You are away from other devices using 
the 2.4 GHz radio frequency, such as 
cordless phones, microwaves, and 
Wi-Fi equipment. If this is impossible, 
move the phone closer to the 
hands-free device.

• The device specifications are 
compatible with your smartphone.

I lost the connection between my 

smartphone and my Bluetooth headset

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Bluetooth.

3 Select the Devices tab.

4 Select your headset name from the list.

5 In Partnership Settings, make sure the 
Hands Free option box is checked.

6 Select Save.

7 Highlight the headset name.

8 Press and hold Center  to open the 
shortcut menu, and then select Set as 

Hands-Free.

9 Test your headset by making or 
receiving a call.

If the headset still doesn’t work, delete the 
existing partnership and create a new one. 
To delete the partnership:

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Bluetooth.

3 Highlight the headset device name.

4 Press and hold Center  to open the 
shortcut menu, and then select Delete.
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5 Create a new partnership (see 
Connecting to devices with Bluetooth® 
wireless technology.

Synchronization

Synchronization enables you to back up the 
information on your smartphone onto your 
computer or your server. If you ever need 
to perform a hard reset or otherwise erase 
all your information on your smartphone, 
you can synchronize your smartphone with 
your computer to restore the info. To make 
sure you always have an up-to-date backup 
of your info, synchronize frequently.

You can synchronize email and other 
information directly with Microsoft 
Exchange Server 2003 with Service Pack 2 
or Exchange Server 2007 using Microsoft 
Exchange ActiveSync®, or you can 
synchronize your smartphone with your 
computer, using the desktop sync software 
from the Windows Mobile Getting Started 
CD that came with your smartphone.

Desktop sync software

This section covers issues with 
synchronizing using the desktop sync 
software that came with your smartphone. 
If you have a Windows XP computer, the 
desktop sync software is called 
ActiveSync® desktop software. If you have 
a Windows Vista computer, the desktop 
sync software is called Windows Mobile 
Device Center.

NOTE See Exchange ActiveSync (wireless 
synchronization) for help with direct 
wireless synchronization with an Exchange 
server.

The desktop sync software does not 

respond to sync attempt

As you complete the following steps, 
synchronize after each step. If the 

DID YOU KNOW? You can go to the Windows 
Mobile website for more information at 
www.windowsmobile.com. 

DID YOU KNOW? A common cause of sync 
problems is the presence of protective 
software, such as VPNs or firewalls, on your 
computer or network.
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synchronization is successful, you do not 
need to complete the remaining steps.

1 Verify that the USB sync cable is 
securely connected at all points (see 
Setting up your computer for 
synchronization).

2 Make sure that all of the files you’re 
trying to sync are closed on both your 
computer and your smartphone.

3 On a Windows XP computer, look for 
the ActiveSync  icon at the top of 
your smartphone screen and the 
ActiveSync  icon in the taskbar on 
your computer to make sure ActiveSync 
desktop software is running on your 
computer. On a Windows Vista 
computer, look for the connection  
icon at the top of your smartphone 
screen. 

If the correct icons are not displayed, do 
the following:

Smartphone: Press Start , select 
Programs. and select ActiveSync . 
Press Menu  (right action key) 
and select Connections. Make sure the 
Synchronize all PCs using this 

connection box is checked, and that 
USB is selected from the list.

Windows XP computer: Click Start, 
navigate to Programs, and then select 
Microsoft ActiveSync.

Windows Vista computer: Click Start, 
select All Programs, and then select 
Windows Mobile Device Center.

4 Do one of the following:

5 Windows XP computer: Double-click 
the ActiveSync  icon in your taskbar. 
From the File menu, select Connection 

Settings. Make sure the Allow USB 

connections box is checked, and then 
click Connect.

6 Windows Vista computer: Click Start, 
select All Programs, and then select 
Windows Mobile Device Center. 
Select Connect without setting up 

your device, and then select 
Connection settings. Make sure the 
Allow USB connections box is 
checked, and click Connect.

7 Perform a soft reset (see Performing a 
soft reset).
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8 Restart your computer and make sure 
the desktop sync software is running.

9 If problems persist and you’re 
synchronizing through a USB hub, try 
connecting the sync cable to a different 
USB port or directly to your computer’s 
built-in USB port.

10 If you’re already synchronizing through a 
built-in USB port on the front of your 
computer, move the sync cable to a 
USB on the back of your computer if 
your computer has USB ports in both 
places.

11 Uninstall the desktop software that 
came with your smartphone, and then 
insert the Windows Mobile Getting 
Started CD, which came with your 
smartphone, and repeat the installation 
process (see Reinstalling the desktop 
software).

12 For a Windows XP computer only, 
delete the existing partnership between 
your smartphone and your computer 
and create a new one by doing the 
following steps in turn:

• Disconnect your smartphone and your 
computer from the sync cable.

• Right-click the gray ActiveSync  
icon in the taskbar in the lower-right 
corner of your computer screen, and 
then select Open Microsoft 

ActiveSync.

• Click File, and then click Delete 

Mobile Device. When asked to 
confirm, click Yes.

• Connect your smartphone and your 
computer to the sync cable.

• When the Synchronization Setup 
Wizard appears, follow the steps to 
establish a sync relationship between 
your smartphone and your computer.

13 If your organization uses a firewall or a 
VPN connection, synchronizing with 
ActiveSync may not work. For a 
Windows XP computer only, go to 
www.microsoft.com and search for the 
following topics to help with specific 
firewall setup situations:

• ActiveSync USB Connection 
Troubleshooting Guide

• ActiveSync with Sygate Personal 
Firewall

• ActiveSync with TrendMicro PC-cillin 
Internet Security
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• ActiveSync with Norton Personal 
Firewall

• ActiveSync with Zone Alarm Security 
Suite

• ActiveSync with McAfee Personal 
Firewall

• ActiveSync with Windows Firewall

14 Verify with your computer hardware 
vendor that your operating system 
supports your internal USB controller.

Synchronization finishes but info doesn’t 

appear where it should

• With the included desktop sync 
software, your smartphone can 
synchronize with the root folders of 
Microsoft Office Outlook Contacts, 
Calendar, Tasks, and Notes (Outlook 
sold separately; a free trial version is 
available for download from the 
Windows Mobile Getting Started CD). If 
you want to synchronize with a global 
Exchange Address Book, you must copy 
the addresses to your local Contacts list 
in Microsoft Office Outlook (right-click 
the addresses and select Add to 

Personal Address Book).

• Microsoft Office Outlook subfolders and 
public folders are not accessible with 
the included software. You may want to 
use a third-party solution instead.

• If you’re trying to sync offline, be sure 
to set your Microsoft Office Outlook 
Calendar, Contacts, Notes, and Tasks to 
be available offline.

• If you’re still having problems, try the 
following:

1 Make sure you’re synchronizing with 
the intended desktop personal 
information manager (PIM). The 
Windows Mobile Getting Started CD 
lets you synchronize with Microsoft 
Office Outlook for Windows. If you use 
a different PIM, you need to install 
third-party software to synchronize. For 
more information, consult the company 
that makes the PIM.

2 Open the desktop sync software on 
your computer, and make sure the Files 
synchronization option is selected (see 
Changing which applications sync).

3 Uninstall the desktop sync software, 
reboot your computer, insert the 
Windows Mobile Getting Started CD, 
which came with your smartphone, and 
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then repeat the installation process (see 
Reinstalling the desktop software).

Synchronization starts but doesn’t finish

Make sure that you installed the desktop 
software that came with your smartphone. 
If you’re not sure whether this software is 
installed, reinstall it (see Reinstalling the 
desktop software).

My video and music files won’t sync

1 Make sure you have Windows Media 
Player 10 or later installed on your 
computer.

2 Reinstall the desktop sync software 
from the Windows Mobile Getting 
Started CD, which came with your 
smartphone (see Reinstalling the 
desktop software). Media file 
synchronization fails if you installed the 
desktop sync software before you 
installed Windows Media Player.

My appointments show up in the wrong 

time slot after I sync

1 Make sure that you installed the 
desktop sync software that came with 
your smartphone. If you’re not sure 

whether this software is installed, 
reinstall it (see Reinstalling the desktop 
software).

2 Open Microsoft Office Outlook and 
correct the wrong entries.

3 Manually enter any information you 
added to your smartphone since the last 
time you synchronized.

4 Synchronize your phone and your 
computer.

My scheduled sync doesn’t work

By default, a scheduled sync does not work 
while you are roaming. This is to prevent 
roaming charges on your account. If 
roaming charges are not a concern, follow 
these steps to continue your sync schedule 
while roaming:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right action key) 
and select Schedule.

4 Check the Use above setting when 

roaming box.

5 Press OK .
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An alert tells me that ActiveSync 

encountered a problem on the server

There is a temporary problem with the 
server or the server may be temporarily 
overloaded. Try again later, and if the 
problem persists, contact your system 
administrator.

An alert tells me that there is not enough 

free memory to sync my info

The ActiveSync application on your 
smartphone ran out of storage space. Try 
the following:

1 Go to Memory Settings and close all 
running programs (see Closing 
applications).

2 If the problem persists, see Making 
room on your smartphone for 
suggestions on other ways to free up 
space on your smartphone.

An alert tells me that ActiveSync 

encountered a problem with [item type] 

[item name]

An error occurred during the sync of a 
single item. This error can usually be 
corrected only by removing the item that 

caused the error. If you sync again to see if 
the error persists, be aware that items 
causing this type of error are skipped and 
do not show up again.

My Today screen settings are not restored 

after a hard reset

Settings such as the background image and 
plug-in choices are not backed up during 
synchronization, so they can’t be restored 
after a hard reset. If you use a backup 
utility, you may be able to restore a backup 
to recover your Today screen setting and 
other additional info.

Exchange ActiveSync (wireless 

synchronization)

This section covers issues with direct 
wireless synchronization with an Exchange 
server. See Desktop sync software for help 
with synchronizing using your desktop sync 
software.

TIP If you are synchronizing with an Exchange 
server and you’re unable to change your lock 
settings, check with your system 
administrator to find out if a systemwide 
locking policy is in place.
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An alert tells me that the server could not 

be reached

Your smartphone had to wait too long to 
connect to the Exchange server. The 
connection may have been lost, the server 
may be temporarily overloaded, or the 
server may have encountered an internal 
error. Check your Exchange server name 
and proxy server settings (see Setting up 
wireless synchronization), and try 
again later.

An alert tells me that my account 

information could not be detected

When you set up the Exchange server sync 
options, the credentials page was left 
blank. Correct the credentials (see Setting 
up wireless synchronization), or set up your 
smartphone to sync only with a computer, 
and try to sync again.

An alert tells me the device timed out 

while waiting for credentials

The Exchange server credentials screen 
was left open too long. Re-enter the 
Exchange server credentials, and try to 
sync again.

Email

I have problems using my account

Occasionally you may experience problems 
using an email account after you set it up. If 
you followed the account setup procedure 
and are experiencing problems in using the 
account, verify that the account complies 
with your email provider’s requirements by 
following these steps:

• Verify both your password and your 
username for your email account.

• Some email service providers require 
you to be on their network to use your 
email account. If this is the case, be 
sure to use your provider’s network as 
the connection type for the account.

• Some email service providers have 
other requirements specific to their 
service. For example, Yahoo! requires 
you to set up POP mail forwarding for 
your Yahoo! account to download email 
messages to your smartphone. Check 
with your service provider to see if any 
provider-specific requirements exist.
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• Service provider settings frequently 
change. If your email account was 
working but you are currently 
experiencing problems, check with your 
service provider to see if any of the 
account settings have changed.

I have problems sending and receiving 

email

Short periods of time when email is 
unavailable are common due to server 
problems or poor wireless coverage. If you 
have problems sending or receiving mail 
for an extended period of time, check with 
your ISP or email service provider to verify 
that the service is working properly.

Scheduled email synchronization is not 

working

If email synchronization is occurring and 
you turn your smartphone off or the 
connection to your email service provider is 
disconnected, the synchronization fails.

• Check the synchronization schedule to 
make sure that email sync is set to 
occur at the expected day and time. See 
Setting the synchronization schedule for 
details.

• Press Start , select Programs, and 
then select ActiveSync . Press 
Menu  (right action key) and 
select Configure Server. Make sure the 
verify password setting is on. This is 
required for over-the-air synchronization.

I have problems sending email

If you are able to receive email messages 
but cannot send them, try the following 
steps, in turn:

• Make sure your ISP or email provider 
allows you to access email on a 
smartphone. Some providers do not 
offer this option at all; other providers 
require an upgrade for accessing email 
on a smartphone.

• Press Start , select Programs, and 
then select ActiveSync . Press 
Menu  (right action key) and 
select Configure Server. Make sure the 
SSL box is checked.

• Enter the name of a different outgoing 
mail server for sending mail. Many ISPs, 
such as cable companies, require that 
you have an Internet connection to their 
network to send email through their 
servers. In this case, you can almost 
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always receive email from these 
accounts, but if you want to send email, 
you must send it through another server 
(see Setting up a POP/IMAP account in 
the Inbox application: Common email 
providers).

My vCard or vCal email attachment isn’t 

forwarding correctly

Microsoft Office Outlook provides several 
features including vCard and vCal that work 
with email client software on a Windows 
computer. For these features to work 
correctly, the email client software must be 
properly set up. Follow these steps to 
check the settings:

1 Click Start on your computer, and then 
select Settings.

2 Select Control Panel.

3 Select Internet Options, and then click 
the Programs tab.

4 Make sure that the email field is set to 
the correct email client software. 

5 Click OK.

6 Start the email client software and 
make sure it is configured as the default 
MAPI client. Consult the documentation 

for your desktop email application for 
more information.

When I sync with my Exchange server my 

info is not downloading to my 

smartphone

Check with your system administrator to 
obtain the name of the mail server that 
offers you wireless access to the corporate 
mail system. If you cannot obtain the name 
of this server (some companies do not give 
it out, because they do not want wireless 
access to their servers), you cannot use 
Exchange ActiveSync to synchronize with 
the Exchange server. You can also check 
the following setting:

1 Press Start  and select Programs. 

2 Select ActiveSync . 

3 Press Menu  (right action key) 
and select Configure Server. 

4 Make sure the SSL box is checked.
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Web

I can’t access a web page

First, make sure you have Internet access: 
Open Internet Explorer Mobile and try to 
view a web page you’ve loaded before. To 
ensure that you’re viewing the page 
directly from the Internet, press Menu 

 (right action key) and select Refresh. 
After confirming your Internet connection, 
try to view the page in question again. If it 
comes up blank, press Menu  (right 
action key) and select Refresh.

If you’re still having trouble, the page may 
contain elements that are not supported by 
Internet Explorer Mobile, such as Flash, 
Shockwave, VBScript, WML script, and 
other plug-ins.

Some websites use a redirector to their 
true home page. For example, if you enter 
the address http://www.palm.com/support, 
it may resolve to http://www.palm.com/us/
support. If Internet Explorer Mobile can’t 
follow the redirect, try using a desktop 
browser to see the landing page of the 
redirector, and enter that address in 
Internet Explorer Mobile.

An image or map is too small on my 

smartphone screen

Internet Explorer Mobile has several 
viewing modes: One Column, Default, 
Desktop, and Full Screen. Switch to 
Desktop to see the full-size image (see 
Viewing a web page).

A secure site refuses to permit a 

transaction

Some websites don’t support certain 
browsers for transactions. Please contact 
the site’s webmaster to make sure the site 
allows transactions using Internet Explorer 
Mobile.

TIP Your smartphone can open your email 
application when you select an email address 
on a web page. If nothing happens when you 
select the link, try setting up your email 
application first.
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Camera

Here are some tips for taking good pictures 
with the built-in camera:

• Clean the camera’s lens with a soft, 
lint-free cloth.

• Take pictures in bright lighting 
conditions. Low-light images may be 
grainy, due to the sensitivity of the 
camera.

• Hold the camera as still as possible. Try 
supporting your picture-taking arm 
against your body or a stationary object 
(such as a wall).

• Keep the subject of the pictures still. 
Exposure time is longer with lower light 
levels, so you may see a blur.

• For best results, verify that you have the 
brightest light source coming from 
behind you, lighting the subject’s face. 
Avoid taking indoor pictures with the 
subject in front of a window or light.

• Make sure the subject is at least 0.5 
meters (18 inches) away from the 
camera to ensure good focus.

Remember that when you synchronize, 
your Camera images are stored in the 
C:\Documents and 
Settings\<Username>\My Documents\Treo 
My Documents folder on your hard drive 
(see Camera).

The Camera preview image looks strange

Some third-party applications overwrite the 
color settings on your smartphone with 
their own 8-bit color settings. This can 
affect the Camera Preview Mode. Delete 
third-party applications one by one until the 
preview image improves (see Removing 
applications).

DID YOU KNOW? Pictures are 16-bit color. 
Resolution settings range from the low end of 
VGA (160 x 120 pixels) to a high end of 1.3 
megapixels (1280 x 1024). Video resolution 
settings range from a low end of 176 x 144 
pixels to a high end of 352 x 288 pixels. You 
can change the resolution setting by pressing 
Menu (right action key) and selecting 
Resolution (still images) or Quality (video).
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Third-party 
applications

Sometimes third-party applications can 
cause conflicts on your smartphone. 
Third-party applications that modify 
wireless features may affect the 
performance of your smartphone and may 
require extra troubleshooting. Use caution 
when installing the following types of 
applications:

• Ringtone managers

• Caller ID applications

• Instant messaging

• Applications that modify when your 
phone or data connections turn on or off 
and how your phone behaves

If you recently installed an application and 
your smartphone seems to be stuck, try 
the following:

1 Perform a soft reset (see Performing a 
soft reset).

2 Make sure the third-party application is 
compatible with the Windows Mobile 6 

Professional operating system on your 
smartphone.

3 Delete the most recently installed 
application from your smartphone (see 
Removing applications).

4 If the problem persists, perform another 
soft reset.

5 If possible, synchronize or use a backup 
utility to back up your most recent info.

6 Perform a hard reset (see Performing a 
hard reset).

7 Synchronize or restore your backup to 
restore the info in your built-in 
applications.

8 If the problem is resolved, begin 
reinstalling your third-party applications 
one at a time.

9 If the problem recurs, delete the last 
application you installed and report the 
problem to its developer.

Getting more help

Contact the vendor of any third-party 
software if you require further assistance. 
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Making room on your 
smartphone

If you store a large amount of information, 
or install many third-party applications, the 
internal memory on your smartphone may 
fill up. Here are some common ways to 
clear space on your smartphone:

• Camera: Large images or videos take 
up a lot of memory. Move images to an 
expansion card or delete images from 
your smartphone (see Pictures & 
Videos).

• Messaging: Multimedia content and 
email attachments can consume 
excessive memory. Move multimedia 
content and attachments to an 
expansion card, or delete large files 

from your smartphone (see Deleting 
messages and Deleting a single 
message). You may also want to empty 
the deleted items folder.

• Internet: If you save links to pages 
you’ve visited in Internet Explorer 
Mobile, you may want to clear all recent 
pages (see Customizing your Internet 
Explorer Mobile settings).

• Third-party applications: You can 
delete infrequently used applications or 
move them to an expansion card (see 
Copying or moving applications and files 
between your smartphone and an 
expansion card).

Also, remember that your smartphone 
includes an expansion card slot, and that 
you can store applications and information 
on expansion cards. However, you still 
need free memory on the smartphone 
itself to run applications from an expansion 
card.

TIP Remember that not all third-party 
applications were written with the Treo 800W 
smartphone keyboard and 5-way navigator in 
mind. You may encounter strange behavior or 
errors in these applications if you use the 
keyboard and the 5-way navigator.
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Voice quality

Is the other person hearing an echo?

• Try decreasing the volume on your 
smartphone to avoid coupling 
or feedback on the other person’s end. 
This applies to both the speakerphone 
and to the handset earpiece.

• Position the smartphone closer to your 
ear to prevent sound leaking back to the 
microphone. Keep your hand away from 
the microphone hole, which is on the 
lower-right side of your smartphone.

• If you’re using Speakerphone mode 
with your smartphone lying on a flat 

surface, try turning the smartphone 
“face down” (screen facing the 
surface).

Are you hearing your own voice echo?

Ask the other person to turn down their 
volume or to hold the phone closer to 
their ear.

Is your voice too quiet on the other end?

Be sure to hold the bottom of the 
smartphone, or the hands-free 
microphone, close to your mouth.

Check the signal strength indicator. If the 
signal is weak, try to find an area with 
better coverage.
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Where to learn more

For a quick introduction

• Quick Tour: The Quick Tour introduces 
you to many of your Palm® Treo™ 800W 
smartphone’s features. It is already 
installed on your smartphone, and you 
can open it any time. Press Start , 
select Programs, and then select Quick 

Tour .

While using your smartphone

• On-device Help: Your smartphone 
includes on-device help that is specially 
formatted for your smartphone screen. 
To view the on-device help, press Start 

 and select Help.

• Online support from Palm: For 
up-to-date downloads, troubleshooting, 
and support information, go to
www.palm.com/treo800W-support.

If you need more information

• Books: Many books on Windows 
Mobile® devices are available in local or 
online book retailers (look in the 
computers section).

• Customer service from your wireless 

service provider: For questions about 
your mobile account or features, contact 
your wireless service provider’s 
customer care.
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Terms

ActiveSync®

The software on your smartphone that 
exchanges and updates the information 
on your Palm® Treo™ 800W smartphone with 
the information on your computer. 

ActiveSync desktop software

The software on your Windows XP 
computer that exchanges and updates the 
information on your computer with the 
information on your smartphone. To open 
ActiveSync on your computer, double-click 
the ActiveSync icon in the taskbar in the 
lower-right corner of your screen. If the 
icon does not appear, click Start, click All 

Programs (or navigate to the Programs 
group), and then select Microsoft 

ActiveSync. See Installing ActiveSync 
desktop software: Windows XP.

Alt (alternative) 

The key that you use to enter accented 
characters and symbols that do not appear 
on your keyboard. Press Alt , and then 
press a key on the keyboard to view the 
alternative characters available for that key. 

See Entering other symbols and accented 
characters.

auto-off interval

The time of inactivity that passes before 
the screen on your smartphone turns off. 
The wireless features on your smartphone 
are unaffected by this setting. See 
Optimizing power settings.

beam

The process of sending or receiving an 
entry or application using the infrared port 
on your smartphone or using Bluetooth® 
wireless technology. See Beaming 
information.

Bluetooth® wireless technology

Technology that enables devices such as 
smartphones, mobile phones, and 
computers to connect wirelessly to each 
other so that they can exchange 
information over short distances. For more 
info, visit www.bluetooth.com. See 
Connecting to devices with Bluetooth® 
wireless technology.

desktop software

A Personal Information Manager (PIM) 
application for computers, such as 
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Microsoft Outlook®, that helps you manage 
your personal information and keep it 
synchronized with your smartphone. See 
Installing ActiveSync desktop software: 
Windows XP.

dialog box

A set of options and command buttons that 
is enclosed by a border and that enables 
you to carry out a specific task.

EDGE (Enhanced Data rates for GSM 

Evolution)

An enhanced version of GPRS that delivers 
data speeds that are up to 3 times faster 
than standard GPRS connections, with 
rates up to 236.8 Kbps. (Additional charges 
may apply.) See What are all those icons?

GPRS (General Packet Radio Service)

A mobile Internet connectivity technology 
that allows persistent data connections. 
(Additional charges may apply.) See What 
are all those icons?

HSDPA (High-Speed Download Packet 

Access)

An evolutionary enhancement to 
CDMA2000 packet data. HSDPA uses 
different modulation and coding techniques 

to improve downlink performance. Your 
smartphone supports data rates up to 
700Kbps.

infrared (IR)

A way of transmitting information using 
light waves. You use the IR port on 
your smartphone to transfer information 
between other IR devices within a 
short radius. See Beaming information.

Lithium-ion (Li-ion)

The rechargeable battery technology used 
in your smartphone. See Charging the 
battery.

Microsoft Exchange ActiveSync®

Technology that allows your smartphone to 
synchronize email, contacts, calendar 
events, and tasks wirelessly with Microsoft 
Exchange Server 2003 or 2007. See Setting 
up wireless synchronization.

MMS (Multimedia Messaging System)

An enhanced messaging system that 
enables you to send pictures, animations, 
and ringtones almost instantly. See 
Creating and sending a multimedia 
message.
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Mobile Device

The component on your Windows XP 
computer that enables you to install 
applications and other information on your 
smartphone. To access it, open Windows 
Explorer or My Computer and look for the 
icon that represents your smartphone. See 
Installing applications from your computer.

Option 

Press this key and then a second key to 
enter the character or to access the feature 
displayed above the letter on the second 
key. See Entering numbers, punctuation, 
and symbols.

partnership

The connection that you make between 
two devices by means of Bluetooth 
wireless technology. The devices recognize 
each other because each device finds the 
same passkey on the other device. After 
you create a partnership between the 
devices, you no longer need to enter the 
passkey. Partnership is also known as 
paired relationship, pairing, trusted device, 
and trusted pair on some devices. See 
Connecting to devices with Bluetooth® 
wireless technology.

Phone Off

Appearing on the Today screen, this 
indicates that your smartphone is not 
connected to any network, and you cannot 
make calls except those to emergency 
numbers. You can still use the organizer 
features, however. To turn the phone on/
off, go to the Wireless Manager. See 
Turning your phone on.

Phone/Send 

The button on your smartphone that 
provides quick access to your Today screen 
and dials after you’ve entered a phone 
number. See Making calls from the Today 
screen.

piconet

An ad-hoc network of devices that uses 
Bluetooth wireless technology to connect 
one master device with up to seven active 
slave devices. The network can include up 
to 255 inactive, or parked, slave devices 
which the master device can bring into 
active status at any time.
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PIM (personal information manager)

A genre of software that includes 
applications such as Microsoft Outlook, 
Palm® Desktop software, Lotus Notes, and 
ACT!. PIMs generally store contacts, 
schedules, tasks, and memos. 

PIN (personal identification number)

The password assigned to your SIM card 
by your wireless service provider. Turning 
on the PIN lock secures your wireless 
account. See also PUK. See Locking the 
SIM card.

PIN2 (personal identification number 2)

A code that protects certain network 
settings such as fixed dialing. 

PUK (PIN unlock key)

A special extended password assigned to 
your SIM card. If you enter the wrong PIN 
more than the allowed number of times, 
your SIM is blocked and you must call your 
wireless service provider for the PUK. See 
Locking the SIM card.

Secure Sockets Layer (SSL)

A security protocol that enables you to 
send personal information in a more secure 
manner over the Internet.

SIM (Subscriber Identity Module) card

The smartcard, inserted into your 
smartphone, that contains your mobile 
account information, such as your phone 
number and the services to which you 
subscribe. You can also store addresses, 
phone numbers, and SMS messages on 
the SIM card. See Inserting the SIM card 
and battery.

SMS (Short Messaging Service)

The service that exchanges short text 
messages almost instantly between 
mobile devices. Your smartphone can send 
and receive text messages while you are 
on a call. See Creating and sending a text 
message.

Start 

The menu on your smartphone from which 
you can open all applications. See Opening 
applications.

streaming

Technology that enables you to access 
media content—for example, watch video 
or listen to an audio program—directly 
from the Internet on your smartphone 
without needing to download and a save a 
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file on your smartphone. See Viewing a 
video.

synchronization

The process in which information that is 
entered or updated on your smartphone, 
your computer, or a server is automatically 
updated in one of the other locations either 
wirelessly or by means of a cable 
connection. See Synchronizing information.

UMTS (Universal Mobile 

Telecommunications System)

One of the third-generation (3G) mobile 
phone technologies that is designed for 
high-speed data transfer, with rates up to 
384 Kbps, as well as voice and multimedia 
services. It uses W-CDMA as the 
underlying technology. See What are all 
those icons?

username

The name associated with your 
smartphone that distinguishes it from 
other Windows Mobile® devices. If you 
install ActiveSync® desktop software, you 
are asked to give your smartphone a 
username. If you only synchronize 
wirelessly using Microsoft Exchange 
ActiveSync, you do not need to give your 

smartphone a username. See Installing 
ActiveSync desktop software: Windows 
XP.

Windows Mobile

The operating system of your Treo 800W 
smartphone. Your smartphone uses 
Windows Mobile® 6 Professional edition. 
When installing third-party applications to 
your smartphone, be sure to install only 
apps that are written for Microsoft 
Windows Mobile 6 Professional. Apps 
designed for Microsoft Windows Mobile 6 
Standard or any edition of Windows Mobile 
5.0 software are not compatible with your 
Treo 800W smartphone. See Installing 
third-party applications.

Windows Mobile Device Center

The software on your Windows Vista 
computer that enables you to synchronize 
content and manage music, pictures, and 
videos between your smartphone and your 
computer. To open Windows Mobile 
Device Center on your computer, click 
Start, click All Programs, and select 
Windows Mobile Device Center. See 
Installing Windows Mobile Device Center: 
Windows Vista.
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Important Safety 
Information
FCC Notice 

This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures: 

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications not expressly approved by Palm could void 
the user’s authority to operate this equipment.

The following statement is normally required to be on the FCCID 
label. If the device is too small, the statement must be included in the 
user manual. 

This device complies with part 15 of the FCC rules. Operation is 
subject to the following two conditions:

• This device may not cause harmful interference, and

• This device must accept any interferences received, including 
interference that may cause undesired operation.

This guide contains important operational and safety 

information to help you safely use your Palm® Treo™ 800W. Failure 
to read and follow the information provided in this guide may result in 
serious bodily injury, death, or property damage.

General Precautions

There are several simple guidelines to operating your smartphone 
properly and maintaining safe, satisfactory service. 

• Speak directly into the microphone. 

• Avoid exposing your smartphone and accessories to rain or liquid 
spills. If your smartphone does get wet, immediately turn the 
power off and remove the battery. 

• Although your smartphone is quite sturdy, it is a complex piece of 
equipment and can be broken. Avoid dropping, hitting, or bending 
it, or sitting on it. 

• Any changes or modifications to your smartphone not expressly 
approved in this document could void your warranty for this 
equipment and void your authority to operate this equipment. 

Maintaining Safe Use of and Access to Your 

Smartphone

Do Not Rely on Your Smartphone’s Phone for Emergency Calls 

Wireless phones such as the one on your Treo 800W operate using 
radio signals, which cannot guarantee connection in all conditions. 
Therefore you should never rely solely upon any wireless phone for 
essential communication (for example, medical emergencies). 
Emergency calls may not be possible on all cellular networks or when 
certain network services and/or phone features are in use. Check 
with your local service provider for details.

Using Your Phone While Driving 

Talking on your phone while driving (or operating the phone without a 
hands-free device) is prohibited in some jurisdictions. Laws vary as to 
specific restrictions. Remember that safety always comes first.
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Following Safety Guidelines

To operate your smartphone safely and efficiently, always follow any 
special regulations in a given area. Turn your smartphone’s phone off 
in areas where use is forbidden or when it may cause interference or 
danger.

Using Your Smartphone’s Phone Near Other Electronic Devices

Most modern electronic equipment is shielded from radiofrequency 
(RF) signals. However, RF signals from wireless phones may affect 
inadequately shielded electronic equipment.

RF signals may affect improperly installed or inadequately shielded 
electronic operating systems and/or entertainment systems in motor 
vehicles. Check with the manufacturer or their representative to 
determine if these systems are adequately shielded from external RF 
signals. Also check with the manufacturer regarding any equipment 
that has been added to your vehicle.

Consult the manufacturer of any personal medical devices, such as 
pacemakers and hearing aids, to determine if they are adequately 
shielded from external RF signals.

NOTE Always turn off the phone in health care facilities and request 
permission before using the phone near medical equipment.

Turning Off Your Phone Before Flying

NOTE Turn off your phone before boarding any aircraft. To prevent 
possible interference with aircraft systems, the U.S. Federal Aviation 
Administration (FAA) regulations require you to have permission from 
a crew member to use your phone while the plane is on the ground. 
To prevent any risk of interference, FCC regulations prohibit using 
your phone while the plane is in the air.

Turning Off Your Phone in Dangerous Areas

To avoid interfering with blasting operations, turn your phone off 
when in a blasting area or in other areas with signs indicating 
two-way radios should be turned off. Construction crews often use 
remote-control RF devices to set off explosives.

Turn your phone off when you’re in any area that has a potentially 
explosive atmosphere. Although it’s rare, your phone and accessories 
could generate sparks. Sparks can cause an explosion or fire, 
resulting in bodily injury or even death. These areas are often, but not 
always, clearly marked. They include:

• Fueling areas such as gas stations.

• Below deck on boats.

• Fuel or chemical transfer or storage facilities.

• Areas where the air contains chemicals or particles such as grain, 
dust, or metal powders.

• Any other area where you would normally be advised to turn off 
your vehicle’s engine.

NOTE Never transport or store flammable gas, flammable liquid, or 
explosives in the compartment of your vehicle that contains your 
phone or accessories.

Restricting Children’s Access to Your Smartphone

Your Treo 800W is not a toy. Do not allow children to play with it as 
they could hurt themselves and others, damage the smartphone and/
or its phone, or make calls that increase your monthly bill.

Using Your Phone With a Hearing Aid Device

Your Palm® Treo™ 800W smart device by Palm is compliant with the 
FCC Hearing Aid Compatibility (HAC) requirements. For additional 
HAC information, including the HAC rating of this product, please 
refer to www.palm.com/CentroHAC.

Your smartphone has been tested for hearing aid device compatibility. 
When some wireless phones are used near some hearing devices 
(hearing aids and cochlear implants), users may detect a buzzing, 
humming, or whining noise. Some hearing devices are more immune 
than others to this interference noise, and phones also vary in the 
amount of interference they generate.
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The wireless telephone industry has developed ratings for some of 
their mobile phones, to assist hearing-device users in finding phones 
that may be compatible with their hearing devices. Not all phones 
have been rated. Phones that have been rated have a label on the 
box. Your Palm Treo 800W phone has an M4 and T4 rating. 

These ratings are not guarantees. Results will vary, depending on the 
level of immunity of your hearing device and the degree of your 
hearing loss. If your hearing device happens to be vulnerable to 
interference, you may not be able to use a rated phone successfully. 
Trying out the phone with your hearing device is the best way to 
evaluate it for your personal needs.

M-Ratings: Phones rated M3 or M4 meet FCC requirements and are 
likely to generate less interference with hearing devices than phones 
that are not labeled. M4 is the better/higher of the two ratings.

T-Ratings: Phones rated T3 or T4 meet FCC requirements and are 
likely to be more usable with a hearing device’s telecoil (“T Switch” or 
“Telephone Switch”) than unrated phones. T4 is the better/higher of 
the two ratings. (Note that not all hearing devices contain telecoils.)

The more immune your hearing aid device is, the less likely you are to 
experience interference noise from your wireless phone. Hearing aid 
devices should have ratings similar to those of phones. Ask your 
hearing health-care professional for the rating of your hearing aid. Add 
the rating of your hearing aid and your phone to determine probable 
usability:

• Any combined rating equal to or greater than six offers best use.

• Any combined rating equal to five is considered normal use.

• Any combined rating equal to four is considered usable.

Thus, if you pair an M3 hearing aid with an M3 phone, you will have a 
combined rating of six for “best use.” This is synonymous for T 
ratings. 

Palm further suggests that you experiment with multiple phones 
(even those not labeled M3/T3 or M4/T4) while in the store to find the 
one that works best with your hearing aid device. If you experience 
interference or find the quality of service unsatisfactory after 

purchasing your device, promptly return it to the store within 30 days 
of purchase. With the Palm 30-day Risk-Free Guarantee, you may 
return the device within 30 days of purchase for a full refund, and you 
will only be responsible for charges based on your actual usage.

Getting the Best Hearing Device Experience With Your 

Smartphone

To further minimize interference: 

There is usually less interference on the microphone setting than on 
the telecoil setting.

Set the phone’s screen and keyboard backlight settings to ensure the 
minimum time interval. 

Move the phone around to find the point with the least interference.

If your hearing aid is equipped with a telecoil, turn on the HAC setting 
on your smartphone.

Turning on the HAC Setting

When the HAC setting is on, your smartphone sends the audio from 
your phone calls to the telecoil rather than to the microphone of your 
hearing aid. You are likely to hear calls much better because volume is 
increased and background noise and feedback are diminished. The 
HAC setting improves only the calls you listen to through the 
earpiece. Turn off BT. Turn off WiFi. It does not affect calls heard on 
the speakerphone or with a car kit or headset. HAC requires extra 
battery power, so watch your battery consumption when it's turned 
on.

CAUTION Do not turn on the HAC setting unless you use a hearing 
aid with a telecoil. Using this setting without a hearing aid or with a 
hearing aid without a telecoil may be harmful to your hearing.

1 Make sure your phone is turned on (see “Turning Your Device’s 
Phone On and Off” on page 55).

2 Press Phone .
3 Press Menu .
4 Select Options and then select Phone Preferences.
5 Check the Hearing Aid Compatibility box.
6 Select OK.
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Caring for the Battery

Protecting Your Battery

NOTE The guidelines listed below help you get the most out of your 
battery’s performance.

• Recently there have been some public reports of wireless phone 
batteries overheating, catching fire, or exploding. It appears that 
many, if not all, of these reports involve counterfeit or 
inexpensive, aftermarket-brand batteries with unknown or 
questionable manufacturing standards. Palm is not aware of 
similar problems with Treo 800Ws resulting from the proper use 
of batteries and accessories approved by Palm or the 
manufacturer of your phone. Use only Palm or 
manufacturer-approved batteries and accessories found at Palm 
Stores or through your smartphone’s manufacturer, or call 
1-866-343-1114 to order. They’re also available at 
www.Palm.com—click Accessories under the Shop & Browse 
menu. Buying the right batteries and accessories is the best way 
to ensure they’re genuine and safe.

• In order to avoid damage, charge the battery only in temperatures 
that range from 32° F to 113° F (0° C to 45° C).

• Don’t use the battery charger in direct sunlight or in high humidity 
areas, such as the bathroom.

• Never dispose of the battery by incineration.

• Keep the metal contacts on top of the battery clean.

• Don’t attempt to disassemble or short-circuit the battery.

• The battery may need recharging if it has not been used for a long 
period of time.

• It’s best to replace the battery when it no longer provides 
acceptable performance. It can be recharged hundreds of times 
before it needs replacing.

• Don’t store the battery in high temperature areas for long periods 
of time. It’s best to follow these storage rules:

• Less than one month: -4° F to 140° F (-20° C to 60° C)
• More than one month: -4° F to 113° F (-20° C to 45° C)

Battery Safety Information

• Do not disassemble or open, crush, bend or deform, puncture or 
shred.

• Do not modify or remanufacture, attempt to insert foreign objects 
into the battery, immerse or expose to water or other liquids, 
expose to fire, explosion or other hazard.

• Only use the battery for the system for which it is specified.

• Only use the battery with a charging system that has been 
qualified with the system per this standard. Use of an unqualified 
battery or charger may present a risk of fire, explosion, leakage, 
or other hazard.

• Do not short circuit a battery or allow metallic conductive objects 
to contact battery terminals.

• Replace the battery only with another battery that has been 
qualified with the system per this standard, IEEE-Std-1725-200x. 
Use of an unqualified battery may present a risk of fire, explosion, 
leakage or other hazard.

• Promptly dispose of used batteries in accordance with local 
regulations.

• Battery usage by children should be supervised.

• Avoid dropping the phone or battery. If the phone or battery is 
dropped, especially on a hard surface, and the user suspects 
damage, take it to a service center for inspection.

• Improper battery use may result in a fire, explosion or other 
hazard.

Disposal of Lithium-Ion (Li-Ion) Batteries

Do not handle a damaged or leaking li-ion battery as you can be 
burned. 

For safe disposal options of your li-ion batteries, contact your nearest 
Palm authorized service center.

Special Note: Be sure to dispose of your battery properly. In some 
areas, the disposal of batteries in household or business trash may be 
prohibited.
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Radiofrequency (RF) Energy

Understanding How Your Phone Operates

Your phone is basically a radio transmitter and receiver. When it’s 
turned on, it receives and transmits radiofrequency (RF) signals. 
When you use your phone, the system handling your call controls the 
power level. This power can range from 0.006 watts to 0.2 watts in 
digital mode.

Knowing Radiofrequency Safety

NOTE The design of your Palm Treo 800W complies with updated 
NCRP standards described below.

NOTE In 1991-92, the Institute of Electrical and Electronics 
Engineers (IEEE) and the American National Standards Institute 
(ANSI) joined in updating ANSI’s 1982 standard for safety levels with 
respect to human exposure to RF signals. More than 120 scientists, 
engineers and physicians from universities, government health 
agencies and industries developed this updated standard after 
reviewing the available body of research. In 1993, the Federal 
Communications Commission (FCC) adopted this updated standard 
in a regulation. In August 1996, the FCC adopted hybrid standard 
consisting of the existing ANSI/IEEE standard and the guidelines 
published by the National Council of Radiation Protection and 
Measurements (NCRP).

Body-Worn Operation

NOTE To maintain compliance with FCC RF exposure guidelines, if 
you wear a handset on your body, use the Palm-supplied or -approved 
carrying case, holster, or other body-worn accessory. Use of 
non-Palm-approved accessories may violate FCC RF exposure 
guidelines. Be sure to use an accessory that contains NO metal 
(snaps, clips, etc) and provides AT LEAST 1.5 cm of separation 
between the users body and the unit.

NOTE For more information about RF exposure, visit the FCC Web 
site at www.fcc.gov. 

Specific Absorption Rate (SAR) for Wireless Phones

The SAR is a value that corresponds to the relative amount of RF 
energy absorbed in the head of a user of a wireless handset.

The SAR value of a phone is the result of an extensive testing, 
measuring, and calculation process. It does not represent how much 
RF the phone emits. All phone models are tested at their highest 
value in strict laboratory settings. But when in operation, the SAR of a 
phone can be substantially less than the level reported to the FCC. 
This is because of a variety of factors including its proximity to a base 
station antenna, phone design, and other factors. What is important 
to remember is that each phone meets strict federal guidelines. 
Variations in SARs do not represent a variation in safety. 

All phones must meet the federal standard, which incorporates a 
substantial margin of safety. As stated above, variations in SAR 
values between different model phones do not mean variations in 
safety. SAR values at or below the federal standard of 1.6 W/kg are 
considered safe for use by the public. 

The highest reported (FCC) SAR values of the Palm Treo 800W are:

FCC Radiofrequency Emission

This phone meets the FCC Radiofrequency Emission Guidelines and 
is certified with the FCC as:

FCC ID # O8F-715

IC ID #  3905A-715

More information on the phone’s SAR can be found from the 
following FCC Web site: 
https://gullfoss2.fcc.gov/prod/oet/cf/eas/reports/GenericSearch.cfm.

• Static Electricity, ESD, and Your Smartphone

Maximum Scaled SAR Values (W/kg) FCC

CDMA2000 
Cellular

CDMA2000 
PCS

WLAN Co-location

Head 0.837 1.420 0.067 1.433

Body 0.577 0.456 0.018 0.595
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Electrostatic discharge (ESD) can cause damage to electronic devices 
if discharged into the device, so you should take steps to avoid such 
an occurrence.

Description of ESD

Static electricity is an electrical charge caused by the buildup of 
excess electrons on the surface of a material. To most people, static 
electricity and ESD are nothing more than annoyances. For example, 
after walking over a carpet while scuffing your feet, building up 
electrons on your body, you may get a shock—the discharge event—
when you touch a metal doorknob. This little shock discharges the 
built-up static electricity.

ESD-Susceptible Equipment

Even a small amount of ESD can harm circuitry, so when working 
with electronic devices, take measures to help protect your electronic 
devices, including your Palm® smartphone, from ESD harm. While 
Palm has built protections against ESD into its products, ESD 
unfortunately exists and, unless neutralized, could build up to levels 
that could harm your equipment. Any electronic device that contains 
an external entry point for plugging in anything from cables to docking 
stations is susceptible to entry of ESD. Devices that you carry with 
you, such as your smartphone, build up ESD in a unique way because 
the static electricity that may have built up on your body is 
automatically passed to the device. Then, when the device is 
connected to another device such as a docking station, a discharge 
event can occur. 

Precautions Against ESD

Make sure to discharge any built-up static electricity from yourself 
and your electronic devices before touching an electronic device or 
connecting one device to another. The recommendation from Palm is 
that you take this precaution before connecting your smartphone to 
your computer, placing the smartphone in a cradle, or connecting it to 
any other device. You can do this in many ways, including the 
following: 

• Ground yourself when you’re holding your mobile device by 
simultaneously touching a metal surface that is at earth ground. 
For example, if your computer has a metal case and is plugged 
into a standard three-prong grounded outlet, touching the case 
should discharge the ESD on your body.

• Increase the relative humidity of your environment.

• Install ESD-specific prevention items, such as grounding mats.

Conditions That Enhance ESD Occurrences

Conditions that can contribute to the buildup of static electricity in the 
environment include the following:

• Low relative humidity.

• Material type (The type of material gathering the charge. For 
example, synthetics are more prone to static buildup than natural 
fibers like cotton.)

• The rapidity with which you touch, connect, or disconnect 
electronic devices.

While you should always take appropriate precautions to discharge 
static electricity, if you are in an environment where you notice ESD 
events, you may want to take extra precautions to protect your 
electronic equipment against ESD.

Owner’s Record

The model number, regulatory number, and serial number are located 
on a nameplate inside the battery compartment. Record the serial 
number in the space provided below. This will be helpful if you need 
to contact us about your phone in the future.

Model: Palm® Treo™ 800W

Serial No.: 

User’s Guide Proprietary Notice

CDMA Technology is licensed by QUALCOMM Incorporated under 
one or more of the following patents:

4,901,307   5,109,390   5,267,262   5,416,797   
5,506,865   5,544,196   5,657,420   5,101,501   
5,267,261   5,414,796   5,504,773   5,535,239   
5,600,754   5,778,338   5,228,054   5,337,338   
5,710,784   5,056,109   5,568,483   5,659,569   
5,490,165   5,511,073 
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Specifications

Radio • CDMA2000 with EVDO

Phone features • Personal speakerphone

• Hands-free headset jack (2.5 mm, 3-barrel connector)

• Microphone mute option

• TTY compatible 

Processor technology • Samsung processor—300MHz 

Expansion • miniSD card slot

Battery • Rechargeable Lithium-ion

• 1200mAh power

• Removable for replacement

• 3 hours full charge time

Operating system • Windows Mobile® 6 Professional

Camera • Still image capture resolution:1280 x 1024, 1.3 megapixel

• 2x digital zoom

Size • 4.44 in. x 2.34 in. x 0.84 in. 
(112.9mm x 59.3mm x 21.3mm)

Weight • 5.4 ounces (154 grams)

Connectivity • Infrared (1.0 compliant)

• Bluetooth® wireless technology (1.2 compliant)
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Display • Touch-sensitive LCD screen (includes stylus)

• 65,536 colors (16-bit color)

• Resolution: 240 x 240 

• User-adjustable brightness

Keyboard • Built-in QWERTY keyboard plus 5-way navigator

• Backlight for low lighting conditions

Included software • Today/Phone (includes 
Speed Dial and Dial Pad)

• Messaging (text, 
multimedia, and email)

• Internet Explorer Mobile 
(web browser)

• Camera

• Pictures & Videos

• Windows Media Player 
Mobile

• File Explorer

• Contacts

• Calendar

• Tasks

• Notes

• Calculator

• ActiveSync®

• Excel Mobile

• Word Mobile

• PowerPoint Mobile

• Voice Command

• Quick Tour

• Search

• Terminal Services

• Picsel PDF Viewer

• Bluetooth Plug-in
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System requirements • Windows XP or Vista (later versions may also be 
supported)

• 32MB of available memory (RAM)

• 170MB of free hard disk space

• Available USB port

Operating and storage 
temperature range

• 32°F to 104°F (0°C to 40°C)

• 5% to 90% RH 
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Index

SYMBOLS

! on battery icon 12

NUMERICS

112 calls 37, 245
1st day of week option 181
3GP files 163
3GPP files 123, 160
3GPP2 files 123, 160
5-way navigator 7, 19, 21, 

284
911 calls 37, 245

A

AC charger 11, 79
accented characters 28, 29
accessing

ActiveSync 78
alternate characters 28
applications 30, 240
calculator 231
Calendar application 176
Contacts application 173
Dial Pad 41
File Explorer 218
information 31, 252

Internet Explorer 137
menu items 22, 23, 24
Messaging app 121
Notes application 185
on-device help 287
online address books 107
options in lists 24
Outlook folders 275
Palm online support 287
PDF Viewer 193
Phone Settings screen 15
Pictures & Videos 

application 159, 160, 
164, 166

Quick Tour 287
remote files 256
speed-dial buttons 38
spreadsheet templates 

202
Tasks application 183
Tasks entry bar 185
the Internet 256, 270
Today screen 14, 31
web pages 137, 139, 141, 

281
Wireless Manager 36

accounts
conference calls and 48

customer service support 
for 287

missing phone numbers 
and 16

preventing unauthorized 
use of 245, 252

removing email 99
troubleshooting 278

Accounts tab 99, 105, 110
action keys 7, 22
actions 22, 238
activating items on screen 22
active call info 44
active calls. See phone calls
ActiveSync

defined 289
installing 71
opening 78
receiving email and 103
synchronizing with 71, 73, 

261, 272
troubleshooting 261, 272–

277
ActiveSync icon 78, 81, 191, 

289
ActiveSync Plug-in for 

Bluetooth 86
Add a new VPN server 

connection option 257
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Add Contact prompt 46
Add Favorite dialog box 139
Add Media command 124
Add Picture command 124
Add Recipient command 121
Add Server Source command 

82
Add Sound command 124
Add to Contacts command 

127
Add to Favorites command 

139
Add to Personal Address 

Book command 275
adding

a second call 47
applications 240
appointments 177, 179
attachments to email 102, 

117, 219
bookmarks 139
bulleted or numbered lists 

197
caller ID pictures 174
connections 256, 257
contacts 46, 60, 173
document templates 195
expansion cards 226
files to playlists 167

folders 198
notes 174, 185, 186
online address book 106–

107
passkeys 146
signatures 110, 131
speed-dial buttons 50
spreadsheets 200
tasks 183
untimed events 178, 179

address book 106, 107, 112, 
175, 275

Address List Lookup 217
address messaging options 

112
Address tab 107, 112
addresses

adding 173
checking for 112
copying 275
entering email 102, 112
entering web 32, 137
looking up corporate 217
multiple recipients and 

102, 122
selecting 22, 281
synchronizing 275

adjusting screen brightness 
238

Advanced tab (Power 
Settings) 254

advancing slides 199, 200
After calls from numbers… 

option 60
Agenda View (calendar) 176
alarm clock 251
alarm sounds 252
alarms

adding 178, 183
setting 238, 251
turning on and off 237

Alarms tab 251
albums 160
alert tones. See alarms; 

ringtones
aligning the screen 239
alignment settings

documents 197
spreadsheets 200

Allow cookies check box 142
Allow USB connections 

check box 273
Alt key 26, 289
alternate characters 28, 29
alternate characters list 28, 

29
AMR files 122
animation 163, 199, 200
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anniversaries 179
Answer button 42
answering the phone 42, 47
Appearance tab 235, 240
application icons 30, 241
applications

See also third-party 
applications

associating with buttons 
241

battery life and 13
caution for hard resets and 

263
choosing menu items in 

23, 24
closing 30, 254
copying 229
customizing 240–245
deleting 222, 284
displaying 30, 254
downloading 219, 221
error reporting for 252
included with device 302
installing 219–220, 283, 

284
losing information in 263
moving through 20, 21
moving to expansion cards 

229

opening 30, 228, 240
phone calls and 45
reinstalling 261, 263
running from expansion 

cards 228, 284
running multiple 30
selecting 30
storing 284
synchronizing information 

in 73, 88
troubleshooting 264, 266
turning sounds on or off 

for 237
viewing memory usage for 

253
Appointment tab 177
appointments

adding 177
appearing in wrong time 

slots 276
deleting 180, 181
hiding 180
marking as private 180
reminders for 178
scheduling repeating 179
viewing 176

Appointments tab 182
Area code option 175
arrow icons 19

ascending sort order 208
ASF files 160
Assign a program list 241
attachments

adding 102, 117, 219
downloading 104, 105
embedded objects in 106
internal memory and 284
opening 104
storing 105, 113
troubleshooting 280

Attendees option 179
audio 42, 159, 163
auto-completion options 243
AutoCorrect command 162
Autofill option 205
AutoFilter command 208
AutoFilter settings 

(spreadsheets) 201
auto-keyguard feature 245, 

246
Auto-Keyguard list 246
Automatically download 

MMS messages check 
box 131

auto-off interval 289
available memory 253
available storage space 253
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B

back view (device) 8
backgrounds 154, 161, 169, 

235
backing up information 69, 

261, 263
backlight (keyboard) 26, 255
backlight shut-off interval 27
Backspace key 22, 26, 28
backup and restore 

application 81
backup utilities 261, 263, 

264, 277
backups, restoring 264, 277
battery

Bluetooth connections 
and 144

charging 11–12
conserving power for 255
disposing of 264, 298
inserting 10
maximizing life of 13–14
purchasing 11
removing 263, 265
replacing 264–265
specifications for 301
viewing remaining power 

for 254
viewing status of 67

battery door 10
battery door release 8
battery icon 12
Battery Power tab 27
battery status icons 67
Battery tab 254
Beam File command 223
Beam tab 225
Beam… command 224
beaming 14, 219, 223–225, 

289
birthdays 179
blank screens 267
Block incoming calls list 61
Block outgoing calls list 61
blocking phone calls 60
Bluetooth connections

battery level and 144
battery life and 14
checking status of 56
communicating over 54
hands-free devices and 

54, 55, 56
overview 143
synchronizing over 86

Bluetooth devices
beaming to 225
connecting to 54–56, 

143–146

creating partnerships for 
145

discovery setting for 147
phone calls and 56
receiving information over 

145, 147
sending information over 

145, 147
troubleshooting 271

Bluetooth icon 56, 68, 144
Bluetooth Plug-in 144
Bluetooth Settings screen 

144–147
Bluetooth wireless 

technology 135, 224, 289
BMP files 159
Bold option 196
bookmarks 139

See also favorites
border highlight 21
borders 200
brightness, adjusting 238
browsing files and folders 

218, 230
browsing the web. See web 

browsing
built-in applications 222, 302
built-in camera. See camera
bulleted lists 197
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bullets 193
Burst mode 156
button settings 169
buttons

assigning to media files 
169

assigning voice 
commands to 241

associating with 
applications 241

creating speed-dial 50
disabling 246
editing speed-dial 52
opening menus and 22
reassigning 241
selecting or activating 21
showing voicemail 51
turning sounds on or off 

for 237
Buttons icon 241
Buttons list 241
Buttons screen 241
Buttons tab (Options) 169

C

CAB files 221
calculations 203, 204, 231
Calculator application 231
calculator buttons 232

Calculator icon 231
calendar

adding items to 178, 179
displaying 176
removing events 181
setting alarms for 178
setting options for 181
unavailable slots on 180

Calendar application
adding contacts and 173
customizing 181–182
managing schedules with 

177–181
selecting views 176
starting 176
untimed events in 178

calendar options 181–182
Calendar views 176, 181, 

182
call forwarding 49
call forwarding icon 49
Call Log 40
Call Sender command 127
call waiting 47
call-barring password 61
caller ID applications 283
caller ID blocking 46
caller ID pictures 154, 174
caller IDs 61

call-waiting notifications 62
camcorder icon 155
camera

battery life and 13
capturing videos with 

156–157
specifications for 301
taking pictures 154–156
troubleshooting 282

camera lens 8
Camera Preview Mode 282
camera settings 157–159
Camera tab 158
Cancel Bluetooth command 

56
capitalization 27, 245
Capitalize first letter of 

sentence check box 245
Caps Lock icon 27
Caps Lock mode 27
captions 124
Carrier

call forwarding and 49
conference calls and 48

cascading menus 24
case-sensitive searching 

195, 210
categories

contacts 174
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events 180
playlists 167
tasks 183, 184

cell patterns (spreadsheets) 
200

certificates 137, 252
Certificates icon 252
Certificates screen 252
changes, undoing 162
changing

alarm sounds 252
color themes 235, 240
connections 256
contacts 174
date and time settings 250
email accounts 99
information 209
picture or video resolution 

155, 156, 282
PIN numbers 248
speed-dial buttons 52
text 195
text size 238

character entry 29
character sets 142
characters

capitalizing 27, 245
entering 26, 27, 204, 243
phone calls and 51

scrolling 20
text messages and 121, 

122
typing alternate 28

charge indicator 7, 12
charger cable 11
charging

device 11, 13
device battery 11–12

charging status 12
Chart command 209
chart options 209
charts 201, 209
Chat icon 128
chat sessions 128, 131
Chat tab 132
check boxes 21
chronological list of calls 40
Clear Cookies button 143
Clear History button 142
Clear Now Playing command 

168
Clear Type tab 238
clearing web links 142
Clock & Alarms icon 250, 

251
Clock & Alarms Settings 

screen 250, 251

closing
applications 30, 254
menus 24
notification messages 126
screens 21

color settings 282
color themes 235, 240
command button 242, 243
commands 22, 242

See also menus; voice 
commands

Company Directory 
command 108

company names 41, 174
comparisons 208
completed tasks 183, 184
components (Treo device) 3
compressed files 219
computers

connecting to 79
installing from 221, 222
reinstalling desktop 

software on 261
synchronizing with 87, 89
system requirements 75
viewing videos and 

pictures on 153
Conference button 48
conference calls 48
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confidential events 180
Confidential option 180
configurations

troubleshooting 270
Configure Server command 

280
configuring

data services 270
mail servers 280
TTY devices 59

Confirm message deletions 
check box 131

confirmation messages 132
Connect command 257
Connect via Bluetooth 

command 87
Connect via IR command 87
connecting

charger cable 11
device to PCs 79
headsets 52
to Bluetooth devices 54–

56, 143–146
to hands-free car kits 54
to mobile networks 268
to service providers 256
to the Internet 256, 270
to TTY devices 59
to VPNs 256–257

to web sites 137, 147
connection icons 257
Connection Settings 

command 273
connections

adding 256, 257
changing 256
displaying 256
ending 257
losing 271
manually starting 257
precautions for 300
removing Bluetooth 146
setting up 256–257
setting up wireless 148
timing out 278
troubleshooting 267–272, 

281
trusted devices and 147

Connections icon 256
Connections screen 256, 

257, 270, 271
Connections tab 225, 256
connectivity specs 301
conserving battery power 

255
contact categories 174
contacts

adding 46, 60, 173

addressing messages to 
102, 112, 121, 123

assigning ringtones to 51, 
59, 161, 174

changing 174
displaying 174
linking speed-dial buttons 

to 50
looking up 32, 38, 175
making calls to 38
personalizing 59
removing 175
saving information for 46
selecting communication 

method for 39
sending messages to 122, 

179
viewing details list for 39

Contacts application 173–
175

Contacts list 39, 47, 122, 
127, 175

context-sensitive menus 24
continuous playback (slides) 

200
cookies 137
Copy command 141, 161, 

196, 229
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copying
addresses 275
applications 229
items in folders 219
phone numbers 40, 41, 

141
pictures and videos 161
text 141, 196

copyrighted items 160
corporate mail systems 256, 

280
corporate networks 252
corporate servers 256, 280
coupling 285
coverage area 14, 35, 268
Create chat from messages 

option 132
creating

appointments 177, 179
bookmarks 139
bulleted or numbered lists 

197
caller ID pictures 174
connections 256, 257
contacts 46, 60, 173
documents 193, 194, 195
email messages 102
folders 198
multimedia messages 122

notes 185, 186
online address book 106–

107
partnerships 145
passkeys 146
playlists 167
signatures 110, 131
speed-dial buttons 50
spreadsheets 200
tasks 183
templates 127, 195, 202
text messages 121
untimed events 178, 179
video ringtones 161
workbooks 202

credentials 257, 278
cropping pictures 162
currency symbols 239
Currency tab 239
customer assistance 287
Customize the playlists… 

check box 164
customizing

applications 240–245
Calendar 181–182
camera 157–159
chat settings 131
Contacts application 175
dates and time 250

email settings 110
Excel Mobile 211
format settings 239
Internet Explorer Mobile 

142–143
Media Player Mobile 168
Messaging application 

130–133
network settings 133
Notes application 187
phone 57–65
system settings 250–255
system sounds 236
tasks 184
Today screen 235
voicemail system 51, 58
Word Mobile 198

Cut command 161, 196
cutting. See deleting

D

daily schedules 176
data 263

See also information
data connection icons 257
data filters 181, 208
data formats 239
data service icons 268
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data service providers 256, 
270, 279

data services 3, 268, 270
data transmission speeds 3
date format settings 239
Date tab 239
dates 205, 239, 250

See also calendar
Day View 176, 181
day-planner formats 176
decimal places 239
decimal symbols 239
decompression utility 219
default document template 

198
default format settings 239
Default mode option 187
Default option 138
default PINs 247
Default template option 187
Default zoom level options 

245
defined names 

(spreadsheets) 207
delays 36, 270
Delete Appointment 

command 180, 181
Delete Cells command 210

Delete command 130, 198, 
211

Delete Contact command 
175

Delete Files button 142
Delete Task command 184
Deleted folder 113, 284
deleting

applications 222, 284
Bluetooth connections 

146
certificates 252
contacts 175
directory services 107
documents 198
email accounts 99
events 181
favorites 140
files 219, 284
items from libraries 166
items from playlists 167
items in folders 219
messages 112, 130, 131
notes 187
partnerships 146, 271
pictures 162
speed-dial buttons 52
tasks 184
text 22

web files 142
workbooks 211
worksheets 211

descending sort order 208
Desktop option 138
desktop software 261, 289

See also applications; 
software

device
additional information for 

287
caution for resetting 263
caution for storing 8
charging 11, 13
compatibility with 

third-party vendors 73
compatible hands-free 

devices for 54
components of 3, 7–9
connecting to PCs 79
disabling touch-sensitivity 

for 246
features described 3
freeing space on 222, 284
getting help with 259, 287
getting phone number for 

15
locking 248
losing 81, 249
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low lighting conditions and 
26

management tools for 215
moving around on 17
not responding 262, 268, 

283
personalizing 233
required items for 4
resetting 248, 262–264, 

268
setting up 9–16
specifications for 301
system requirements for 

303
third-party applications and 

282, 283
troubleshooting 287
turning on and off 36
unlocking 248
updating information on 

69
device names. See 

usernames
Device Setup Wizard 164
devices

See also Bluetooth 
devices; device

battery life and 13
beaming to 224

configuring TTY/TTD 59
discovering trusted 143, 

144, 147
electrostatic discharge and 

299
physically-impaired 

disabilities and 59
transferring information 

from 261
troubleshooting 271

Devices tab 145, 271
diagnostic information 252
Dial Lookup list 15
Dial Pad 39, 41
dialing 14, 36–40, 41, 51
dialog boxes 290
digit grouping 239
digital cameras 159

See also camera
digital certificates 137, 252
dimmed images 267
Direct Push Technology 82
directory service 106, 107, 

112
Disable touchscreen check 

box 247
Disconnect Bluetooth 

command 87
Disconnect command 258

discoverable setting 147
discovering trusted devices 

143, 144, 147
disk space 303

See also memory
Dismiss button 44
display formats 239
Display message on screen 

check box 238
display options (web) 138
display settings 238–240

See also screen
displaying

alternate characters 28
animated images 163
applications on device 30
appointments 176
calendar 176
contacts 39, 174
current connection 256
daily schedules 176
events 178, 180
folder contents 218
memory usage 253
multimedia messages 128
notifications 58, 238
on-device help 287
PDF files 193
pictures 153, 154, 159
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power settings 254
Quick Tour documentation 

287
running applications 254
space on expansion cards 

230, 254
tasks 184
videos 153, 154, 159
web pages 137, 138
wireless settings 255

DOC files 193
document file types 193, 199
documentation 4, 287
documents

See also Word Mobile 
application

creating 193, 194, 195
deleting 198
finding and replacing text 

in 195
moving or copying text in 

196
opening 194
organizing 198
saving 193, 194, 196, 198
sending 91
setting margins for 197
spell-checking 197
supported features for 193

unsupported features for 
193

documents list 199
DOT files 193
downloading

applications 219, 221
attachments 104, 105
email 84, 103, 104
files 140
images 141, 163
multimedia messages 

126, 131
Palm-specific information 

and updates 287
pictures 159
ringtones 57
videos 163

Downloads favorite 141
downward-pointing arrows 

24
drained battery 13
drawing 185
drivers 262
Drop and Answer command 

48
drop-down lists

accessing 24
exiting 25
highlighting in 20, 25

scrolling through 20
selecting items in 22, 25

drop-down menus 24

E

earpiece 7, 285
echoes 285
EDGE connections 290
Edit command 162, 174
Edit Server Settings screen 

82
Edit Speed Dial command 52
editing. See changing
electrostatic discharge 300
email

adding address book for 
106–107

adding attachments to 
102, 117, 219

addressing 102, 112
creating 102
deleting 112, 113
dialing from 41
downloading 84, 103, 104
entering contacts and 173, 

179
forwarding 109
getting from corporate 

servers 256, 280
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getting from Exchange 
servers 103

internal memory and 284
priority settings for 103
receiving attachments 

with 104
reply options for 112
requirements for 3
selecting addresses 22
sending 103, 104, 117, 

139, 279
synchronizing 13, 103, 

272, 279, 280
troubleshooting 278–280

email accounts
changing 99
deleting 99
troubleshooting 278

email applications 281
E-mail button 104
email client software 280
email message icons 129
embedded images 106
emergency calls 37, 245
emoticons 122
Enable Clear Type check box 

238
Enable fixed dialing check 

box 64

Enable local network time 
check box 251

encoding options 142
encryption 137
End Show command 199
End User License 

Agreement 4
ending

active calls 45
data connections 257
playback 165

endnotes 194
entering

alternate characters 28, 29
data in spreadsheets 202, 

205
information 27–28
numbers 26, 27
owner information 249
passkeys 55, 146
passwords 83, 95, 98, 

248, 249
phone numbers 14, 36, 

39, 41
PINs 247
text 244, 245
web addresses 32, 137

Entire column option 211
Entire row option 211

entry fields
deleting text in 22
highlighting in 20, 22
moving to 20
opening drop-down lists in 

25
scrolling through 20

Erase all data? prompt 264
erasing. See deleting
error messages 237, 277
error reporting 252–253
Error Reporting icon 253
Error Reporting screen 253
errors 252, 268, 277
ESD (electrostatic discharge) 

299–300
Even when roaming check 

box 131
event categories 180
event icons 182
Event list 238
events

creating 178, 179
deleting 181
filtering 181
hiding 180
marking as sensitive 180
reminders for 178
selecting sounds for 238
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setting notification 
preferences for 238

Events check box 237
Excel files 189

See also Excel Mobile; 
spreadsheets

Excel Mobile application
customizing 211
display settings for 203
overview 200
searching in 209
starting 202
supported features 200
unsupported features 201

Excel Mobile icon 202
Exchange ActiveSync 280, 

290, 293
Exchange Address Book 275
Exchange server credentials 

screen 278
Exchange server sync 

options 84, 278
Exchange servers

accessing 175
getting email from 103
setting up accounts for 

82–84
synchronizing with 13, 72, 

87, 277

troubleshooting 278, 280
exiting applications 30, 254
expanding lists in fields 25
expansion card slot 8, 226, 

301
expansion cards

as storage medium 284
browsing on 230
displaying available space 

on 230, 254
inserting 226–227
installing apps on 222
moving apps to 229
moving information to 

198, 210, 229
opening items on 228
removing 227
renaming 230
searching on 217, 219
storing attachments on 

105, 113
transferring files to 163, 

166, 228, 229
types supported 226

extensions (phone) 51
external power sources 254
External Power tab 27
Extra Digits button 43, 51
Extra Digits text box 51

Extract command 49

F

factory settings 169
factory-installed applications 

222, 302
favorites 139–140

See also web pages
Favorites button 140
Favorites command 140
features 3
Federal Trade Commission 

website 253
feedback 285
fields. See entry fields
File Explorer 217, 218–219, 

230, 231
File Explorer icon 218
file names 196, 198, 217
file types

displaying 199
documents 193
Media Player 163
multimedia 122
pictures 159
videos 160

files
accessing from corporate 

accounts 256
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browsing 218
decompressing 219
deleting 219, 284
downloading 140
moving 198, 219
saving 228
searching for 217, 219
selecting multiple 219
transferring to expansion 

cards 163, 166, 228, 
229

fill series (spreadsheets) 205
Filter command 174, 181
Filter option 184
filtering

events 181
information 174, 208
tasks 184

filters 181, 208
Find Online command 175
Find/Replace command 195, 

209
finding

contacts 32, 38, 175
information 209
text 195

firewalls 272
5-way navigator 7, 19, 21, 

284

fixed dialing 63
folder names 198
folders

accessing Outlook 275
adding documents to 196
arranging pictures and 

videos in 161
browsing 218, 230
creating 140, 198
moving items to 198, 210, 

219
opening items in 219
organizing web favorites in 

139, 140
sorting contents 219
synchronizing messages 

in 103
Font color option 196
Font command 196
Font option 196
fonts 194, 196, 201, 238
footers 194
footnotes 194
forgetting passwords 248
format settings 239
formats, losing 193
formatting

charts 209
paragraphs and lists 197

spreadsheets 200, 207
system data 239
text 196

Formatting toolbar 197
forms (web) 139
formulas 201, 204, 211
Forward command 109
forwarding

messages 109, 127
phone calls 49

freeing memory 222, 277, 
284

Freeze Panes option 203
front view (device) 7
full charge (battery) 11
Full Screen option 138
functions (spreadsheets) 

201, 204

G

games 13
getting started 4, 5, 14, 287
GIF files 123, 159, 163
Global Address List 106, 

107, 175
Global Address List Lookup 

217
Glossary 289
Go to Slide command 199
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GPRS connections 290
graphics programs 162

H

HAC setting 297
Hands Free check box 56, 

271
hands-free car kit 53, 56
hands-free devices

connecting to 54
setting up 52
tips for 57
troubleshooting 271
turning Keyguard on or off 

for 246
hanging indents 197
hanging up phone 15, 45
hard resets 248, 263
hardware 3
Hardware buttons check box 

237
headers 194
headset button 53
headset jack 7
headsets

configuring as trusted 
devices 144

connecting 52–54

disabling Keyguard and 
246

hearing-impaired 59
heat sources 14
help 259, 287
Help topics 30
hiding

appointments 180
events 180
images 138
speed-dial buttons 38
Tasks entry bar 185

highlight 21
Highlight option 197
highlighting

applications 30
items in folders 219
items on screen 20, 21–

22
menu items 23, 24
options in lists 20, 25
text 22, 197

Hint tab 249
hints (passwords) 249
History command 141, 166
History list 141, 142
Hold button 45
home locations 250
Home page option 142

hypertext links. See links

I

icons
application 30, 241
battery status 12
data connections 257
data services 268
email 129
events 182
message status 129
navigator 19
phone status 66
signal-strength 35, 255

Identification tab 249
Ignore with text message 

command 42
image file types 159
image files 123, 153, 284
images

See also pictures
dimmed 267
downloading 141
hiding web page 138
incorrect color settings 

and 282
receiving 106
setting background 161, 

235
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troubleshooting web page 
281

IMAP accounts 94, 96, 105
inactivity 156, 157, 254
Inbox 20, 103, 129
Inbox application 102, 106
Include file attachments 

check box 105
incorrect passwords 248
Indentation setting 197
indented lists 194
indenting text 197
indicator light 7, 12
information

accessing 31, 252
backing up 69, 261, 263
changing 209
entering 27–28
erasing all 272
filtering 174, 208
losing 193, 263
moving 198, 210, 229
protecting 245–249
removing battery and 264
restoring 263, 264
searching for 195, 210, 

217–218
sharing 223
sorting 208

storing 225, 284
synchronizing 71, 73, 272
transferring 69, 261
updating 69

infrared port. See IR port
infrared transmissions 87, 

290
Input icon 243
input options 26, 243
Input screen 243, 244
inserting expansion cards 

226–227
installation, troubleshooting 

264, 283
installing

ActiveSync 71
applications 219–220, 

283, 284
bonus software 220
SIM smartcards 9–16
synchronization software 

75, 76, 77
VPN clients 256
Windows drivers 262

instant messaging 
applications 283

internal memory. See 
memory

Internet 256, 270

See also web browsing; 
websites

Internet Connection Sharing 
147

Internet Connection Speed 
option 169

Internet Explorer Mobile
browsing with 137–142
closing 139
customizing 142–143
installing from 221
scrolling in 20
starting 137
unsupported elements for 

137, 281
IR connections 225
IR port 8, 87, 224, 290
ISP mail systems 96
ISP settings 256
ISPs (Internet Service 

Providers) 256, 279
Italics option 197
Items tab 235

J

JavaScript 137
JPEG files 123
JPG files 159
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K

keyboard
accessing alternate 

characters on 28
dialing from 36
entering information from 

27–28, 245
locking 246
scrolling with 20
selecting menu items 

from 24
setting key combinations 

for 241
specifications for 302
troubleshooting 284

keyboard backlight 26, 255
keyboard icon 26
Keyguard 246
Keyguard icon 246
Known Caller option 57

L

language-impaired 59
leading zeros 239
left action key 22, 177
Legacy Pocket Word files 

194
libraries (media) 166
Library command 165

Library list 165
Library screen 165, 169
Library tab 169
lightening bolt 12
Li-Ion battery 290

See also battery
links

clearing web 142
internal memory and 284
media files and 166
messages and 129, 139
selecting 21, 138
troubleshooting 281

list separators 239
List setting 197
Listen button 44
listening to

media files 163
voicemail messages 44

lists
accessing 24
creating 194, 197
displaying alternate 

characters and 28
exiting 25
formatting 197
highlighting in 20, 25
navigating web page 139
scrolling through 20

selecting items in 22, 25
Lithium Ion battery 290

See also battery
locating

contacts 32, 38, 175
information 209

location-specific information 
239, 250

Lock icon 137, 160, 248
Lock screen 248
locking

SIM smartcards 247
spreadsheet rows and 

columns 203
the keyboard 246
the screen 246
Treo device 248

logging in to
corporate servers 256
networks 252

looking up contacts 32, 38, 
175

lookup feature 217
losing

connections 271
information 193, 263
passwords 248
Treo device 81, 249

low coverage areas 268
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low lighting conditions 26
lowercase letters 27

M

magnet 8
magnification. See zoom 

settings
mail servers 256, 280
Main tab 253
Make the device 

discoverable check box 
144

Make this device 
discoverable setting 147

Manage existing connections 
option 256, 257

Manage Folders command 
103

Manage tab 237
management tools 215
manually closing applications 

31
MAPI clients 280
maps 281
margins 197
Match case box 195, 210
Match whole words only 

check box 195, 210
measurement units 239

media files
creating playlists for 167
formats for 163
linking to 166
playing 164
synchronizing 164
transferring 163, 166
troubleshooting 276

media libraries 166
Media Player 276
Media Player Mobile 163–

169
media players 13
Media sync option 164
meeting invitations

accepting/declining 116
meeting requests 106, 107, 

179, 182
memory

available 303
freeing 222, 277, 284
low conditions for 31, 253
running apps and 30, 228
storing numbers in 232
viewing expansion card 

230
memory buttons 232
Memory icon 230
memory options (web) 142

Memory screen 253
Memory Settings screen 31
Memory tab 142
memory usage 253
memos. See messages; 

notes
menu items 23
Menu key 23, 24
menus 22–24
Menus icon 240
Menus screen 240
Message Details command 

127
message list 128, 129
Message Options command 

125
Message Options screen 

125
Message Priority list 125
message status icons 129
Message tab 111
Message validity period 

option 131
messages

See also multimedia 
messages; text 
messages; voice notes

adding signatures to 110, 
131
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addressing 102, 122, 123
automatically resending 

131
creating email 102
deleting 112, 130, 131
dialing from 41
displaying notification 238
displaying status of 129
forwarding 109, 127
invalid characters and 122
listening to 44
receiving notifications for 

126, 132, 270
saving 103
sorting 130
storing 284

Messages tab 131
Messaging application

See also text messages; 
multimedia messages

adding contacts and 173
chat sessions and 128
customizing 130–133
email settings in 110
messaging options in 125
notification options in 126
overview 121
play options in 127
starting 121

status icons in 129
messaging applications 283
messaging services 270, 

290
microphone 7, 45, 159, 285
microphone icon 242
Microsoft ActiveSync. See 

ActiveSync
Microsoft Exchange 

ActiveSync.See Exchange 
ActiveSync

Microsoft Office 189
Microsoft Office Excel 201

See also spreadsheets
Microsoft Windows Mobile 

software 220
Microsoft Windows Mobile 

website 261
Microsoft Word documents. 

See documents
MIDI files 122
miniSD cards 225
mirror 8, 155
Missed call option 57
MMS files 166
MMS messaging 121, 290
mobile accounts. See 

accounts

Mobile Device component 
(Windows) 291

Mobile Device folder 78, 
221, 222

mobile devices 224, 261
mobile networks 267, 268
mobile phone numbers 173
Mobile to Market certificates 

220
Mode tab 144
model numbers 300
Modem tab 256
ModemLink application 147
modems 147
Modify Sheets command 

208, 211
Month View 177
most recently dialed 

numbers list 40
moving

documents to folders 198, 
219

files to expansion cards 
163, 166, 228, 229

information 198, 210, 229
pictures and videos 161
speed-dial buttons 52
text 196
workbooks 210
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moving around the screen 
19–21

moving through web pages 
138

MP3 files 163
MP4 files 163
MPEG files 160
MPEG4 files 123
multi-connector 7
multi-line fields 20
multimedia features 119, 

151
multimedia file types 160
multimedia files 159, 284
multimedia messages

creating 122
deleting 130, 131
displaying 128
downloading 126, 131
forwarding 127
internal memory and 284
opening 126
overview 119
phone numbers in 41
playing 126–128
previewing 125
receiving 126
replying to 127
requirements for 3

saving 127
sending 123, 125, 128
setting options for 125
sorting 130
troubleshooting 270

Multimedia Messaging 
System. See MMS 
messaging

multiple recipients 102, 122
music 42, 163, 165, 237

See also media files
music files 276
Mute command 45
My Device folder 218
My Device library 166
My Documents folder 217, 

218, 263
My Pictures folder 154, 156
My Playlists category 167
My Storage Card library 166
My Text command 102
My Text phrases 102

N

names 32, 293
naming

document files 196, 198
expansion cards 230
folders 198

groups of pictures 158
speed-dial buttons 50
templates 195, 202
workbooks 210
worksheets 206, 208

navigating the screen 19–21
navigating web pages 138
navigator. See 5-way 

navigator
navigator buttons 19, 21
negative numbers 239
network protocols 168
network settings 64, 133
Network tab 64, 168
networks

changing 65
connecting to 65
logging in to 252
troubleshooting 267–272

New Account command 94, 
96

New Appointment command 
177, 178

New MMS command 123
New Partnership option 145
New Sound command 237
New Speed Dial command 

50
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notes
adding 174, 183
creating 185, 186
removing 187
saving 187

Notes application 185–188
Notes icon 185
Notes list 186, 187
Notes tab 174, 249
notification options 126, 132, 

238
notification screens. See 

notifications
Notification tab 132
notifications

changing event 238
closing 126
displaying 58
downloading sounds for 

57
enabling or disabling 238
phone calls and 62
previewing sounds for 58
receiving messages and 

126, 132
receiving phone calls and 

47
receiving transmissions 

and 147

receiving voicemail 44
setting ringtones for 57
setting system sounds for 

237
silencing sounds for 236
troubleshooting 270

Notifications check box 237
Notifications tab 57, 237
Now Playing playlist 167, 

168
Now Playing screen 167
number format settings 239
number pad 14
number sign symbol 239
Number tab 239
numbered lists 197
numbers

See also phone numbers
entering 26, 27
formatting 201, 205
pasting into Calculator 232

O

Off Hold button 45
Office Outlook. See Outlook
Office Word documents. See 

documents
offline synchronization 275
Off-peak times options 85

OK button 7, 31
One Column option 138
online address book 106, 

107, 112, 175
online support (Palm) 287
Open URL command 166
opening

ActiveSync 78
alternate characters list 28
applications 30, 228, 240
attachments 104
calculator 231
Dial Pad 41
documents 194
email applications 281
File Explorer 218
items in folders 219
menus 22, 24
multimedia messages 126
on-device help 287
Outlook folders 275
PDF Viewer 193
Phone Settings screen 15
Quick Tour 287
templates 202
text messages 127
Today screen 14, 31
web pages 137, 139, 141
Wireless Manager 36
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operating system (device) 
266, 293, 301

operating systems (PCs) 75
Option key 20, 26, 27, 291
Option Lock icon 27
Option Lock mode 27
options

displaying 180
highlighting 20, 21, 25
selecting 24, 25

Options screen (ActiveSync) 
88

Options screen (Internet 
Explorer) 142

Options screen (messaging) 
105, 110, 111, 113, 114, 
130

Options tab 235, 244, 249
organizer features 36, 171
orientation (screen) 240
orientation (slides) 200
orientation options 240
Orientation tab 200
outages 270
Outbox 129
Outlook

accessing folders for 275
copying addresses to 275

downloading messages 
from 103, 105

email client software and 
280

installing drivers for 262
synchronizing with 82, 

108
Outlook E-mail screen 94, 

96, 102
overdue tasks 184
Override playback options 

200
owner information 249
Owner Information icon 249
Owner Information screen 

249

P

page breaks 194
paired relationships. See 

partnerships
pairing. See partnerships
Palm (online support) 287
Palm applications 221
Palm devices 79, 261
Paragraph command 197
paragraph formatting 197
partial battery icon 12
partnerships 145, 271, 291

passkeys 55, 146
Password tab 248
Password type list 248
passwords

call-blocking and 61
corporate email accounts 

and 83, 98
entering 83, 95, 98, 248, 

249
forgetting or losing 248
locking device and 246, 

248
saving 95, 98
spreadsheets and 201

Paste command 161, 196
patches 222
patterns in workbooks 200
Pause playback option 127, 

168
PDF files 193
PDF Viewer 193, 211
Peak times options 85
performance 266, 283
Personal Address Book 275
personal computers

connecting to 79
installing from 221, 222
reinstalling desktop 

software on 261
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synchronizing with 87, 89
system requirements 75
viewing videos and 

pictures on 153
personal events 180
personal identification 

numbers (PINs) 63, 247, 
292

personal information 248, 
249, 290

personal information 
managers 275, 292
See also PIM applications

Personal option 180
Personal tab 57
personalizing your device 

233
phone

See also phone calls; 
phone numbers; device

adjusting volume 15, 59
advanced features 44–50
answering 42, 47
customizing 57–65
dialing 14, 36–40, 41, 51
disabling touch-sensitive 

feature for 246
hanging up 15, 45
network settings for 64

ringtones for 57, 58
running applications and 

45
selecting wireless band for 

62
silencing ringer 42
specifications for 301
waking up screen for 45

phone calls
See also phone; phone 

numbers
adding a second 47
blocking 60
ending 15, 45
forwarding 49
hands-free devices and 

53, 56, 57
making 14, 36, 41, 44, 

127
placing on hold 45
receiving 42, 44
receiving notifications for 

62
restricting 63
sending to voicemail 42
setting up conference 48
troubleshooting 271, 285

Phone dialog box 41
phone headset 52–54

See also headsets
Phone icon 247
phone lock feature 245
phone numbers

See also phone; phone 
calls

assigning to speed-dial 
buttons 50

copying 40, 41, 141
entering 14, 36, 39, 41
entering extra digits with 

51
locating device 15
missing from Phone 

Settings screen 16
redialing most recent 40
saving 46
selecting 22

Phone Off message 35, 291
Phone Settings screen 15, 

16, 60, 247
phone status icons 66
Phone tab 60
Phone/Send button 7, 15, 

37, 291
Phone/Send icon 37
phone-off icon 13, 35
photo albums 160
photos. See pictures
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pick lists
accessing 24
exiting 25
highlighting in 20, 25
scrolling through 20
selecting items in 22, 25

Picsel PDF Viewer 211
picture files 123, 153
picture formats 159
Picture Speed Dial button 51
picture speed-dial buttons 

38, 50
pictures

adding as backgrounds 
161, 235

adding as screensaver 158
adding sounds to 124
adding to messages 124
adjusting resolution of 

155, 162
creating caller ID 174
default resolution settings 

for 282
deleting 162
downloading 159
editing 162
hiding on web pages 138
naming groups of 158
previewing 156, 157, 282

receiving 154
saving 158
sending 160
setting default size 158
storing 284
synchronizing 153
taking 154–156, 282
viewing 153, 154, 159

Pictures & Videos application 
157, 159–163

PIM applications 289, 292
PIMs 262, 275, 292
PIN unlock key 292
PINs 63, 247, 292
Play button 165
Play Slide Show command 

160
Play Sound box 58
Play sound check box 238
Play Sound list 252
playback icons 51
playback options 168, 200
Playback screen 168, 169
Playback tab 168, 200
playing

media files 164
multimedia messages 

126–128
presentations 199, 200

sounds 159
voice notes 186
voicemail messages 44

playlists 163, 164, 167
plug-ins 137, 236
POP accounts 94, 96
pop-up menus 24
port numbers 257
ports. See IR port; USB ports
Power icon 254
Power screen 254
Power/End button 7, 35
PowerPoint files 189
PowerPoint Mobile 

application 199–200
PowerPoint Mobile icon 199
precautions 300
preferences 131, 233

See also customizing
preinstalled applications 222, 

302
presentations 199, 200

See also PowerPoint 
Mobile

Preview Message command 
125

Preview Mode (camera) 282
previewing

multimedia messages 125
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pictures 156, 157, 282
sounds 58, 238
videos 157

priority levels 125, 183
Priority list 103
privacy mode 126, 132
private events 180
Private option 180
processor 301
Program Buttons tab 241
Program Files folder 229
Programs check box 237
Programs screen 30
programs. See applications; 

software
Prompt if device unused for 

check box 248
Properties command 139
protected spreadsheets 201
protecting

information 245–249
Treo device 245

proxy servers 257
PSW files 194
PUK (PIN unlock key) 292
punctuation marks 27, 29
Purge command 130
Purge screen 130
push technology 82

Q

QCELP files 122
Quality command 156
Quick Keys 38, 51
Quick Tour 287
Quick Tour icon 287
QuickTime Player 163
quitting applications 30, 254

R

radio 301
RAS connections 256
reassigning buttons 241
Receive all incoming beams 

check box 225
receiving

attachments 104
beamed information 225
email 103, 104, 279
meeting requests 106
multimedia messages 

122, 126, 131
pictures 154
text messages 121, 126, 

270
videos 154

Receiving Data message 225
recently-viewed web pages 

141

rechargeable battery. See 
battery

recipients, sending to 
multiple 102, 122

Record button action option 
187

recording
sounds 237
videos 156–157
voice notes 245

Recording icon 186
recording toolbar 186
records (data) 224
recurring appointments. See 

repeating appointments
redialing phone numbers 40
redirector (websites) 281
Refresh command 138
refreshing web pages 138, 

281
Region tab 239
regional settings 239, 250
Regional Settings icon 239
Regional Settings screen 239
regulatory numbers 300
reinstalling software or 

applications 261, 263
Reminder option 178
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reminders
adding 178, 183
events and 182
system alarms and 251
tasks and 184
turning on and off 237

remote access servers 256
remote files 256
Remove Programs icon 222, 

224
Remove Programs list 223
Remove Programs screen 

222, 224
Remove Split command 203
removing

applications 222, 284
battery 263, 265
battery door 10
Bluetooth connections 

146
certificates 252
contacts 175
directory services 107
documents 198
email accounts 99
events 181
expansion cards 227
favorites 140
files 219, 284

items from folders 219
items from libraries 166
items from playlists 167
messages 112, 130, 131
notes 187
partnerships 146, 271
pictures 162
speed-dial buttons 52
tasks 184
text 22
web files 142
workbooks 211
worksheets 211

Rename command 230
Rename/Move command 

195, 198, 210, 229
renaming

documents 198
expansion cards 230
items in folders 219
workbooks 210
worksheets 208

Repeat check box 238
Repeat command 165
repeat patterns 179
repeating appointments 179
repeating current song 165
repeating sounds 238
repeating tasks 183

Replace All button 195, 210
Replace button 195, 210
replacing

information 209
text 195
the battery 264–265

Request Delivery/Read 
Receipt check box 125

Require PIN when phone is 
used check box 247

reset button 8, 262
resets 248, 262–264, 268

caution for 263
resizing text 139
resolution (camera) 282
resolution (screen) 267, 302
Resolution command 155, 

282
restarting Treo device. See 

resets
restoring

backups 264, 277
information 263, 264
sound settings 236

Resume playback option 
127, 168

retrieving voicemail 44
Return key 26
reverse type 22



I N D E X 331

Revert to Saved command 
162

revision marks 193
right action key 22
right-click menus. See 

shortcut menus
Ringer switch 9, 236
ringer volume 59
ringer, silencing 42
ringtone files 122
ringtone managers 283
ringtones

assigning to contacts 51, 
59, 161, 174

creating video 161
downloading 57
previewing 58
selecting 57

roaming 85, 276
Roaming option 58
rotating pictures 157, 162
RTF files 193
RTSP files 160
running multiple applications 

30
Running Programs tab 31, 

254

S

safety guidelines 295
Save As command 141, 196
Save Image command 141
Save links… option 142
Save password check box 

83, 95, 98
Save to Contact Ring Tone 

command 161
Save to Contacts command 

47
Save to list 229
Save to option 187
Save to Template command 

127
Saved folder 103
saving

documents 193, 194, 
196, 198

email messages 103
files 228
multimedia items 127
multimedia messages 127
notes 187, 245
passwords 95, 98
phone numbers 46
pictures and videos 158
text messages 127
workbooks 200, 202, 211

Schedule command 85
Schedule screen 85
scheduled syncs 276, 279
schedules

adding items to 177, 178, 
179, 183

managing 177–181
organizing events for 180
removing events 181
removing tasks 184
sorting tasks on 184
unavailable time on 180
viewing daily 176

scheduling synchronization 
84–85

screen
activating items on 22
activating wrong features 

267
adjusting brightness 238
adjusting display 238–240
aligning 239
arranging web pages on 

138
battery life and 14
caring for 8
changing color themes for 

235, 240
changing orientation 240
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disabling touch-sensitivity 
for 245

locking 246
moving around on 19–21
scrolling in 20–21, 245
selecting items on 22
setting backgrounds for 

161, 235
setting delays for 36
specifications for 302
troubleshooting 239, 267
turning on or off 35, 36, 

254, 289
waking up 36, 45

screen fonts 238
Screen icon 238, 239
screen resolution 267, 302
Screen taps check box 237
Screen view 239
screens, returning to 

previous 21
screensavers 158
scroll arrows 21
scroll bar 21
Scroll upon reaching the last 

line check box 245
scrolling

device screen 20–21, 245
slides 199

spreadsheets 203
web pages 138

SD expansion cards 225
Search button 218
Search dialog box 217
Search for list 217, 218
Search icon 217
search results list 217, 218
searching

contacts list 39
documents 195
spreadsheets 209
web pages 137

searching for files 217, 219
searching for information 

195, 210, 217–218
searching for signal 14
secure websites 281
security 146, 245–249, 252
security certificates 137, 252
security options (web) 143
security software 245
Security tab 142, 247
Select All Text command 141
selecting

applications 30
items in folders 219
items in lists 25
items on screen 21, 22

menu items 23, 24
options in lists 22, 24, 25
speed-dial entries 32
tabs 20
web links 21, 138

self-portrait mirror 8, 155
Send Link via E-mail 

command 139
Send meeting requests via 

option 182
Send outgoing items… 

check box 85
Send Sound command 237
Send via E-Mail command 

223
Send/Receive command 104
sending

copyrighted items 160
email 103, 104, 117, 139, 

279
meeting requests 107, 

179, 182
multimedia messages 

123, 125, 128
pictures 160
sounds 237
text messages 42, 121
videos 160

sensitivity options 180, 183
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Sent folder 112, 129
serial numbers 300
servers, troubleshooting 

277, 278, 280
See also Exchange servers

service contracts 3
service providers 256, 270, 

279
Services tab 49, 61, 62, 64
Set as Hands-Free command 

271
Set as Today Background 

command 161
Set reminders for new items 

option 182, 184
Set up my proxy server 

option 257
setting alarm clock 251
settings. See options
shaded lightning bolt 12
sharing information 223
sheet list 203
Shift cells options 210
Shift key 26, 27
Short Messaging Service. 

See SMS messaging
shortcut menus 24
shortcuts 22

Show alphabetical index 
option 175

Show contact names only 
option 175

Show half hour slots option 
181

Show icons option 182
Show list 160, 228
Show Options command 

200
Show Pictures option 138
Show start and due dates 

option 184
Show Tasks entry bar option 

185
Show time stamps of each 

message option 132
Show week numbers option 

182
Shuffle command 165
side button 7
signal, searching for 14
signal strength 66, 267, 285
signal-strength icon 35, 255
Signature box 131
signatures 110, 131
Signatures screen 110, 131
silencing system sounds 9, 

236

silencing the ringer 42
silent alarm 237, 238
SIM smartcards 9, 11, 247, 

292
Size option 196
sketching 185
Skins tab 169
Slide Show tab 157
slide show toolbar 160
slide shows 158, 160, 199, 

200
slide timing option 200
slider 21
slides 124, 128
smartcard. See SIM 

smartcards
smartphone

getting help with 259
troubleshooting 259

SMS messaging 121, 292
soft resets 262
software

See also applications
caution for hard resets and 

263
included with device 4, 

302
installing 76, 77, 220
purchasing 266
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reinstalling 261, 263
songs. See music
Sort By command 184
Sort by list 208, 219
Sort command 130, 208
sort options 184
sort order 208
sorting

folder items 219
History list items 142
information 208
messages 130
pictures and videos 161
tasks 184

sound clips 122
Sound Mode buttons 236
sound settings 236, 237
sounds

adding to pictures 124
changing alarm 252
customizing 236
playing 159
previewing 58, 238
recording 237
selecting event 238
sending 237
setting ringtone 57
setting system 237
silencing 9, 236

turning off event 238
Sounds & Notifications 

screen 57
Sounds & Notifications 

Settings icon 237
Sounds & Notifications 

Settings screen 237
Sounds tab 237
Space key 26
speaker 8, 163
speakerphone 45, 285
Speakerphone command 45
special characters 29
special characters. See 

alternate characters; 
symbols

special occasions 178
specifications 301
speech-impaired services 59
Speed Dial Options 

command 52
speed-dial buttons 37, 50–52
Spell Check command 103
spell-checking 103, 197
Spelling command 197
split bar 203
spreadsheet templates 200, 

202, 211

spreadsheets
See also Excel Mobile; 

workbooks; 
worksheets

accessing 189
adding charts to 209
calculations in 203–205
changing order of 

worksheets 206
creating 200
defining filters for 208
deleting elements in 210
display options for 203
entering data in 202, 205
formatting 200, 207
insertion options for 205
scrolling 203
searching 209
sending 91
sorting in 208
unsupported features for 

201
SSL (Secure Sockets Layer) 

137
standby mode 156, 157
Start button 7, 30
Start menu 30, 240, 292
starting

data connections 257
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Excel Mobile 202
Internet Explorer Mobile 

137
PowerPoint Mobile 199
Word Mobile 194

static 300
status icons 66, 129
stereo headphones 163
Still image compression level 

list 158
Still Mode command 155
Stop command 165
stopping playback 165
stopping synchronization 89
Storage Card folder 222, 230
storage card symbol 219
Storage Card tab 230, 254
storage cards. See expansion 

cards
storage space 253, 277
Storage tab 112
storage temperatures 303
storing

applications 284
attachments 105, 113
device 8
document files 196
information 225, 284
passwords 83, 98

pictures 284
workbooks 210

streaming 292
Strikethrough option 197
stylus 9
submenus 24
Suggest words when 

entering text check box 
244

support 287
Swap button 48, 49
Symbol command 204
symbols 28, 29, 51, 204
Sync button 86
sync cable 75, 79
sync conflicts 83
sync schedules 276, 279
synchronization

backing up information 
and 263

battery life and 13
benefits of 69
defaults for 72
defined 293
hard resets and 263, 264
overview 71
preparing for 75
scheduling 84–85
setting options for 88

setting up 82, 86, 87
stopping 89
troubleshooting 262, 272–

278, 280
synchronization software 73, 

75, 76, 77, 275
synchronizing

addresses 275
dates and time 250
email 13, 103, 272, 279, 

280
information 71, 73, 272
manually 85
media files 164
multimedia files 153
offline 275
over Bluetooth 

connections 86
over IR ports 87
playlists 164
through USB hubs 274
wirelessly 72, 81, 86, 87, 

277
with multiple computers 

87
with third-party 

applications 73, 263
system alarms 251
system dates and time 250
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system errors 268
system locks 246, 248
system requirements 75, 

303
system settings 250–255
system sounds 9, 236, 237
system warnings 237

T

tables in documents 193
tabs 20
taking pictures 154–156, 282
tapping 19, 22, 239
tapping sounds 237
task categories 183, 184
Task tab 183
tasks

adding notes to 183
completing 184
creating 183
customizing 184
deleting 184
displaying 184
filtering 184
filtering and sorting 184
marking as sensitive 183
setting due dates for 183
setting reminders for 183, 

184

Tasks application 182–185
Tasks entry bar 183, 185
Tasks icon 183
Tasks list 184
Tasks tab (Connections) 256, 

257
TDD devices 59
technical support 287
telecommunications devices 

for impaired. See TTY 
devices

temperature range 303
templates

documents 195, 198
multimedia messages 127
notes 186, 187
spreadsheets 200, 202, 

211
text messages 127

Templates folder 195, 202
tentative appointments 177
text

aligning 197
changing 195
copying 141
deleting 22
entering 26, 27, 244, 245
finding and replacing 195, 

244

formatting 196
highlighting 22, 197
moving or copying 196
resizing 139, 238
selecting 22
spell-checking 103, 197
word-processing features 

for 193
text captions 124
text fields

moving to 20
opening drop-down lists in 

25
removing text in 22
scrolling through 20

text files 252
text messages

creating 121
deleting 130, 131
forwarding 127
links in 129
opening 127
overview 119
phone calls and 45
phone numbers in 41
receiving 126, 270
replying to 127
saving 127
sending 42, 121
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setting options for 125
sorting 130
troubleshooting 270

Text Size tab 238
Text Speed Dial button 51
text speed-dial buttons 38, 

50
text telephone devices. See 

TTY devices
themes 235, 240
third-party applications

accessing Outlook folders 
and 275

caution for hard resets and 
263

compatibility with 219
deleting 284
getting help with 283
installing 220, 283, 284
navigator and 19, 284
previewing pictures and 

282
reinstalling 261, 263
screen resolution and 267
synchronizing with 73, 

263
troubleshooting 220, 266, 

283–284
third-party vendors 73

Thumbnail View 156, 157
Thumbnails button 157
TIF files 159
time format settings 239
time system settings 250
Time tab 239, 250
time units 178
time zones 250
Timer 155
tips 3
Today icon 235
Today screen

accessing 14, 31
accessing Dial Pad from 

41
color themes for 240
components of 32
customizing 161, 235
dialing from 36, 37, 40, 41
overview 31
recovering settings for 

277
retrieving voicemail from 

43
Today Settings screen 235
top view (device) 9
touchscreen. See screen
touchscreen lockout 245, 

246

touch-sensitive feature 245
transactions 281
transferring

applications 229
files 163, 166, 228, 229
information 69, 261

transition effects (slides) 200
transmission delays 270
Transparency level list 161
troubleshooting 259, 287
Trusted Device list 144
trusted devices 143, 144, 

147
See also partnerships

trusted pairs. See 
partnerships

TTY devices 59
TTY/TDD options 60
Turn on Bluetooth check box 

54, 144
turning on or off

alarms 237, 251
caller IDs 61
Caps Lock 27
device 36
event sounds 238
keyboard backlight 26
Keyguard 246
Option Lock 27
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reminders 237
Ringer switch 236
screen 35, 36, 254
wireless services 13

TXT files 193
Typing mode 187

U

UMTS services 293
unauthorized users 245, 252
unavailable time slots 180
Underline option 197
underlining text 194, 197
Undo command 162
Unfreeze Panes option 203
Unknown Caller option 58
unlocking

device 248
SIM smartcards 247
spreadsheet rows and 

columns 203
unread messages 129
unretrieved voicemail 43
untimed events 178, 179
Update Library command 

166
updating information 69
upgrades 261
uppercase letters 27, 245

urgent message icon 129
URLs 166, 199

See also web links
USB connections 148
USB controllers 275
USB hubs 274
USB ports 79, 274
USB sync cable 79
Use above settings while 

roaming check box 85
Use network time zone 

check box 251
User Guide 287
usernames 293

V

Validity Period list 125
vCal attachments 280
vCard attachments 124, 280
Vibrate when… check boxes 

58, 238
vibrating alarm 237, 238
video albums 160
video file types 160
video files 123, 153, 276
Video Mode command 156
video options 168
video ringtones 154, 161
Video tab 159, 168

videos
adding sounds 159
adding to messages 124
changing resolution 156
defaults for 159
downloading 163
limiting length 159
previewing 157
receiving 154
recording 156–157
saving 158
sending 160
setting resolution for 282
synchronizing 153
viewing 153, 154, 159

View By command 174
View command 138, 176
View Recording Toolbar 

command 186
viewing

alternate characters 28
animated images 163
applications on device 30
appointments 176
calendar 176
contacts 39, 174
current connection 256
daily schedules 176
events 178, 180
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folder contents 218
memory usage 253
multimedia messages 128
notifications 58, 238
on-device help 287
PDF files 193
pictures 153, 154, 159
power settings 254
Quick Tour documentation 

287
running applications 254
space on expansion cards 

230, 254
tasks 184
videos 153, 154, 159
web pages 137, 138
wireless settings 255

virtual private networks. See 
VPN connections

voice captions 124
Voice Command button 242, 

243
Voice Command icon 266
Voice Command screen 242
Voice Command settings 

242, 266
voice commands 14, 243
Voice mail option 58
voice notes 185, 245

Voice recording format list 
245

voice recording formats 245
voicemail

customizing 51, 58
receiving notifications for 

44
retrieving messages 44
sending calls to 42, 47
setting up 43

voicemail buttons 51
Voicemail icon 43, 44
voicemail systems 43
volume

phone 15, 59
ringer 59
tapping sounds 237

Volume button 7, 15, 59
VPN clients 256, 272
VPN connections 96, 105, 

256–257
VPN software 256

W

waking up screen 36, 45
wallpaper 154
warnings 237
warranty 4
WBMP files 123

weak signals 267, 285
web addresses 32, 137, 281

See also web links
web browser. See Internet 

Explorer Mobile
web browsing

memory consumption and 
284

requirements for 3
secure sites and 137, 281
troubleshooting 281

web files 142
web links

clearing 142
internal memory and 284
messages and 129, 139
Palm online support 287
selecting 21, 138
troubleshooting 281

web pages
accessing 137, 139, 141, 

281
arranging on screen 138
clearing links to 284
copying from 141
dialing from 41, 141
display options for 138
downloading items from 

140, 221
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hiding images on 138
moving through 138
playing media files from 

166
refreshing 138, 281
resizing text on 139
returning to recently 

viewed 141
scrolling 138
searching 137
security settings for 143
selecting addresses on 

281
sending email from 139
setting as home 142
viewing 137, 138

Web search field 137
websites

See also web browsing
accessing 135
compatibility with 137
connecting to 137, 147
ending connections to 257
redirectors and 281
searching over 137
submitting transactions 

and 281
week numbers 182
Week View 176, 181

Week view option 181
Windows Mobile devices 

224, 261
Windows Mobile Getting 

Started Disc 4, 220
Windows Mobile operating 

system 266, 293
Windows Mobile software 

220
wireless band setting 62
wireless connections 135, 

143, 148
wireless coverage 14, 35
wireless features 13, 135, 

255, 283
Wireless Manager 13, 36, 

255
Wireless Manager command 

13, 36
wireless modems 147
wireless services 13, 255
wireless synchronization 72, 

81, 86, 87, 277
WMA files 160, 163
WMV files 160, 163
Word application 189

See also documents
Word Completion tab 244
word matching 195, 210

Word Mobile application 20, 
193–199

Word Mobile icon 194
word-processing features 

193
workbook list 211
workbooks

See also Excel Mobile 
application; 
spreadsheets

creating 202
deleting 211
displaying 203
moving around in 203
naming 210
organizing 210
replacing information in 

209
saving 200, 202, 211
searching 209
setting default template 

for 211
worksheet names 201
worksheets

See also spreadsheets; 
workbooks

adding 206
adjusting column and row 

size for 207
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deleting 211
entering defined names in 

207
entering formulas in 204, 

211
entering functions in 204
filtering data in 208
formatting options for 207
inserting cells, rows, and 

columns 205

moving between 203
naming 206
removing cells, rows, and 

columns 210
renaming 208

Writing mode 187

Y

Year View 177

Z

ZIP files 219
zoom buttons (camera) 155
Zoom command 194
zoom icons (presentations) 

199
Zoom In command 199
zoom options 155
zoom settings 201, 203, 245
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